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SPECTRA PRECISION SOFTWARE PRODUCT END USER
LICENSE AGREEMENT (“EULA")

IMPORTANT, READ THIS AGREEMENT CAREFULLY. BY INSTALLING OR US-
ING ALL OR ANY PORTION OF THE SOFTWARE, YOU ARE ACCEPTING ALL OF
THE TERMS AND CONDITIONS OF THIS AGREEMENT. YOU AGREE THAT
THIS AGREEMENT IS ENFORCEABLE LIKE ANY WRITTEN AGREEMENT.

IF YOU DO NOT AGREE TO ALL OF THESE TERMS AND CONDITIONS, DO NOT
USE OR ACCESS THE SOFTWARE.

IF YOU HAVE PAID A LICENSE FEE FOR USE OF THE SOFTWARE AND DO NOT
AGREE TO THESE TERMS, YOU MAY RETURN THE SOFTWARE (ALONG WITH
ANY HARDWARE ON WHICH IT WAS EMBEDDED, IF APPLICABLE) FOR A
FULL REFUND PROVIDED YOU (A) DO NOT USE THE SOFTWARE AND (B) RE-
TURN THE SOFTWARE WITHIN THIRTY (30) DAYS OF YOUR INITIAL PUR-
CHASE.

IF YOU WISH TO USE THE SOFTWARE AS AN EMPLOYEE, CONTRACTOR, OR
AGENT OF A CORPORATION, PARTNERSHIP OR SIMILAR ENTITY, THEN YOU
MUST BE AUTHORIZED TO SIGN FOR AND BIND THE ENTITY IN ORDER TO
ACCEPT THE TERMS OF THIS AGREEMENT. THE LICENSES GRANTED UN-
DER THIS AGREEMENT ARE EXPRESSLY CONDITIONED UPON ACCEPTANCE
BY SUCH AUTHORIZED PERSONNEL.

IF YOU HAVE ENTERED INTO A SEPARATE WRITTEN LICENSE AGREEMENT
WITH US FOR USE OF THE SOFTWARE, THE TERMS AND CONDITIONS OF
SUCH OTHER AGREEMENT SHALL PREVAIL OVER ANY CONFLICTING
TERMS OR CONDITIONS IN THIS AGREEMENT.

This Spectra Precision Software Product End User License Agreement (“Agree-
ment”) is between You and us (both being defined below) (each a “Party” and

collectively the “Parties”). This Agreement covers any Software and supporting
technical documentation provided with the Software (“Documentation”).

1.Definitions.

“Affiliate” shall mean any entity that directly or indirectly through one or more
entities, controls, is controlled by, or is under common control with a Party. For
purposes of this definition, the term "control" as applied to any entity, means the
possession, directly or indirectly, of the power to direct or cause the direction of
the management of that entity, whether through ownership of voting securities
or otherwise.

“Effective Date” means the earlier of the date You sign an Order Form or the
date on which the Software is first made available to You.

“Order Form” means any order which is entered into by us (or an authorized
Spectra Precision products distributor or reseller) and You under which You are
provided the Software. Each Order Form for the Software shall be deemed a part
of this Agreement. This Agreement is binding on You whether or not You execut-
ed an Order Form with us. Order Forms may not vary the terms of this Agree-
ment. Only a written agreement, signed by us (not a Spectra Precision products
distributor or reseller) may vary the terms of this Agreement.

“Software” means the Spectra Precision software product(s) provided in con-
nection with this Agreement in object code form (or as otherwise specified in
any related Order Form). “Software” shall also include any releases provided to
or purchased by You under any separate support and maintenance agreement
You may enter into with us. Unless otherwise noted, the Software and Documen-
tation are referred to collectively herein as “Software”.

“Our”, “we” and “us” means Trimble Inc. (935 Stewart Drive, Sunnyvale,
California 94085, U.S.A.) and/or its Affiliates, including, without limitation,
Trimble Europe B.V. (Meerheide 45, 5521 DZ Eersel, The Netherlands);

“Supplier” means either us or an authorized distributor or reseller of Spectra
Precision products or services which has entered into an Order Form with You.

“Third-Party Software” means any third-party software that we provide to You
under this Agreement or under separate terms and conditions.

“You” means the customer (individual or entity) that has downloaded or other-
wise procured the licensed Software for use as an end user.

2.License.

2.1.Grant of License. Subject to all of the terms and conditions of this Agree-
ment, we grant You a non-transferable, non-sublicensable, non-exclusive license
to use the Software in machine-readable form on any computer and operating
system for which it was intended, but solely (a) for your own internal business
purposes at the location specified in the applicable Order Form or otherwise
agreed to by us (the “Site”); (b) in accordance with the Documentation; and (c)
in accordance with any additional license term, subscription term or other user,
seat, computer, field of use or other restrictions set forth in the applicable Order
Form or otherwise specified by us.

2.2.1Installation and Copies. We shall make available the Software and Docu-
mentation by disk, other media, or as embedded in a device, or make it available
for download in electronic form. We shall also provide You with electronic pass-
words or other enabling mechanisms if necessary to permit the licensed usage
of the Software. All licenses shall commence, and delivery shall be deemed to
occur, as of the Effective Date (or, if later, such date on which the Software and
license keys are first made available to You). If your Order Form is with a Spectra
Precision products distributor or reseller, that distributor or reseller (and not us)
is solely responsible for delivery to You and we have no liability for any failure to
deliver. If the Software requires license keys to operate as licensed to You, our
applicable Supplier will deliver such license keys to You.

2.3.Software Intended to be Installed on Computers. The Software is licensed
as a single product. You may not separate its component parts for use on more
than one computer except as specifically authorized in this Agreement. You may
copy and install on your computers for use only by your employees the number
of copies of the Software for which You have paid the applicable license fee or
have been authorized in writing by us. You may transfer the Software from one
computer to another computer provided that the computer to which the Software
is transferred is located at the Site and the Software is completely removed and
de-installed from the prior computer. If You are permitted by us to install the
Software on a network server, and You transfer the Software from the Site to a
new location, You must provide us with written notice of the new site prior to
such transfer. You may also make a reasonable number of copies of the Software
only for back-up and archival purposes. This Paragraph 2.3 does not apply to
any software embedded on our devices.

2.4.License Restrictions.

2.4.1.You shall not (nor shall allow any third party to): (a) decompile, disassem-
ble or otherwise reverse engineer the Software or attempt to reconstruct or dis-
cover any source code, underlying ideas, algorithms, file formats or
programming interfaces of the Software by any means whatsoever (except and
only to the extent that applicable law prohibits or restricts reverse engineering
restrictions). To the extent any applicable mandatory laws give You the right to
perform any of the aforementioned activities without our consent in order to gain
certain information about the Software for purposes specified in the respective
statutes (e.g., interoperability), You hereby agree that, before exercising any
such rights, You shall first request such information from us in writing detailing
the purpose for which You need the information. Only if and after we, at our sole
discretion, partly or completely deny your request, may You exercise such stat-
utory rights; (b) distribute, sell, sublicense, rent, lease or transfer the Software
(or any portion thereof), nor use the Software (or any portion thereof) for time
sharing, hosting, service provider or like purposes; (c) provide the Software to a
third party on a temporary basis and/or use the Software for the benefit or pur-
poses of a third party whether by means of lease, loan, data processing services
(e.g. “fee for service”) or otherwise, unless You are a reseller of Spectra Preci-
sion products under separate written agreement with us and authorized by us to
do so; (d) remove any product identification, proprietary, copyright, or other no-
tices contained in the Software; (e) modify any part of the Software, create a de-
rivative work of any part of the Software, or incorporate the Software into or with
other software, except to the extent expressly authorized in writing by us; (f) at-
tempt to circumvent or disable the security key mechanism that protects the
Software against unauthorized use (except and only to the extent that applicable
law prohibits or restricts such restrictions) and/or any licensing control features;
or (g) publicly disseminate performance information or analysis (including, with-
out limitation, benchmarks or comparison testing or analysis) from any source
relating to the Software or disclose to any third-party or release any results there-
of (all of which information shall be considered our confidential information)
without our prior written consent.

2.4.2 If the Software has been provided to You as embedded in any hardware
device, You are not licensed to separate the Software from the hardware device.
If the Software has been provided to You separately from a hardware device but
is intended to be loaded onto a hardware device specified by us (such as a firm-
ware update), your license is limited to loading the Software on the device spec-
ified by us in the Documentation, and for no other use.

2.4.3 You agree to use all reasonable efforts to prevent unauthorized use and
disclosure of the Software.

2.5.Evaluation Software. Subject to the terms and conditions of this Agreement
and during its term, we may, in our discretion, provide You with pre-release, beta
or other software on an evaluation basis (“Evaluation Software”). You may use
Evaluation Software solely for internal evaluation purposes for thirty (30) days
from receipt of the Evaluation Software (unless otherwise agreed with us in writ-
ing) (the “Evaluation Period”). Unless You pay the applicable license fee for the
Software, the Evaluation Software may become inoperable and, in any event,
your right to use the Evaluation Software automatically expires at the end of the
Evaluation Period. Evaluation Software shall be subject to all restrictions on



Software set forth in this Agreement. You shall treat all Evaluation Software as
Confidential Information of us and shall return or destroy any copies of Evalua-
tion Software upon expiration of the applicable Evaluation Period. Any and all
suggestions, reports, ideas for improvement and other feedback of any type You
provide regarding the Evaluation Software are our sole property, and we may use
such information in connection with any of our products or services without any
obligation or restriction based on intellectual property rights or otherwise. You
acknowledge that all Evaluation Software is provided “AS IS” and may not be
functional on any machine or in any environment. THE WARRANTIES OF SEC-
TION 5 DO NOT APPLY TO EVALUATION SOFTWARE. WE AND OUR SUPPLI-
ERS DISCLAIM ALL WARRANTIES RELATING TO THE EVALUATION
SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE OR
NON-INFRINGEMENT.

2.6.Internet-Based Services Components. Some features of the Software may
require connection to the Internet directly or through a wireless connection in
order to function. Such features may result in the transfer of certain data over
such connections, which may or may not be secured or encrypted. You are solely
responsible for obtaining any necessary Internet wireless subscription plans with
the applicable service providers. You further acknowledge that we are not re-
sponsible for the availability of Internet or wireless connections or the security
or integrity of data transmitted over such connections.

2.7.0wnership. Notwithstanding anything to the contrary contained herein, ex-
cept for the limited license rights expressly provided herein, we, our licensors
and suppliers have and will retain all rights, title and interest (including, without
limitation, all patent, copyright, trademark, trade secret and other intellectual
property rights) in and to the Software and all copies, modifications and deriva-
tive works thereof (including any changes which incorporate any of your ideas,
feedback or suggestions). You acknowledge that You are obtaining only a limited
license right to the Software and that irrespective of any use of the words “pur-
chase”, “sale” or like terms hereunder no ownership rights are being conveyed
to you under this Agreement or otherwise.

2.8.Copyright. All title, rights and copyrights in and to the Software (including,
but not limited to, any images, photographs, animations, video, audio, music,
and text incorporated into the Software, as well as all intellectual property
rights), the Documentation and other accompanying written materials, and any
copies of the Software are owned by us, our licensors and/or suppliers. You shall
not remove, cover, or alter any of our patent, copyright, or trademark notices
placed upon, embedded in, or displayed by the Software or on its Documenta-
tion, packaging and related materials.

3.Payment. Unless a Software has been made available by us at no charge, You
shall pay all fees associated with the Software licensed and any services pur-
chased hereunder as set forth in the applicable Order Form. All payments shall
be made in the currency specified in the applicable invoice within thirty (30)
days of your receipt of such invoice, unless otherwise specified in writing by our
Supplier. Except as expressly set forth herein, all fees are non-refundable once
paid. You shall be responsible for all taxes, withholdings, duties and levies aris-
ing from the order (excluding taxes based on the net income of our Supplier).
Any late payments shall be subject to a service charge equal to 1.5% per month
of the amount due or the maximum amount allowed by law, whichever is less.

4.Term of Agreement.

4.1.Term. This Agreement is effective as of the Effective Date and expires at
such time as all license and service subscriptions hereunder have expired in ac-
cordance with their own terms (the “Term”). Either Party may terminate this
Agreement (including all related Order Forms) if the other Party: (a) fails to cure
any material breach of this Agreement within thirty (30) days after written notice
of such breach; (b) ceases operation without a successor; or (c) seeks protection
under any bankruptcy, receivership, trust deed, creditors arrangement, compo-
sition or comparable proceeding, or if any such proceeding is instituted against
such Party and not dismissed within sixty (60) days. If You have entered into a
separate written agreement with us which governs the Software and that agree-
ment is terminated, then this Agreement automatically terminates and You shall
no longer have any right to use the Software. Termination is not an exclusive
remedy and the exercise by either Party of any remedy under this Agreement will
be without prejudice to any other remedies it may have under this Agreement,
by law, or otherwise. For clarity, even if You have entered into an Order Form with
a Spectra Precision products distributor or reseller, we are a third party benefi-
ciary to that Order Form and has the right to terminate this Agreement as set
forth in this Section 4 (Term of Agreement).

If a Software has been made available by us at no charge, the license remains
effective until terminated in accordance with subparagraphs (b) and (c) men-
tioned above; You decide to terminate this Agreement by ceasing all use of the
Software and destroying or returning all copies; or, without prejudice as to any

other rights, we decide to terminate this Agreement with or without notice if You
fail to comply with the terms and conditions of this Agreement.

4.2.Termination. Upon any expiration or termination of this Agreement, You
shall cease any and all use of any Software and Evaluation Software and destroy
all copies thereof and so certify to us in writing.

4.3.Survival. Paragraph 2.4 (License Restrictions), Paragraph 2.7 (Ownership),
Paragraph 2.8 (Copyright), Section 3 (Payment), Section 4 (Term of Agreement),
Paragraph 5.3 (Disclaimer of Warranties), Section 8 (Limitation of Remedies
and Damages), Section 9 (Confidential Information), Section 10 (Export Com-
pliance) and Section 11 (General) shall survive any termination or expiration of
this Agreement.

5.Limited Warranty and Disclaimer.

5.1 Limited Warranty. We warrant to You that for a period of ninety (90) days
from the Effective Date (the “Warranty Period”) the Software shall operate in
substantial conformity with the Documentation. Because the Software is inher-
ently complex and may not be completely free of nonconformities, defects or er-
rors, You are advised to verify your work. We do not warrant that the Software will
operate error free or uninterrupted, that it will meet your needs or expectations,
that all nonconformities can or will be corrected, or the results obtained through
use of the Software. Our sole liability (and your exclusive remedy) for any breach
of this warranty shall be, in our sole discretion, to use commercially reasonable
efforts to provide You with an error-correction or work-around which corrects the
reported non-conformity, or if we determine such remedies to be impracticable
within a reasonable period of time, to refund the license fee paid for the Soft-
ware. Our Supplier other than us may fulfill our warranty obligations hereunder
on our behalf. Our Suppliers shall have no obligation with respect to a warranty
claim unless notified of such claim within the Warranty Period.

5.2 Exclusions. The above warranty shall not apply: (a) if the Software is used
with hardware or software not specified in the Documentation; (b) if any modi-
fications are made to the Software by You or any third party; (c) to defects in the
Software due to accident, abuse or improper use by You; (d) to Software provided
on a no charge or evaluation basis; (e) to any Third Party Software; or (f) to any
Software obtained as freeware, whether from us, our Supplier or otherwise.

5.3 Disclaimer of Warranties. THIS SECTION 5 IS A LIMITED WARRANTY AND,
EXCEPT AS EXPRESSLY SET FORTH IN THIS SECTION 5, THE SOFTWARE
AND ALL SERVICES ARE PROVIDED “AS IS.” NEITHER WE NOR OUR SUP-
PLIERS MAKE ANY OTHER WARRANTIES, CONDITIONS OR UNDERTAKINGS,
EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, INCLUDING BUT NOT
LIMITED TO WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NONINFRINGEMENT. YOU MAY HAVE OTHER
STATUTORY RIGHTS. HOWEVER, TO THE FULL EXTENT PERMITTED BY LAW,
THE DURATION OF STATUTORILY REQUIRED WARRANTIES, IF ANY, SHALL
BE LIMITED TO THE LIMITED WARRANTY PERIOD. YOU ASSUME THE EN-
TIRE RISK AS TO RESULTS AND PERFORMANCE OF THE SOFTWARE. IN AD-
DITION, WE MAKE NO WARRANTY, EXPRESSED OR IMPLIED, TO SOFTWARE
PROVIDED TO YOU FREE OF CHARGE INCLUDING WITHOUT LIMITATION
FOR ACCURACY, COMPLETENESS, SUITABILITY, PERFORMANCE OR USE.
ANY SOFTWARE PROVIDED BY US AT NO COST IS PROVIDED "AS IS."; ALL
IMPLIED WARRANTIES ARE IN SUCH CASE DISCLAIMED.

6.Support & Maintenance. We shall provide the support and maintenance ser-
vices, if any, as separately purchased by You and specified in the applicable Or-
der Form. Such support and maintenance shall be provided pursuant to our
standard service terms which are available upon request to us. Our Suppliers
may provide additional support services under separate written agreement, but
we are not responsible for any such support unless being a contracting party.

7.Professional Services. Our Supplier shall provide the number of person-days,
if any, of professional consulting services (“Professional Services”) purchased in
the applicable Order Form and related statement of work. If we are providing
Professional Services, unless agreed in a separate written agreement, all Profes-
sional Services shall be provided pursuant to our standard service terms which
are available upon request to us. If your Order Form is with our Supplier other
than us, that party (and not us) is solely responsible for providing Professional
Services and we, not being a contracting party, have no liability related to such
services.

8.Limitation of Remedies and Damages.

8.1.NEITHER WE NOR OUR SUPPLIERS SHALL BE LIABLE FOR ANY LOSS
OF USE, LOST DATA, FAILURE OF SECURITY MECHANISMS, INTERRUPTION
OF BUSINESS, OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUEN-
TIAL DAMAGES OF ANY KIND (INCLUDING LOST PROFITS), REGARDLESS OF
THE FORM OF ACTION, WHETHER IN CONTRACT, TORT (INCLUDING NEGLI-
GENCE), STRICT LIABILITY OR OTHERWISE, EVEN IF INFORMED OF THE
POSSIBILITY OF SUCH DAMAGES IN ADVANCE.



8.2.NOTWITHSTANDING ANY OTHER PROVISION OF THIS AGREEMENT, WE
AND OUR SUPPLIERS’ ENTIRE LIABILITY TO YOU UNDER THIS AGREEMENT
SHALL NOT EXCEED THE AMOUNT ACTUALLY PAID BY YOU TO US UNDER
THIS AGREEMENT.

8.3.THE SOFTWARE IS NOT FAULT TOLERANT AND IS NOT DESIGNED, MAN-
UFACTURED OR INTENDED FOR USE IN LIFE SUPPORT, MEDICAL, EMER-
GENCY, MISSION CRITICAL OR OTHER STRICT LIABILITY OR HAZARDOUS
ACTIVITIES (“HIGH RISK ACTIVITIES”). WE SPECIFICALLY DISCLAIM ANY
EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.
YOU REPRESENT AND WARRANT THAT YOU WILL NOT USE THE SOFTWARE
(OR PERMIT IT TO BE USED) FOR HIGH RISK ACTIVITIES, AND AGREE THAT
WE WILL HAVE NO LIABILITY FOR USE OF THE SOFTWARE IN HIGH RISK
ACTIVITIES. YOU AGREE TO INDEMNIFY AND HOLD US HARMLESS FOR ANY
DAMAGES, LIABILITIES OR OTHER LOSSES RESULTING FROM SUCH USE.

8.4.The Parties agree that the limitations specified in this Section 8 will survive
and apply even if any limited remedy specified in this Agreement is found to
have failed of its essential purpose.

9.Confidential Information. Any software, Documentation or technical informa-
tion provided by us (or our suppliers and agents) shall be deemed our “Confi-
dential Information” without any marking or further designation. Except as
expressly authorized herein, You will hold in confidence and not use or disclose
any of our Confidential Information. Without limiting the foregoing, You ac-
knowledge that the Software constitutes the valuable confidential information
and trade secrets of us and, accordingly, You shall at all times, both during the
term of this Agreement and thereafter keep in trust and confidence all the Soft-
ware, and shall not disclose the same to any third party without our prior written
consent. You acknowledge that disclosure of our Confidential Information would
cause substantial harm to us that could not be remedied by the payment of dam-
ages alone and therefore that upon any such disclosure by You, we shall be en-
titled to appropriate equitable relief in addition to whatever remedies we might
have at law.

10.Export Compliance. You agree to comply with all applicable laws and regula-
tions of the United States of America (“U.S.”) and of other jurisdictions (nation-
al, state, and local) to the extent that they may govern your use of the Software.
In addition, You acknowledge that the Software may be subject to export restric-
tions by the U.S. government and by certain other governments. You shall not,
and shall not allow any third party to, directly or indirectly, remove or export or
allow the export or re-export of any part of the Software or any direct product
thereof: (a) into (or to a national or resident of) any embargoed or terrorist-sup-
porting country; (b) to anyone on the U.S. Commerce Department’s Table of De-
nial Orders or U.S. Treasury Department’s list of Specially Designated Nationals;
(c) to any country to which such export or re-export is restricted or prohibited,
or as to which the U.S. government or any agency thereof requires an export
license or other governmental approval at the time of export or re-export without
first obtaining such license or approval; or (d) otherwise in violation of any export
or import restrictions, laws or regulations of any U.S. or foreign agency or au-
thority laws, or in violation of any applicable export control laws in the country
where the Software has been obtained or is used. You agree to the foregoing
and warrant that You are not located in, under the control of, or a national or
resident of any such prohibited country or on any such prohibited party list. The
Software is further restricted from being used for the design or development of
nuclear, chemical, or biological weapons or missile technology, or for terrorist
activity.

11.General.

11.1.Assignment. This Agreement will bind and inure to the benefit of each Par-
ty’s permitted successors and assigns. We may assign this Agreement to any Af-
filiate or in connection with a merger, reorganization, acquisition or other
transfer of all or substantially all of our assets or voting securities. You may not
assign or transfer this Agreement, in whole or in part, without our written con-
sent. Any attempt to transfer or assign this Agreement without such written con-
sent will be null and void. If You obtain such written consent from us, You shall
permanently assign or transfer all of your rights under this Agreement, provided
You retain no copies and You transfer all of the Software (including all compo-
nent parts, the media and printed materials, any upgrades, and this Agreement),
and the recipient agrees to the terms of this Agreement. If the Software portion
is an upgrade, any assignment or transfer must include all prior versions of the
Software.

11.2.Partial Invalidity. |f any provision of this Agreement is held to be invalid,
illegal or unenforceable to any extent, that provision shall, if possible, be con-
strued as though more narrowly drawn, if a narrower construction would avoid
such invalidity, illegality or unenforceability, or, if that is not possible, such pro-
vision shall, to the extent of such invalidity, illegality or unenforceability, be sev-
ered, and the remaining provisions of this Agreement shall remain in effect,
provided, however, that the court shall have authority and jurisdiction to, and

shall, add to this Agreement a provision as similar in terms and intended to ef-
fect to such severed provision as may be possible and be legal, valid and en-
forceable.

11.3.Governing Law; Jurisdiction and Venue.

11.3.1.1f You obtained this Software in the U.S., this Agreement is governed by
the laws of the State of California (state where Trimble Inc. is located) and the
U.S. without regard to conflicts of laws provisions thereof, and without regard
to the United Nations Convention on the International Sale of Goods
(“UNCISG”). In such case the jurisdiction and venue for actions related to the
subject matter hereof are the State of California and U.S. federal courts
located in Santa Clara County, California, and both Parties hereby submit to the
personal jurisdiction of such courts.

11.3.2.1f You obtained this Software outside the U.S., this Agreement is gov-
erned by the laws of The Netherlands (country where Trimble Europe B.V. is lo-
cated), excluding its rules governing conflicts of laws and without regard to the
UNCISG. In such case each jurisdiction and venue for actions related to the sub-
ject matter hereof are the Dutch courts of the District of Oost-Brabant, The
Netherlands, and both Parties hereby submit to the personal jurisdiction of such
courts.

11.4.Attorneys’ Fees and Costs. The prevailing Party in any action to enforce
this Agreement will be entitled to recover its attorneys’ fees and costs in con-
nection with such action.

11.5.Notices and Reports. Any notice or report hereunder shall be in writing. If
to us, such notice or report shall be sent to the attention of “General Counsel —
Legal Notice — Spectra Precision Products” to “Trimble Inc., 935 Stewart Drive,
Sunnyvale, California 94085, U.S.A.”. If to You, such notice or report shall be
sent to the address You provided upon placing your order or at the time the
Software has been first made available to You. Notices and reports shall be
deemed given: (a) upon receipt if by personal delivery; (b) upon receipt if sent
by certified or registered U.S. mail (return receipt requested); or (c) three (3)
business days after being sent by a reputable international courier requiring
signature for receipt, addresses to the Party at its notice address. Either Party

may change its notice address by written notice to the other.

11.6.Amendments; Waivers. No supplement, modification, or amendment of
this Agreement shall be binding, unless executed in writing by a duly authorized
representative of each Party to this Agreement. No waiver will be implied from
conduct or failure to enforce or exercise rights under this Agreement, nor will
any waiver be effective unless in a writing signed by a duly authorized represen-
tative on behalf of the Party claimed to have waived.

11.7.Entire Agreement. This Agreement is the complete and exclusive state-
ment of the mutual understanding of the Parties and supersedes and cancels all
previous written and oral agreements and communications relating to the sub-
ject matter of this Agreement. No provision of any purchase order or in any other
business form employed by You will supersede the terms and conditions of this
Agreement, and any such document issued by a Party hereto relating to this
Agreement shall be for administrative purposes only and shall have no legal ef-
fect. Notwithstanding the foregoing, if You have entered into a separate written
license agreement signed by us for use of the Software, the terms and conditions
of such other agreement shall prevail over any conflicting terms or conditions in
this Agreement.

11.8.Independent Contractors. The Parties to this Agreement are independent
contractors. There is no relationship of partnership, joint venture, employment,
franchise or agency created hereby between the Parties. Neither Party will have
the power to bind the other or incur obligations on the other Party’s behalf with-
out the other Party’s prior written consent.

11.9.Force Majeure. Neither Party shall be liable to the other for any delay or
failure to perform any obligation under this Agreement (except for a failure to
pay fees) if the delay or failure is due to unforeseen events, which occur after
the signing of this Agreement and which are beyond the reasonable control of
the Parties, such as strikes, blockade, war, terrorism, riots, natural disasters, re-
fusal of license by the government or other governmental agencies, in so far as
such an event prevents or delays the affected Party from fulfilling its obligations
and such Party is not able to prevent or remove the force majeure at reasonable
cost.

11.10.Government End-Users. The Software is commercial computer software.
If the user or licensee of the Software is an agency, department, or other entity
of the U.S. Government, the use, duplication, reproduction, release, modifica-
tion, disclosure, or transfer of the Software, or any related documentation of any
kind, including technical data and manuals, is restricted by a license agreement
or by the terms of this Agreement in accordance with Federal Acquisition Reg-
ulation 12.212 for civilian purposes and Defense Federal Acquisition Regula-
tion Supplement 227.7202 for military purposes. The Software was developed
fully at private expense. All other use is prohibited.



11.11.Third-Party Software. |f designated in the Documentation, the Software
may contain or be provided with certain Third-Party Software (including software
which may be made available to You in source code form). Such Third-Party
Software is not licensed hereunder and is licensed pursuant to the terms and
conditions indicated in the Documentation and/or on the Third-Party Software
conditions (“Third-Party License”). Except as may be set forth in the Third-Party
License, neither we nor our Suppliers offer any warranty in connection with any
Third-Party Software and neither we nor our Suppliers shall be liable to You for
such Third-Party Software.

11.12.0fficial Language. The official language of this Agreement is English. For
purposes of interpretation, or in the event of a conflict between English and ver-
sions of this Agreement in any other language, the English language version
shall be controlling.

11.13.Reservation of Rights. We reserve all rights not expressly granted by this
Agreement.

If an executed agreement exists between You and us at any time regarding the
Software, the terms of that agreement shall supersede the terms of this Agree-
ment in its entirety. Thus, if You enter into a separate written agreement with us
regarding the Software, that agreement (not this one) will control your use of the
Software; and further if that agreement is terminated, You will not have the right
to use the Software under the terms of this Agreement after termination. Not-
withstanding the foregoing, pre-printed terms and conditions on your Order form
shall not supersede this Agreement.

Data Collector Warranty Program

Spectra Precision would like to make you aware of the warranty program. A new
data collector that has been purchased and is still under the one year factory
warranty or under an extended warranty will be authorized for software updates.
Data collectors that are not currently under a warranty plan are eligible to pur-
chase an extended warranty. There are Survey Pro software only warranties that
will authorize the data collector for software updates, and there are warranties
that cover both the data collector hardware and Survey Pro software. The extend-
ed warranties are a good way to protect your investment in your equipment.

The Survey Pro installation program will use your internet connection to compare
the data collector's serial number against a data base that contains the warranty
status on all units. If the unit is under a valid warranty, the installation will pro-
ceed. If the unit is not covered under warranty, then a message will be displayed
informing you of this and the installation will stop.

To receive Survey Pro minor improvement releases, identified by the version
numbering system, you only need to be on the current version of the latest minor
update. In other words, if you have version 5.0.x you are authorized for a version
5.0.5 improvement release automatically. For minor updates, 5.0 to 5.1 for ex-
ample, it is now required that the data collector or Survey Pro software be on a
current warranty plan.

The warranty plans are listed on Spectra Precision price lists. Data collector se-
rial numbers are required in order to generate the proper registration codes for
your unit and to log the warranty plan into the database.



Survey Pro User Guide Release Notes, October 2016

The content of this new Survey Pro User Guide reflects the
changes and enhancements made to Survey Pro 6.0
compared to Survey Pro 5.8:

1. Survey Pro is now compatible with Windows 10 devices.
When run on a Windows 10 device, Survey Pro takes full
control of the device (processor and display screen) until
you leave the application. The user interface remains es-
sentially the same: all screenshots illustrating this guide
are consistent with what you will see on the display
screen of a Windows 10 device.

2. Quick Codes: Descriptions or Features may now be en-
tered by pressing numeric keys (0 to 9). This method
may be faster than by touching on-screen buttons, which
was until this new version the only possible way to attach
descriptions or features to points (see Appendix - Quick
Codes Function).
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1. Welcome to Survey Pro
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Congratulations on your decision to purchase a Spectra Precision product.
Spectra Precision is serious about providing the best possible products to its
customers and knows that you are serious about your tools. We are proud to
welcome you to the Spectra Precision family.

This manual will guide you through your first steps using Survey Pro. Whether
you are using optical or GNSS equipment, or whether you want to perform
leveling fieldwork, you will find here key instructions and explanations for a
successful start.

If you are new to Survey Pro, reading the first three sections will help you
understand the organization and workflow of the software. Chapter 3 will also
give all the details to understand what a “receiver profile” is and how it is used
to easily connect to and configure a GNSS receiver for RTK and/or post-
processing data collection.

The rest of the guide is dedicated to helping you start your field work.

e Station setup is an essential step when surveying with an optical
instrument: this guide discusses the Known Point, Resection and Multiple
Backsights routines, followed by a short description of a few standard
surveying procedures (traverse/sideshot, repetition).

e Choosing the right coordinate system before starting a job with GNSS is
also an essential step: the guide will take you through the different possible
scenarios, followed by a short description of standard data collection
procedures.

e Collecting elevations in level loops is explained in Chapter 7. Leveling on
page 72.

e Stakeout routines are functions common to optical and GNSS surveying.
These are introduced in 8. Stakeout Routines on page 82.

e The last section provides instructions specific to Survey Pro running on
Nikon Nivo and Spectra Precision FOCUS total stations.

From your first successful experience with Survey Pro, based on the
information provided in this guide, you will be able to extend your knowledge
of the software to its many other functions, relying on your own experience as
a surveyor and referring to the on-line Help whenever necessary.



Conventions Used

The following conventions are used:

e Text strings in bold font represent the names of software items such as
fields, buttons, check boxes, tabs, messages, screens, menus, etc.

e The symbol “>" is placed between menus, tabs and/or buttons to indicate
that you have to tap on these parts successively in that order.

e When referring to both optical instruments and GNSS receivers, the term
“instruments” will be used to encompass the two types of equipment.

The following acronyms and abbreviations are used:

e BS: Backsight

e EDM: Electronic Distance Meter

e NEE: Northing, Easting, Elevation (grid coordinates)

e HA: Horizontal Angle

e || H: Latitude, Longitude, Height (geodetic coordinates)
e PPM: Part Per Million

e SD: Slope Distance

e SS: Side Shot

e ZA: Zenith Angle

The following conventions are used when inputting or outputting angles:

e Azimuths, latitudes, longitudes are entered in degrees-minutes-seconds
format and are represented as DD.MMSSsss, where:

— DD: One or more digits representing the degrees
— MM: Two digits representing the minutes
— SS: Two digits representing the seconds

— sss: Zero or more digits representing the decimal fraction part of the
seconds.

E.g.: 212.0805 would indicate 212 degrees, 8 minutes and 5 seconds.

e Bearings can be entered in either of the following formats:
— $32.0805W to indicate South 32 degrees, 8 minutes, 5 seconds West.
— 332.0805 to indicate 32 degrees, 8 minutes, 5 seconds in quadrant 3.

When a field accepts a time for its input, the time is entered in hours-minutes-
seconds format, which is represented as HH.MMSSsss, where:

— HH: One or more digits representing the hours
— MM: Two digits representing the minutes
— SS: Two digits representing the seconds

— sss: Zero or more digits representing the decimal fraction part of the
seconds.



2. Introduction to the Survey Pro User Interface
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On launching Survey Pro, you will first be asked to open a job. When done, the
software will open at the Home screen. The home screen shows a selection of
the functions you will most frequently use in the field. You can customize the
Home screen based on your needs.

If this is your first time using Survey Pro, a message box will inform you how
you can customize the items and layout of the functions on the Home screen
(see How to Customize the Home Screen on page 5).

Because some of the available Survey Pro functions are mode dependent
(optical, GNSS), there is a different Home screen for each mode. That also
means there is a slightly different default Home screen depending on which
instrument is used. See below, from left to right: Optical, GNSS, Leveling.

E e e
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GNSS Status

Start Survey
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The functions available from the Home screen are taken from the Main Menu,
which contains all the possible Survey Pro functions.

You can access the functions available from each submenu by tapping the
corresponding submenu icon.

Each submenu, and all the functions attached to the submenu, are
represented by icons of the same background color. For example the File
submenu and its functions are all in green.



SWitChing Between The table below lists the buttons allowing you to navigate between the Home
Home Screen and screen and the Main Menu and its submenus.

Main Menu Icon / Check boxes | Result

m Takes you to the Home screen from the Main Menu or any submenu.
E Takes you back to the Main Menu from the Home screen.
E Takes you back to the Main Menu from an open submenu.

The default Home screen has only one page so there’s only one blue dot (a
radio button), and it is necessarily checked.

When adding functions through customization, other pages may be created
for the Home screen to accommodate all the added functions (see How to
Customize the Home Screen on page 5). In that case, tap one of the radio
buttons to display the desired page.

Command Bar The command bar is that portion of the Survey Pro screen that remains always
HH displayed whether the Home screen, the Main Menu or one of its submenus is

Desc"ptlon displayed. The command bar contains the following items:

e Map View [1]: This button will access the map view of the current job when
it is tapped. The map view is available from many screens (see Map View
on page 8).

e Central [2]: This icon shows the status of the connection to the Spectra
Precision Central cloud file synchronization service. It will be in one of the
four states below.

Icon ‘ Spectra Precision Central Status

,:b;:j Not signed into Spectra Precision Central

':‘CE;J Signed into Spectra Precision Central and file sync state is normal, with no errors.

,:'czio-] Signed into Spectra Precision Central, file synchronization in progress.

:CE;‘] Signed into Spectra Precision Central, and there is some problem with the file sync state.

Tap this icon to sign in to your organization’s cloud account, or to see more
detailed information about the file sync state once you are signed in.

¢ Instrument Used [3]: The Instrument icon indicates the mode (optical,
GNSS or leveling) that the software is in, and the type of instrument the
software is currently associated with.



How to Customize the
Home Screen

Icon ‘ Current Instrument Selection

Optical instrument
E GNSS receiver

Leveling

This icon is also used to change the instrument and perform additional
settings on this instrument. See 4. Choosing a Surveying Mode -
Connecting Survey Pro to an Instrument on page 23.

o Battery Level [4]: The battery icon displays the condition of the data
collector’s rechargeable battery. The icon has five variations depending on
the level of charge remaining, and a sixth variation to indicate battery
charging.

‘ Meaning

100% charge remaining

[IIm] |75% charge remaining

50% charge remaining

25% charge remaining

Less than 5% charge remaining

NN EEEE

4 Battery charging from AC adaptor

Tapping the battery icon is a shortcut to the Windows Mobile Power
Settings screen.

e Quick Pick [5]: The Quick Pick button will open a customizable list of
routines. To quickly access a routine, just tap on it (see Quick Pick on
page 108).

e Online Help [6]: This button opens the online help, which allows you to
access information for each screen.

A message is displayed right after opening or creating a job asking you to “Tap
and hold on menu items to manage the Home screen”. This message prompts you
to customize the Home menu so that only the functions you will most
frequently be using in the field will be made available from this screen.
After you have become familiar with the customization process and next time
you launch Survey Pro, you can dismiss the message by checking the Don’t
show this again prompt before tapping OK to close the message.



Adding a Function

This is a three-step procedure:

e (o to the Main Menu, then to the submenu containing the function you
would like to add to the Home screen.

SETE — e Tap and hold the corresponding function item and select Add to Home.

E ® m Survey Pro then shows the Home screen with all the possible free locations

ﬂStationSetup @smings ;@ for the new function, all represented as unnamed icons. Note at this point
Traverse | @;:‘,:, et Raw 5] | that all the icons are shown with the same background color (see example).

e Tapon afree icon (an unnamed one) or on the icon of an existing function.
The new function is inserted at the tapped location. Icon colors are then

ﬁ @ Stake to Line V* restOred .

@Remteco,m. mgxn ? If you tap on an existing function, this function and the next ones are

] []
Repetition Shots L4} Stake Points [II11}

" shifted down by one location. Survey Pro will automatically create a new
page of Home screen if the resulting number of functions on the screen is
greater that what the screen can accommodate.

Removing a Function

On the Home screen, tap and hold the function you want to remove and select
Remove Item. This instantly removes the function from the Home screen.

Moving a Function

e Onthe Home screen, tap and hold the function you want to move and select
Move Item. Apart from the function you want to move, which keeps its
original appearance, all other function items change color to blue.

e Tap on the location where you wish to move the function. This may be a free
location, or the location of an existing function. If you tap on an existing
function, the moved function will be inserted at the selected location and
the function at that location and the ones that follow will be moved down.

Home Screen Pages

The default home screen consists of a single page. You may add up to three

additional pages as part of the Home screen in order to make your many

favorite functions accessible from this set of pages.

e Adding a page is done by tapping and holding any function on the Home
screen and selecting Insert Page Before or Insert Page After.

e Switching from one page to the other is done by tapping on radio buttons
at the top of the screen.

e Removing a page is done by tapping any location on that page and selecting
Remove Page. This action requires user confirmation.



Screen Details The screen example below illustrates the different types of items you will
usually encounter on the screen when using the different Survey Pro functions:

Point in Direction
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e Input Field [1]: An area where you can enter a specific value.

e Qutput Field: Only displays a value that cannot be changed.

e Simple Button [2]: Typically used to run the function described by its
name. Just tap it to run the function. When the button name appears in red
characters, you can alternately press the Enter key on the keypad to
perform the same action.

e Power Button [3]: Typically used to provide context-sensitive functions to
modify the corresponding field. Once you have tapped on it, a drop-down
list will appear with several choices. Simply tap the desired choice from the
drop-down list.

e Choose From Map Button [4]: Always associated with a field where an
existing point is required. When the button is tapped, a map view is
displayed. To select a point for the required field, just tap it from the map.

NOTE: If you tap a point from the map view that is located next to other points,
another screen will open that displays all of the points in the area that was tapped.

Tap the desired point from the list to select it.

e Scroll buttons [5]: When a button label is preceded with the > symbol, it
indicates that the button label can be changed by tapping it, thus changing
the type of value that would be entered in the associated field. As you
continue tapping a scroll button, the label will cycle through all the
available choices.

e Check boxes [6]: Tap on these boxes to successively check or clear the
corresponding option.

e Tabs [7]: Many screens show tabs, which look like the tabs on index cards.
Tapping on a tab displays a subset of information part of the selected
screen.
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The following buttons will appear in the area usually occupied by the
command bar.

OK button. Accepts the changes made and closes the window.

Cancels the changes made in the open window

Closes the current window

Quick access to the relevant Settings screen

Quick access to the Help system

Quick access to the Quick Pick list.

O~ S

The map view is a graphical representation of the objects in the current job. It
will show basemaps in the background if you are using one (see screen
example).

Basemap files may be either raster images (such as a georeferenced TIFF file,
or a JPG image with an associated world file), CAD drawings (DXF files) or
Open Street Map files (OSM format).

There are different map views depending on how the map view is accessed.
Each can display slightly different information, such as a vertical profile. A bar
is shown at the bottom of every map view that indicates the scale. The buttons
along the left edge of the screen allow you to change what is displayed in the
map view.

TIP: You can pan around your map by dragging your stylus across the screen.

1 -
The “main” map view is the one you get after tapping in the command
bar (from the Home screen or Main Menu).

From all those screens including a [
after tapping this button.

The “main” map view, as well as any map view accessible from a survey
routine, will also function as an “active” map. That means you can perform
several actions directly from the map. Tap and hold on the map to bring up a
context menu of available actions. The actions available will depend on what
you have selected at the tap-and-hold location.

button, you will also display a map view



Create Point

Location to Point

Location to Location

Location to Line

Stake to Location

Set User Zoom Extent

Show Results

If Optical or GNSS is selected, the main map can also function as an interface
to collect measurements. Tap and hold on the main map and choose Survey
Mode to enable the Measurement interface (see screen example for GNSS).
When in Survey Mode, you can collect data from the main map by tapping on
one of the available buttons (see table below).

You can also press the Enter key to trigger an observation. By default, the Enter
key will trigger a “Topo” observation. You can change the Enter key to trigger
a point observation by clearing the Survey Map Use Enter Button for Topo prompt
on the Job > Settings > Surveying tab.

Shortcut buttons are available to optimize your work. These are defined below:

Optical Function | GNSS | Function

- Mechanical optical instrument: Triggers the
instrument to take a shot in the current mode (fine
or coarse). == .

T/\ - Robotic optical instrument: Similar to GNSS, i.e. |+ One-epoch point measurement
takes the latest tracking mode data and stores a
point.

- Mechanical optical instrument: Takes a fine
mode observation.

?1_ - Robotic optical instrument: Opens up the remote T@ x&::ggg: r;ct:ilgrt])measurement
control screen where you will hit the Take Shot P
button to take a fine mode observation.
TE Setting target height TE Setting antenna height
% || station setup ,".i:.u GNSS status

The main map view includes two additional toolbars:
e The Zoom toolbar
e The Snap-To toolbar

These are described below.
e The Zoom toolbar is always shown.

e Ta c} to show the Snap-To toolbar, - to hide it.
p p
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Displayed Coordinates

The last computed coordinates of the GNSS rover or rod (optical) are
constantly displayed in the lower part of the active map screen as you move
around in the working area. In addition, the name and coordinates of the last
point saved (if any) will be displayed on top of the active map view.

Coordinates will all be expressed in either “NEZ"”,"ENZ", “XYZ" or “YXZ"
coordinates, depending on your choice of Coord. Order in Job > Settings > Units
tab,

Viewing coordinates on the active map view is activated by default. You can
choose not to view coordinates by disabling the corresponding option:

e Tap @ on the map view
e (Clear the Show Coordinate check box.

e Tap @ to save your changes and close the Map Display Options window.
Zoom Toolbhar

Button ‘ Function

Zoom Extent button: By default, will set the map view so that all the points in the
current job can be seen. If configured as a “User Zoom Extent” button, will restore
a different view of the map (see “User Zoom Extent” Button on page 11).

Will zoom the current screen in by approximately 25%.

Will zoom the current screen out by approximately 25%.

Allows you to drag a box across the screen. When your finger or stylus leaves the
screen, the map will zoom to the box that was drawn.

Prompts you for a point name and then the map view will be centered to the speci-
fied point with the point label displayed in red.

B8 0L &
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Snap-To Toolbar

0"" Snap to nearby point.

‘;"-. Snap to the midpoint of the selected line segment.

+ Snap to the nearest of the begin point or the end point of the selected line segment.

' Snap to the intersection of two straight line segments. You cannot snap to the inter-
(] section of line segments that are curves or spirals.

--‘-;- Snap to the point of intersection (PI) of the selected curve segment.

=y
]
’

ot

Snap to the radius point (RP) of the selected curve segment.

Snap to the nearest point on the selected straight line or curve segment.

&
@ Remove all of the Snap To temporary points created on this map.

“User Zoom Extent” Button

The Zoom Extent button may be changed into a User Zoom Extent button, and

vice versa. The button keeps the same aspect but has a slightly different

function. Rather than showing all the visible points in the job (Zoom Extent

button), the User Zoom Extent button will restore the view of a specific area on

the map that you will have chosen beforehand.

Setting the User Zoom Extent button:

e Adjust the map view so that the area you are interested in entirely occupies
the screen (use the zoom buttons and drag the map accordingly).

e Once this is done, tap and hold anywhere on the map view and select Set
User Zoom Extent. A blue dashed frame appears encompassing the entire
view, meaning you have now defined your “user area”.

From now on, tapping will always takes you back to the display of the
user area, whatever the various zoom/drag changes you may have made in
the meantime. Whenever the current zoom & pan setting allows it, the red
frame will appear showing the size and location of the user area on the
current map view.

11



Clearing the User Zoom Extent Button:

e Tap and hold anywhere on the map and select Clear User Zoom Extent. The
user area no longer exists (the red frame disappears from the screen).

From now on, the ] button has recovered its default function, which is
to set the map view so that all the points stored in the open job can be
viewed on the screen.

“Follow-me” Function

When you are holding a GNSS rover or a prism, you may want to keep your
| View Map - 5-28-15 current location always visible on the map screen.
" * ! This is the purpose of the Follow-me function, which will pan the map so that
your location as you walk around can continuously be seen on the map view (it
will be shown as close as possible to the map center, usually within an area
representing three quarters of the map area around its center).
e To activate the Follow-me function, tap and hold anywhere on the map and

select Set “Follow me”.

i @[] e 2 The symbol used to represent your location is a small arrow pointing in your
walk direction. About every 4 seconds, and for about 1 second, it is
replaced with a GNSS antenna or prism icon, depending on the surveying
mode currently used. A gray cross-hair will appear centered on your location
clearly indicating that the Follow-me function is on (the cross-hair will
always be the same size whatever the zoom setting).

¢ To deactivate the Follow-me function, tap and hold anywhere on the map
and select Stop “Follow me”. The gray cross-hair is then removed from the
screen.

e The Follow-me function will automatically be stopped whenever you
manually drag (pan) the map to such an extent that your current location
on the screen is moved outside of the centered “three-quarter area” on the
map view.

5
8,646, E:-6 162 460401, 2:50,561

!
— soln; Fixed HPrec: 0,001 VPrec: 0,00:
D N:7 6:
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3. Creating a Job

Survey Pro cannot start without a job being open. Upon launching Survey Pro, the
Welcome to Survey Pro screen will guide you through the process of creating a new job
or opening an existing job.

NOTE: Upon launching the onboard version of Survey Pro, the initial screen allows you take
measurements without having to open a job. Refer to 9. Survey Pro’s On-Board Version on
page 94.

e Tap the New button. The New Job screen opens, which prompts you for a job name
where the current date is the default name.

1 9 0 2 T ° O

Open a Recent Job Directory: “Survey Pro Jobs,
% Filename | Modified Open
17-10-11 12-10-11 0 P Mew Tob Name: ﬁ
Browse..,
Current Settings:
Azimuth Type: Morth Azimuth =]
4] 1] I ¥ Grid Direction: Morth and East 1=
@ Open an Existing Job ———————— Unit for Distances:  International Feet
| Browse,.. | Hnlct fDE Ang\ees‘:r E)Iegreees =
% Create a MNew Job 4] Il I3
| e, .. | | Create Job Mow | | Settings >

e Either type in a new job name or accept the default name.
e You can create the job in two different ways:

1. Tap the Create Job Now button. The new job will be created with the current
default settings (as listed at the bottom of the screen) and will be stored in the
default directory (\Survey Pro Jobs\).

2. Tap the Settings button to access the different job settings (see below). After
you have gone through the different settings, tap the Finish button. This will
create and store the new job.

NOTE: The job names listed in the upper portion of the screen are those of the most recent jobs
you opened in Survey Pro. This list does not necessarily reflect the list of jobs stored in your data
collector. If you are looking for a job stored in your data collector, use the Browse button.
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Job Settings

The settings and values entered for a new job become the default values for any

subsequent new jobs. A short description of the jobs settings is given below.

[1

iNewsob  KEEI-IREPA| New Job

(@ No control or reference file
O Use a Control File f

North Azimuth &

Azimuth Type:

id Direction: North and East N I
farkd Aretions o O Use an external Reference File I
Units for Distances: Meters v Control File
Units for Angles: Degrees i |

Earth Curvature & Refraction

| Refraction Coefficient:

[ <Back |[ Next> |

< Back || Next > |

Units [1]: When creating a new job, set all the desired units for the job. You can
also enable the setting for Earth Curvature and Refraction correction for optical
measurements.

Control/Reference File [2]: Control points can optionally be imported from another
existing job by checking the Use a Control File check box. After tapping Finish to
create the job, a message will indicate the number of imported points. If you are
using a control file, by default the coordinate system of this control file will be used
for the new job. You can override this default setting on the coordinate system
page. A control file can be imported from either a .Job or .Survey file.

You can also use the points from a reference file (also a .Job or .Survey file) by
checking the Use an External Reference File check box. Any of the points read from
this file will be usable as a reference point in the new job.

About Control Files and Reference Files: A control file contains a list of control points. When
selecting a control file during the job creation phase, you allow Survey Pro to import all the
control points from this file into the job file. For example if the selected control file contains
10 control points, the newly created job file will contain 10 points (+1 if you optionally
defined a start point; see below).

A reference file contains a list of reference points. When selecting a reference file during the
job creation phase, you allow Survey Pro to show all the reference points stored in this file
from within the open job (reference points will show up on the map view and in the list of
points), but these points are not imported into the job file. That's why they are not
represented the same way as the other points (a different icon is used). But if you pick a
reference point to be used as a setup point (whether in optical or GNSS), or for any reason
that requires a point for calculations, this reference point — and only this one — will be
imported into the job (and will change icon).

NOTE: Basically, a reference file is not different from a control file because control points
and reference points are not different by nature; Both types can be any point of interest,
which you consider to be useful to complete your survey.




Select Coordinate System
- Select Coordinate System -

() Zone from Datsbase @ Broadcast RTCM
Region:  |US State Plane 1983 -
Zzone:  |Oregon South 3602 -
Datum: Broadcast RTCM Datum

Use Geoid 1 |GEQIDGS (Conus) -
< Back Next =

If you don’t need any points from another file for the job, select No control or
reference file and tap Next>.

[3] | New Job

=m0 [4] 7m0
Select Coordinate System Enter First Point
- Select Coordinate System -
@ Zone from Database (O Broadcast RTCM
PORIAN S State Plane 1983 M | X 5000 m
Zone: [Alabama East 0101 ] Y: 200.0 m
Datum: ~ [NAD 1983 (Conus) g z
Use Geoid : [RAF09 (France) B Description: Start
[ <Back |[ nNext> | [ <Back |[ Finish |

Select Coordinate System [3]: When you are using a control file, you can start the
job with the control file’s coordinate system, or you can pick a different coordinate
system from the database. If you don’t have a control file, you need to choose the
coordinate system for the job. To select the coordinate system for the new job:

Clear the check box when you are doing an optical survey with a ground scale
factor of 1, or if you are doing a GNSS survey and there's no known projection
or datum for your local grid coordinates.

Check this box when your local grid coordinates are defined by some known
map projection and datum. In this case, select Zone from Database and specify
the region (Region), zone (Zone) and datum (Datum) of your working area.

In GNSS Survey only, the datum may be defined in a different way using RTCM
messages 1021 and 1023 received from some NTRIP networks that broadcast
these messages. In this case, check Broadcast RTCM and specify the region
(Region) and zone (Zone) of your working area. The datum will be provided by
the RTK network.

Understanding Scale Factor for your coordinate system:

If your job has “no coordinate system”, Survey Pro automatically sets the scale
factor for optical measurements to “1.0"”. This means that the distance
measured on the ground will be 1:1 to the distance on the grid. If you start a
GNSS survey, Survey Pro will use default Ground Calibration mode to calculate
your grid coordinates from GNSS measurements.

If your job is using a map projection and datum, Survey Pro will automatically
calculate the correct scale factor for each station setup so the distance
measured on the ground will properly be reduced to the coordinate grid. If you
start a GNSS survey, Survey Pro will use the selected projection to calculate
grid coordinates from GNSS measurements.
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Importing Data

NOTE: You can modify the default optical scale factor settings in the Job > Settings > Scale
Factor tab.

e First Point [4]: A default point name and coordinates are prompted to become the
first point in the job. You can freely change the name and coordinates of this point
before creating it. You may also clear the box if you do not want to create a new
point at this stage.

You may start your measurements now if you don’t need anything else in your job at
this time. In that case, go directly to 4. Choosing a Surveying Mode - Connecting
Survey Pro to an Instrument on page 23.

If you need to add data (points, polylines, alignments, etc.) into your job before
starting, the sections below will tell you how to import or create/edit data from within
the open job. The last section lists the possible formats in which the data stored in
the job can be exported.

Use the File > Import function to add points to the open job. The points may be

imported from different file formats, using default importers:

e Survey Pro native formats (*.Survey, *.JOB, *.JXL, *.CRb). JXL is the extension for
files in JobXML format, a Spectra Precision standard format for point, alignment,
and measurement data.

e LandXML (*.XML), an industry standard format for point, alignment, and
measurement data.

e Text format (*.TXT, *.CSV). An Import ASCII wizard will help you define the content
of every TXT file you will import.

Data may also be imported form other formats (GDM, KOF, SFN, Surpac) using custom
importers created in IXL (XML) format.

Survey Pro will parse and import all the known elements from the chosen file. These
elements will be added to the current job as points, polylines and alignments. See the
definition of these elements in Editing Points on page 17, Editing Polylines on
page 20 and Editing Alignments on page 20.

The File > Import Control function is used to import points onto the control layer of your
job. Points on the control layer are protected from being modified. Control files should
be in *.Survey or *.JOB format.

The File > Reference File function is used to add points to the current job without
importing them into the job file. You see all of your reference points on the map and
in point lists. You can use any reference point in Survey Pro as if it were a regular
point stored in your job file.



Editing Points

Edit Points ? 20
a[a]+[] vms -
Point [ Description [ Worthing (m) _[<]
+ CBM3 T 150,000

471 B 190,000
4772 B 110,000
P13 B 190,000
+rT4 B 190,000
+PT55 5g 1,520,000

A point in Survey Pro has coordinates and properties. A point’s coordinates can be

derived in one of two ways:

e Key-in point: The coordinates for this point were entered using the Job > Points
function or this point was created by importing data to the job.

e (Observed point: The coordinates for this point are calculated from measurements
in the current job.

NOTE: To see the current coordinates and properties of a point, you can tap the point on the
map. This will open the Point Details screen showing the Origin of the point, which describes
how the point was created.

Managing Points

All points in a job file, whether keyed-in or computed from observations, can be
viewed using the Job > Points function. Points in the job will be either active or
deleted. Active points can be used in Survey Pro. Deleted points exist in the job file
database, but must be undeleted before they can be used in Survey Pro.

The following icons are used to identify the different types of existing points:

lcon | Point type

.E. Design point

@ Reference point

r" Staked point

+ Point (undifferentiated)
"ﬁ’ Deleted point

The drop-down list available from the right-upper corner of the screen allows you to
view all the active —i.e. non-deleted— points (select Show Points), the previously
deleted points (select Show Deleted), only the design points (select Design Pts. only),
only the staked points (select Staked Pts. Only), both design and staked points (select
Design & Staked Pts. Only), or all of them (select Show All).

Use the three or four buttons located at the top of the screen to manage your points:

o : Allows you to search for the first point in the displayed list meeting the search
criterion you define. You may define a criterion on the point name or the point
description. You can also search by point code (FXL auto linework and attribute
code).

: Will become active only after Survey Pro has found the first point in the list

meeting your search criterion. Each new press on this button will view the next
point in the list also meeting the search criterion.
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o : Allows you to insert a new point to the list. A name will be prompted by
default for the new point, based on the name of the currently selected point.
Entering the definition of a new point is organized into three different tabs (see
Creating a New Point on page 18). Note that defining a point as a design or staked
point can only be done using Manage Design Points on the Stakeout menu.

o : Allows you to edit the selected point (see Modifying a Point on page 19).

Also, when you tap and hold a point in the Show Points list, a context-sensitive menu
is displayed giving access to the following functions:

e Delete Point: Allows you to delete the selected point.

A deleted point is marked with the () icon, placed before its name.
e Delete Points: Prompts you to make a multi-selection of points and then deletes all
these points.

¢ View Point Details: Allows you to get a read-only view of the point origin, coordinates,
properties and notes. The information is split into three different tabs: Details,
Derivation and Notes.

e View Raw: Takes you to the Raw Data view on which the step during which the point
was created is highlighted. The Raw Data view can also be selected from the main
menu by tapping Job > View / Edit Raw Data.

e View Map: Takes you to the map screen where the selected point is shown at the
center of the screen.

Double-clicking a point in the list is equivalent to selecting View Point Details in the
context-sensitive menu.

When you tap and hold a point in the Show Deleted list, a context-sensitive menu is
displayed giving access to the following functions:

¢ Undelete Point: Will take this deleted point back to the list of existing points. The
undeleted point will recover its original icon.

e View Point Details: Same as above.
e View Raw: Same as above.

Creating a New Point

Select any point in the list and tap to insert a new point:

e The General tab allows you to name the new point, add a description if necessary,
assign a layer to the point and possibly attach a picture to it (using the built-in
camera or by selecting an image file from the disk).

e The Location tab allows you to enter coordinates for the point. You can enter Grid,
global geodetic (WGS84 LLH) or local geodetic (Local LLH) coordinates.

— Grid: This point’s local grid coordinates are the Northing, Easting, Elevation
values that were keyed in or imported. This point’s global geodetic coordinates



will be calculated by transforming grid coordinates into latitude, longitude,
height coordinates using the current projection.

— Global geodetic: This point's WGS84 coordinates are the latitude, longitude
and height values that were keyed in or imported. This point’s local grid
coordinates will be calculated by transforming geodetic coordinates into
Northing, Easting, Elevation coordinates using the current projection.

— Local geodetic: This point’s local geodetic coordinates are the latitude,
longitude and height values that were keyed in or imported. This point’s grid
and global geodetic coordinates will be calculated by transforming the local
geodetic coordinates with the current projection.

When there is no projection set or solved, there is no way to transform the keyed
in values into grid or geodetic coordinates. You will see these coordinates are
missing when you look at the point details.

The Feature tab allows you to associate one or more feature codes to the point. For
more information on Descriptions, Layers, Feature Codes and Notes Descriptions,
Layers and Features, see Advanced Information on Point Properties on page 100.

Modifying a Point

Select the point you want to modify and tap .

Survey Pro will show two additional tabs compared to when you inserted the point:

— Derivation: This is a read-only tab indicating the type and origin of the point.

— Notes: This tab allows you to add as many notes as needed to the point. Each
note is date & time tagged.

— The data shown on the General, Location and Feature tabs can normally be
modified.

Transforming a computed point into a key-in point: Use the Edit Location button on
the Location tab to change the two horizontal coordinates or/and the one vertical
coordinate.

For example, using a total station or GNSS, you observe a point and measure its
three coordinates. This point is in addition a benchmark providing an elevation
reference. You may want to fix the vertical coordinate to what is written on the
benchmark sheet rather than keep the measured elevation. Using the Edit Location
button, you can change the measured vertical coordinate to a keyed-in coordinate
while keeping the horizontal coordinates as measured.

Multi-Point Selection

With a selection of multiple points, you can use the same button to modify the
description and layer of the entire selection in one operation.

Selecting several points not in sequence is obtained by first activating the Control key
and then tapping successively on the points to edit. The Control key is accessible from
either the virtual keyboard (CTL key on Nomad, Recon or ProMark 220) or the real
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Editing
Polylines

Editing
Alignments

Exporting
Data

Generating
Survey Reports

keyboard (CTRL key on Ranger). The Shift key can also be used to select several points
in sequence.

A polyline in Survey Pro is a line connecting points together. Each vertex of the line
is defined by an existing point, whether an observed or keyed in point. Points in
polylines can be connected with either straight segments or horizontal curves.

You can use the polyline editor to modify polylines (go to Job > Edit Polylines). The
polyline editor is described in the Online Help.

An alignment in Survey Pro is a line defined by vectors starting at a Point of Beginning
(POB). The POB can be an existing point in the job, or just location coordinates.
Alignments can have horizontal segments and optionally a vertical profile. Horizontal
segments can be straight segments, circular curves or spiral curves. A vertical profile
can be defined using a vertical curve and straight grade segments.

You can use the alignment editor to modify alignments (go to Job > Edit Alignments).
The alignment editor is described in the Online Help.

You can import alignments for staking, using Roads > Edit Roads menu. Alignments
imported using this function can be viewed in the alignment editor but cannot be
modified.

Use the File > Export function to export data from the open job to one of the supported
file formats. For most formats (Survey, JOB, TXT, CSV, CR5 and DXF), you may select
the portion of the current job you wish to export. For export to XML, Survey Pro 4.x
(Job/RAW) or JobXML format, the entire job database will always be exported.

Survey Pro can generate a report of your survey based on the content of the currently
open job and formatted according to the template you chose at the beginning of the
process.

About 20 templates are available (see list below) and most of them are customizable.
e Complete Survey Report, in html| format

e Report in fbk format

e Report in kof format

e GNSS Points report in csv format

e |evelLoopReport_doubleSpaced

e Google Earth report in kml format

e LisCAD report in fld format

e Report in Nikon RAW format

e Optical observation report in htm format

e Two different points reports in csv format

e Nine different stakeout reports in csv or htm format



To generate, view, and save a survey report for the open job, follow the instructions
below:

e Go to the Main Menu and tap Job, then View Report.

e Select the desired template, then tap Next.

e Whenever prompted, customize the report, then tap @ to let Survey Pro generate
and then view the report.

e Depending on the chosen template, do the following to access the screen from
which you will be able to save the report:

— For html reports, tap Q , @ then '_3 . You then get the screen below.

— For Google Earth reports, in absence of an application capable of viewing the
generated report, Survey Pro will take you directly to the screen below.

— For all other types of reports, tap € to access the screen below.

View Report ? m 20

Tap [View Report] to open the report in the
viewer,

View Report

Tap [Save] to save the report.

Save Report
Another Report >

e Tap Save Report to save the report to the desired folder.
(On the same screen, the View Report button would take you back to the survey
report view, and the Another Report button would allow you to ask for a new report,
based on the same or a different template.)

Sharlng Files survey Pro allows you to share files over the Internet. This requires that you first set
up an Internet connection on your data collector using Windows Mobile's Settings >
Over the Internet Connections > Connections function.

After the Internet connection has been established, go to File > Share and set an e-
mail profile. You can send emails to one or more recipients, with your files attached
el . to your e-mails. If several files are selected to be attached to an e-mail, Survey Pro
will automatically zip the files so there is always one single file attached to the email

E-mail Profile:

Sending e-mails requires that you use an e-mail profile. You can set up your own e-
M mail account (e.g. Gmail) or use one of the default e-mail profiles (SMS, ActiveSync)
set up by Windows Mobile. After you have set up your own e-mail account, it will
- appear as an additional option in the E-mail Profile list.
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Connectlng t0  Sspectra Precision Central is a cloud file storage and synchronization service allowing
H an organization to synchronize files and folders across multiple desktop computers,
Spec"a Precision data collectors running Survey Pro, and mobile devices.

Central Spectra Precision Central automatically keeps files synchronized across devices so
that team members can easily exchange data, and everyone is always using the latest
up to date copy of any data file.

To access Spectra Precision Central from Survey Pro, you need to connect your data
collector to the Internet using WiFi, the cellular modem connection, or by plugging it
into Windows Mobile Device Center (ActiveSync).
To connect a data collector to Spectra Precision Central:
e Tap the icon in the command bar to open up the Central screen
e Type in your user name (Username), your company'’s organization name
(Organization), and your user password (Password).
¢ Tap Sign in. =
When you are connected, the Central icon will change to "99‘]
* Once you are signed in to Central, the Central screen shows your sign-in status, as
well as any current file sync activities going on in the background.
You can then go to Job > Settings and select the Central tab to configure your file
synchronization connection usage preferences:
— Automatic - All: Files will get synchronized any time there is a data connection.
This is for users who want the file synchronization to be continuous and don't
care about mobile data bandwidth usage.

— Automatic - WiFi: Files will get synchronized any time there is a data connection
< Compese ) that is not cellular, for example, if you are using WiFi, or any time you plug into

Automatic — All

Synchronize when connected to: |
Synchronization occurs automatically whenever h

a data connection exists, including cellular.
SYN " Automatic - WiFi

Windows Mobile Device Center (ActiveSync). This is for users who want
automatic file synchronization any time, except when their data connection is
Synchronization occurs automatically whenever ”
a WiFi data connection exists.

WiH

using mobile data bandwidth.

Fosiru R | — Manual: Synchronization takes place only when the Sync Now button on the
tapped and any data connection is available. | .
e central screen is tapped.

Whenever the Cloud button () is shown on the screen, for example when you want
to import files, you can tap on this button and select Central.

By doing this, you will be allowed to browse through the different folders on the cloud
(and not only the subfolder specific to your data collector) so you can download a new
file posted elsewhere in the cloud by your team.

After you will have saved this file to your data collector, the sync mechanism will in
the background create a copy of this file to your specific data collector subfolder on
the cloud.
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4. Choosing a Surveying Mode - Connecting Survey Pro to an

Instrument

Instrument lcon and
Options List

v Manual Mode

Manage Instruments...

v DOptical
Switch to GNSS
Switch to Leveling

Before you start taking new measurements with Survey Pro, you must configure
and activate your instrument. You can activate an optical total station, a GNSS
receiver, a digital automatic level, or you can specify to use manual input for
three-wire leveling.

NOTE: Selecting an instrument only makes sense when Survey Pro is running on a data
collector. If it's running in the instrument you are using (e.g. FOCUS 30), only this
instrument can be used in Survey Pro.

Before you make this choice, power on the instrument. This will allow the data
collector to detect it and establish a radio, Bluetooth or serial connection with
it when asked to do so. Three-wire leveling using manual input does not require
Survey Pro to be connected to an instrument.

With GNSS equipment, you may simply use a rover receiver, or both a base
receiver and a rover receiver. In the latter case, it's good practice to start your
survey having both receivers running side by side. This way, you can complete
the setup of both receivers and ensure they are communicating on the data
link, and you are getting a fixed position at the rover.

When using a serial connection to start a base and rover, the data collector
must be connected to the base receiver first. Once the base is set, disconnect
the cable from the base and connect it to the desired rover.

e Run Survey Pro.
e QOpen or create a job.

e Tap on the Instrument icon in the command bar.

(This icon may look like any of the following: , or ).
This opens a list of options (see screen example).

e Manage Instruments provides access to various functions allowing you to
declare a new instrument and make advanced settings for each instrument.

e The available options below the Manage Instruments button are for selecting
the desired operating mode for Survey Pro:

— Optical for optical instrument (the selected one in the example)
— GNSS for GNSS receiver used in RTK or/and post-processing

— Leveling allows Survey Pro to use the most accurate techniques for
measuring elevations. Leveling can be done using an optical total
station, a digital automatic level, or a manual automatic level.
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NOTE: In surveying, the term "automatic level" refers to a level that can be
accurately plumbed without having to be accurately leveled.

All levels built in the last 40 years or so have been automatic levels. They are
automatic because the prism through which the light rays pass is suspended by a
pendulum. Therefore, as long as the instrument is close to level (which can be
achieved + 60" using a bubble level), the pendulum mechanism ensures that the
light rays are always passing through perpendicular to actual gravity, and they are
very accurate.

This means that a digital instrument such as the Trimble Zeiss Dini level is called a
digital automatic level, and a non-digital instrument, such as the Nikon ALZs, is also
an automatic level.

In the section above the Manage Instruments button is a list of all
instruments that have been added to Survey Pro for the currently selected
mode. The current active instrument is indicated with a check mark. An
additional option is available (“Manual Mode” for optical and leveling;
“Demo Mode” for GNSS) allowing you to use Survey Pro standalone.

In optical, you choose “Manual Mode” to manually enter horizontal angle,
vertical angle, and slope distance any time Survey Pro is triggered to take
an observation. This is useful for training and learning the software, and it
can also be used to enter survey measurement data into a job from written
field notes.

In GNSS, you can choose “Demo Mode” for demonstration and training
purposes only. The “Demo Mode” has no use for handling actual survey
measurements.

In leveling, you must choose “Manual Mode” if you wish to do single-wire
or three-wire leveling from rod readings.

The "Manual Mode” and “Demo Mode” profiles cannot be deleted or
renamed.

In summary, tapping the Instrument icon allows you to:

Select Optical, GNSS or Leveling mode

Quickly activate an instrument for use in the selected operating mode
Quickly access the Instrument Settings screen

Add a new instrument supported in the selected operating mode.



Optical Mode - -
Connecting Survey °
Pro to an Optical

Instrument

Tap the Instrument icon and select Switch to Optical

Tap the Instrument icon and select Manage Instruments. This opens the
Settings screen listing all the current instrument profiles.

e Tap the Add Instrument button and define the new instrument: Choose its
brand and model, and then name it.

Depending on the model you select, additional settings may be required

Er : =% %0
< Instrument |[Instrument (][ Tnstrument >

i @ Instrument Profiles

(connection, radio, etc.) and status is also provided (port, connection, level
bubble, etc.). An Instrument Settings button is also available giving access
to advanced settings (collimation, EDM, lights, etc.).

| e Tap @ to create the new instrument and close the Instrument Setup screen.
Manual Made (& The new instrument is automatically selected in the list (the instrument

# Add Instrument...

name is highlighted in the list).

e Tap @ to close the Settings screen.

Geolock... || Import... || Export... |

The Settings screen for optical instruments includes the following buttons:

¢ Instrument Settings: Gives quick access to the settings of the instrument
selected in the list. The type and number of settings depend on the brand
and model of the instrument selected. All instruments have a Precision tab
through which you can read the expected precision values of the instrument
(angles, distances, PPM). These values are used in the resection routine
(see page 42) to weight the observations used in the computation process.

e GeoLock: Allows you to enable or disable GeolLock, a GPS-assisted target
search function usable with some robotic instruments only.

e Export and Import: These buttons allow you to respectively save or load
instrument profiles. Survey Pro saves instrument profiles as SPI files.

Importing an SPI file is a quick way of adding a preset instrument in Survey
Pro.
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Remote Control Screen

If you are using a robotic total station, use the Survey > Remote Control function
to control the total station from the data collector running Survey Pro.

In addition to providing the same level of control as Survey Pro’s onboard
version, the Remote Control screen constantly provides information about:

e The charge status of the battery used in the total station
e The operating status of the total station (IDLE/ MEASURING/Locked)

e The quality of the radio link between the robotic total station and the data
collector.

The following buttons are also available from this screen to control the
instrument:

. @\ : Launches a GPS-assisted search for the prism (GeoLock)

. q : Launches a search for the prism starting at the current instrument
direction

. @ : Enables or disables the lock-and-go feature (LockNGo)

. @ : Stops the current turn or search operation

o E> : Opens up the “Turn To” screen where you can select a point or angles
to turn the instrument to.

The following icons are made available next to the title bar:

Item ‘ Function

Visible laser pointer off. Tapping on this icon will turn the laser pointer on.

*_ Note: Standard safety precautions should be taken to ensure that persons do not look
directly into the beam.

Visible laser pointer on. Shown to indicate the visible laser is currently active. In the com-
mand bar, the instrument icon will then look like this:

Tapping #= wil tun the laser pointer off.
Note: Standard safety precautions should be taken to ensure that persons do not look
directly into the beam.

Provides access to the Instrument settings screen.

Shows or hides the on-screen keyboard.

Lol ke

Provides access to Geolock activation, status and reset.




GNSS Mode - Introduction to Receiver Profiles

cOnnecting 3urvey Survey Pro connects to a GNSS receiver through a receiver profile, which is a
convenient way of connecting to and configuring a GNSS receiver in one click,
Pro to a GNSS using information previously saved as a receiver profile.

Receiver Receiver profiles allow you to use GNSS receivers for either RTK data
collection, post-processing data collection, or both simultaneously.

There are two ways of adding a receiver profile into Survey Pro:

e Using Spectra Auto-Configure. This procedure can only be used with Spectra
Precision receivers. Survey Pro uses Bluetooth to detect all the nearby
Spectra Precision receivers. For each detected receiver, Survey Pro will
offer to create a base, rover, and network rover profile using the default
settings for that receiver type. You can then choose the receiver profiles you
would like to create for the newly detected receivers.

If the receiver has also RTX capability, be aware Survey Pro does not
automatically create an RTX profile for a receiver. If you want to use the
receiver in RTX mode, you can modify an existing profile, or add a new RTX
profile to operate the receiver in this mode.

e Using Manual Configuration. This procedure allows you to connect to a single
receiver either through a serial connection or over Bluetooth. This
procedure is suitable for any of the supported manufacturers and models
of GNSS receivers. Once the connection with the receiver is established,
you have to define your receiver profile by yourself (see Modifying a
Receiver Profile on page 31 for more information). In the last step, you will
name the receiver profile and save it.

Example of Receiver Profiles List ~ Later, when you start a survey, just select the desired receiver profile —and a
[settings KRB XX network profile if you are working in a a network; see also Managing Network
[< Post Proc... | Receiver Profile"][ Neworks> |  Profiles on page 33— before you ask Survey Pro to connect to the receiver you
© Receiver Profiles are using. Survey pro will configure the receiver hardware according to the

y—— B settings defined in the selected receiver profile.
R P 100 Base % % When you are using Bluetooth to communicate with receivers, you will typically
T % have a different profile for each receiver, since the Bluetooth address is part
- : —— of the profile. However, you can change the receiver a profile connects to by
+ Add Receiver Profile... .
changing the Bluetooth address.
| Import... H Export...

You may have two or more different profiles for the same receiver. For example,
if you use receiver “x” as a rover with a radio base on some days, and as a
network rover with an NTRIP server on other days, then you would have two
different profiles for this same receiver.

Receiver profiles can be imported or exported as SPR files allowing you to
deploy consistent receiver profiles across your surveying crews.

Receiver profiles can be modified, renamed or deleted.
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Example of Detected Receivers

Add Receiver Profile ?HE D

Select Receivers:

[VIEPOCH 50,5111813382
[C1PF_208012
[JPF_852004
[VIPM_201008

Select All || Rescan ” Select None |

Next >

Example of Selected Standard
Receiver Profiles

Add Receiver Profile ? E 0

Select Receiver Profiles:

[CI&PES0 3382 Net

T ES0 3382 Rover
1R E50 3382 Base
1< PM800 1008 Net

] PM800 1008 Rover
R PM800 1008 Base

Select All

Select None

Example of Serial Connection

Spectra Auto-Confi:
Manual C
Brand:[Spectra Precision[*] Model: [ProMark 800 [7]

Connect with: [SEINeE]] [ E
Baud: 19200 4

Parity: [lone ]

Port: |COM 1 )

Adding Receiver Profiles

Tap the Instrument icon and select Switch to GNSS.

Tap the Instrument icon and select Manage Instruments. This opens the
Settings screen listing the currently existing GNSS receiver profiles.

Tap Add Receiver Profile, then use of the two procedures described below.

Adding Receiver Profiles Using Spectra Auto-Configure:

Tap on the Start button in the Spectra Auto-Configure pane. Survey Pro then
scans automatically for new Spectra Precision GNSS receivers within
Bluetooth range. After a while, the screen lists the names of all the
detected receivers.

Select each of the receiver for which you would like to add a receiver
profile.

Tap Next. Survey Pro will in sequence connect to each of the selected
receivers and will then return a list of standard receiver profiles, each of
them corresponding to a possible usable profile for that receiver.

Check each of the receiver profiles you would like to add.

Tap Finish. Survey Pro comes back to the Receiver Profiles screen on which
you can now see the added profile(s). Receiver profiles may be imported or
exported at this point (see Managing Your Receiver Profiles on page 29 for
more information).

Tap @ to return to the Home screen.

Adding a Receiver Profile Using Manual Configuration:

In the Manual Configuration pane, do the following:

— Select the brand of your GNSS receiver

— Select the model of your GNSS receiver

— Select the type of connection to the receiver.
1) If it's a Bluetooth connection, select Bluetooth and then tap the
Bluetooth Settings button. This button opens up the Bluetooth Instruments
screen, from which you can scan for Bluetooth devices supporting a
serial port service (or open up the Windows OS Bluetooth application).
Tap Start Scan and let the utility search for all the devices. When the
search is complete, select the device corresponding to your GNSS
receiver. Then tap Add Selected, change the Bluetooth name if you wish,
set the Bluetooth PIN if required,and tap @.
Tap €3 to return to the initial screen. The name of the chosen Bluetooth
device now appears in the Bluetooth Device field.



NOTE: The Bluetooth Device field lists the names of the previously detected
Bluetooth devices. Use this field when the receiver you want to connect to was
detected beforehand, is still running nearby, or you know its Bluetooth name and
this name is still listed in the drop-down menu. Only in that case can you
directly select the Bluetooth name from that list and quickly establish a
connection with the receiver.

2) If it's a serial connection, check Serial and select the port used on the
data collector side for this connection.

¢ Tap Connect. You can now define a receiver profile for use in the connected
receiver. Complete the four tabs (Survey, Modem, General, Reset). See
Modifying a Receiver Profile on page 31 for more information on receiver
profiles.

o Tap @ to save the new receiver profile. This profile is now available from
the list of receiver profiles. Receiver profiles may be imported or exported
at this point (see Managing Your Receiver Profiles on page 29 for more
information).

e Tap again @ to return to the Home screen.

Managing Your Receiver Profiles
Do the following to access the list of existing receiver profiles in Survey Pro:
e Tap the Instrument icon and select Switch to GNSS.

e Tap the Instrument icon and select Manage Instruments. Survey Pro lists the
receiver profiles as detailed below.

P E OO
Recsiver Profle -] Networke> |

& Receiver Profiles [ Eﬂ

E50 3382 Rover

R PM800 1008 Rover
? Demo Mode )

Rename... 7
+ Add Receiver Profile... [7]

Delete

| Impormr[Expoft...

(5] (6]

e [1]: Receiver profile name. By default, the name includes the receiver
model first, followed by its serial number (last four characters), then its
survey function.
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[21: Survey function icon: This may be one of the four icons below (see also
Modifying a Receiver Profile on page 31).

Icon ‘ Meaning

Ctl) Rover.
ﬁ Base.

&? Network Rover.
gﬁ Network base.
Qilj RTX (prompted only if the receiver has RTX capability).

[3]: Connection icon: This may be one of the two icons below.

Shown when respectively a Bluetooth or cable connection has
been set between Survey Pro and the receiver.
If the Bluetooth icon is shown, tapping this icon will provide the

or receiver brand and model as well as the receiver Bluetooth name.
If the Serial icon is shown, tapping this icon will provide the
receiver brand and model as well as the serial line settings.

[4]: Settings icon: |§| Provides access to the receiver profile’s Survey,
Modem, General and Reset tabs. See Modifying a Receiver Profile on
page 31 for more information.

[5]: Import. Tap on this button to import a receiver profile, then:

— Select the SPR file you want to import.

— Tap @ . Survey Pro returns the name of the receiver profile contained in
the file.

— Select the profile name to continue.

— Tap Import to complete the import sequence.

[61: Export. Tap on this button to export a receiver profile, then:
— Select the receiver profile you want to export.
— Tap Export.

— Name the file, then tap @ to export the profile and save it as an SPR
file in the chosen folder.



Example of Receiver Information

Receiver Information ?HE T

Firmware:

Nav Process ver.:
Boot ROM ver.:
Sig Process ver.:

Name: ES50 3382 Rover

Model: Spectra Precision EPOCH 50
Capabilities: ? K R

S/N: 5111813382

1.0.0

00422
00422
00422

E50 3382 Rover ? 00
< Reset Survey 7|[ Modem >

Epoch 50’s Survey tab

7 Setup Type:
Elevation Mask:

Corrections:

[] Use Station Index:

Set to OFF mode

Base
Network Rover
Network Base

[71: This menu is displayed after you tap and hold a receiver profile in the
list. From this menu you can do the following:

— Receiver Info: Use this function to view more information on the receiver
connected to Survey Pro through this profile (see example). The possible
capabilities of a receiver (shown as icons) are identified below.

Icon | Capability

? The receiver has rover capability.

K The receiver has base capability.

2 The receiver has data collection capability (for post processing).

— Rename: Used to rename the selected receiver profile.
— Delete: Used to delete the selected receiver profile. Then tap Yes to
confirm that you really want to delete the profile.

Modifying a Receiver Profile

Tap on the corresponding @ button in the receiver profiles list to make
changes to a receiver profile. The receiver profile is described on four different
tabs, the content of which is receiver-dependent.

IMPORTANT! All changes you make to a receiver profile will be effective only if a
receiver is connected to Survey Pro through this profile. In addition, the changes made
to a receiver profile will not be effective immediately in the connected receiver, but only
next time you start a survey using the modified receiver profile to connect to and
configure the receiver.

The Survey tab is primarily used to define the following RTK survey
parameters:

— Setup Type: Used to assign one of the four functions to the receiver:
1) Rover: Corrections received via radio.
2) Base: Corrections broadcast via radio.
3) Network Rover: Corrections received via modem.
4) Network Base: Corrections sent to an IP address.
5) RTX: RTX corrections received via modem (IP) or L band.

— Elevation Mask: Limits the use of satellites to those that are high enough

in the sky, seen from the receiver antenna. All satellites located under
this zenith angle will be rejected (default: 10°).

— Corrections: Used to set the format of corrections received (rover) or

broadcast (base). This setting is not used for rover receivers that support
automatic detection of correction format.
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Epoch 50’s Modem tab

E50 3382 Rover ? 00
< Survey Modem ] Iml
‘) Data Modem: |Internal PacCrestADL @

. Generic Serial
’—Serlal Port: Internal PacCrest ADL

Baudrate:  3%pacCrest ADL
Parity: N{PacCrest PDL
Serial Port:  C(Cell phone

[Radio Settings:

Channel: 2 -
Sensitivity: Low
SP80’s Modem tab

SP80 0013 Rover [? ©[9]
< Survey |Modem [ General> ]

@ Data Modem:

Internal Wi-Fi
ICurrent Internet
Internal GPRS Modem

Enable Wi-Fi
7 Livebox-093c
|| [a DaVinci WPA/WPA2

u! Livebox-d83e  WPA/WPA2-PSK
w/lorange Open

Il | Refresh | [ Add... |

ProMark 800’s General tab

PM800 1008 Rover @0
< Modem Reset >

Storage Location: Internal Memory ¥
NMEA Outputs: off v
Confidence Level:
Specify Base Receiver ‘[t N 7|

SP80’s Anti-Theft tab

SP80 0044 Net
[ <Aers | CETTI ) sockup k> |
f Change Password... |
| Anti-Theft:

I | Enable | | Test

[] Prompt to enable Anti-Theft

Startup Protection:

N H

— Use Station Index: Used to assign a station ID to a base, or identify the
base a rover is expected to use.

— Set to Off mode: Sets the receiver idle, i.e. no more corrections are sent
out if the receiver is a base —or network base- or the receiver stops
listening for corrections if it's a rover or network rover. There is an
exception with ProMark receivers, which in all cases will keep on
operating as rovers.

The Modem tab allows you to configure the RTK data link.

— |f Setup Type = Rover or Base, allows you to enter the UHF radio settings
(i.e. baud rate, frequency channel and sensitivity for most radio
models).

— |f Setup Type = Network Rover, Network Base, or RTX, allows you to set the
cell modem used, either the one internal to the data collector (Current
Internet or Windows Networking option), the one internal to the receiver
(Internal GPRS Modem option), or an external cell phone (IP Modem
option).

Setting a cell modem mainly implies entering the service provider
information (APN) and your connection profile (username & password).

The General tab allows you to configure settings that are specific to the
brand and model of this receiver profile. For more information on brand-
and model-specific settings, see the online help.

The Reset tab provides additional control over the connected receiver. Three

buttons may be available:

— Set Rx. to OFF mode: Same as Set to Off mode above.

— Soft Reset: Will reboot the receiver with its current settings.

— Hard Reset: Will reboot the receiver with its default settings (depends on
the model of receiver used).

For some Spectra Precision GNSS receivers, more tabs are available: When

made visible, the Anti-Theft and Alerts tab can be used to protect a remote

base receiver from theft and/or to authorize only certified users to operate

the receiver at power up.



Example of Network Profile

Network Settings P EOQ
Name: MyNetRoverConnection

&F Setup Type:  [Network Rover

Server Type:

O]

| Direct IP

d

Address: [10.11.12.13

| Port: [2101

User Name:
Password:

Corrections:

SP3910

kKRR KK

ATOM

Managing Network Profiles

Network profiles are managed the same way as receiver profiles. Network
profiles are required:

To specify the source of RTK corrections a GNSS receiver acquires when it
is set as a network rover.

To specify the destination of the RTK corrections a GNSS receiver will
generate when it is set as a network base.

To add a new network profile:

Tap the Instrument icon and select Switch to GNSS.

Tap the Instrument icon and select Manage Instruments. This opens the
Settings screen listing the currently existing GNSS receiver profiles.

Tap on the Networks tab

Tap Add Network. Enter your network parameters (see below), then tap @ .

A network profile is defined by the following parameters:

Name: Enter a name for your network profile.

Setup Type: Tell whether the network profile is to be used by a base (choose

Network Base) or a rover (choose Network Rover).

Server Type: Depending on the selected Setup Type, define the type of IP

connection used:

For a network rover:

— Automatic: Make this choice if you want Survey Pro to determine the type
of connection and server from which the rover will acquire corrections
(recommended).

— NTRIP: Make this choice if you want your rover to acquire corrections
from an NTRIP server.

— Direct IP: Make this choice if you want your rover to connect directly to
a Direct IP single base server or to a static IP base.

For a network base:

— Direct Connect: Make this choice for your base if you want the rover to
connect directly to that base over the Internet.

— TCP/IP Forwarding: Make this choice if you want the base to forward its
corrections to a TCP/IP server.

— NTRIP Forwarding: Make this choice if you want the base to forward its
corrections to an NTRIP server.

Address: I[P address of the server that the receiver connects to for sending
or acquiring corrections. With Direct Connect chosen for a network base, the
IP address is assigned dynamically by the network provider. That's why in
that case, the Address field reads “Dynamic” and is read-only.

Port: IP port of the server that the receiver connects to for sending or
acquiring corrections.
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+ Add Receiver Profile...

Connect to Receiver P E 0
Select Receiver Profile:
&R SP80 0013 Net Base (B]1E<3
SP80 0013 Net Rover (O] (%]

Network: |MyNetwork ] Manage
My NTRIP Net Networks...
MyNetwork

e User Name and Password: Credentials required to be allowed to access the
server.

e Mount Point: (for a network base in NTRIP Forwarding only) Enter the mount
point where to send corrections to.

* Force NTRIP password (for a network rover in Automatic or NTRIP setup type).
With this option enabled, you will be prompted for user name and password
for every NTRIP mount point, even if the NTRIP table specifies that they
are not required. This option is to deal with poorly formatted NTRIP tables,
where the source table says that password is not required, but the selected
mount point actually requires one.

e Corrections: Whenever required, specify the format of corrections (ATOM,
CMR, RTCM) the receiver should generate (base) or receive (rover).

When later starting a survey, you will be requested to specify the network
profile your receiver will work with. Choose the name of that network profile.

At this point, the Manage Networks button allows you to return to the list of
existing network profiles to make changes if necessary. In the networks list, an
icon placed ahead of each network profile name tells you the type of receiver
the network profile is intended for:

o R Network base profile

o & . Network rover profile

Checking the GNSS Status

Checking the GNSS status of the connected receiver is recommended before
starting a job.This implies that the GNSS receiver is in real conditions of use,
preferably in an open sky environment.

Use the GNSS Status function on the Survey menu to read this information. The
GNSS status is split into six different tabs:

e Receiver: Provides additional information describing the position solution
computed by the receiver. In RTK, the Reset Ambiguities button allows you
to re-initialize the computation of the position. For more information, see
6. GNSS Surveying on page 53.

e DataLink: Describes how a rover is provided with RTK corrections, or the
type of RTK corrections generated by a base. For more information, see 6.
GNSS Surveying on page 53.

® Post Process: This tab shows the data recording status (Yes/No), the
recording interval (1 or 2 sec), the name of the point on which data
recording takes place (only when static) and the time elapsed since data
recording was started. Additionally, this tab shows the receiver’s battery
and memory statuses (plus remaining, estimated recording time for some
receivers). When there is no data recording in progress, most of these fields
are left empty.



e Sky View: Provides a polar view of the sky showing the location and type of

GNSS Status each satellite being tracked and the total number being used in position
solutions (see example). You may change the value of the elevation mask
Used: 14 on this screen. This will update the value read on the General tab as well
Tracked: 16 (see Managing Your Receiver Profiles on page 29).
i Color code and letter code used for the different constellations:
Color ‘ Gray ‘ Blue ‘ Red ‘Green ‘Yellow‘Magenta‘Cyan
Satellites used in position | Notused | GPS |GLONASS|BeiDou | Galileo | QZSS |SBAS
Sat label (“xx"= Sat PRN) - Gxx Rxx Cxx Exx Jxx Sxx
e SatlInfo: For each visible satellite, provides the satellite identifier (e.g. G8),
[ the current status (Used/not Used) and the L1 signal strength (SNR) as a

< Sky View ||Sat Info [*][Position >
Show Tracked [&

Satellites:

GNSS Status
< SatInfo |[Position ] iver >

Coordinates:
Latitude: 47°17'56.29524" N @ WGSs4|
Longitude: 1°30'32.58150" W O Local LLF
Height: 86.056 m O arid

Solution:SDGPS

Heading:
‘ Speed:

color-coded vertical bar. See table below.

Vertical Bar | L1 Signal Strength Used/Not Used Indicator |  Status

Green Very Good Solid dot Used
Yellow Good Hollow Dot Not Used
Red Poor

The Tracking button allows you to enable or disable each of the
constellations the receiver can track.

Depending on the receiver used, you may be given the ability to reject some
satellites through a context-sensitive menu attached to each vertical bar
(you may want to not use a satellite because the signal received from it is
too weak, or because it is officially declared unhealthy). In this case, a filter
is also available on this screen allowing you to show all the visible satellites
or only those that are currently tracked.

(NOTE: The same satellite labels as on the Sky View above are shown on this
screen.)

e Position: Provides the three coordinates of the position solution currently
computed by the GNSS receiver, the solution status, as well as heading and
speed if the receiver is currently moving. The position may be expressed in
WGS84 (always possible), in a local coordinate system (if selected and
solved) or as grid coordinates (if the grid is selected and solved).

Before going any further in your work, you should check that at least 6
satellites are received and used, each satellite providing a good signal level,
and the receiver delivers a 3D position solution.

During your survey, should your GNSS receiver raise some alerts (loss of RTK
position status, low memory or low battery), Survey Pro will automatically
forward them to you in the form of message boxes. This is to make sure you
get this information in a timely manner as some GNSS receivers may not be
able to warn you directly.
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Leveling Mode -
Getting Ready for
Leveling

Leveling can be performed using one of two techniques:

Automatic leveling: An automatic level is used to take readings on a
graduated level rod. This is the traditional leveling technique for surveying.
It can be performed by manually reading the rod, or by using a digital
automatic level such as the DiNi to electronically read the rod.
Trigonometric leveling: An optical total station is used to measure zenith
angle and slope distance to a prism on a pole. This alternative leveling can
be performed with a total station and a prism on a fixed height pole.

Depending on the technique you wish to use, you must configure your
instrument and possibly select a leveling method.

Auto/Manual Leveling Methods

Survey Pro supports the following leveling methods:

Three Wire: An automatic level is used and the operator observes the
leveling rod at the upper, middle, and lower wire of the level stadia. This
method is used with the “Manual Mode” instrument profile.

Single Wire: Same as three-wire leveling, except that only the middle wire
is read and entered using the “Manual Mode” instrument profile.

Electronic: An electronic automatic level is used to digitally observe a bar-
coded level rod. This method is used with one of the supported electronic
level instrument profiles.

Trigonometric: An optical total station is used to observe a prism on a prism
pole to measure vertical distance. This method is used with any electronic
total station instrument profile. It can also be used with the “Manual
Mode” instrument profile if you wish to hand enter zenith and slope
distance observations from a field book.

NOTE: Trigonometric leveling (trig leveling) is a different survey technique than
performing a 3D optical survey with a total station.

In trig leveling, you do not set up the optical total station on a known point, and you
do not measure the height of the instrument or the height of the rod at any time
during the survey.

Trig leveling is more like traditional leveling in that you set up the instrument in
between the points in each turn, you observe the rod at the backsight to establish
the height of the instrument, then you observe the rod at the foresight to establish
the foresight elevation. Because the foresight observation is subtracted from the
backsight observation, the height of the rod, which must be kept constant between
the backsight and foresight of each turn, cancels out. Therefore, in trig leveling, you
never need to enter the height of the rod. The height of the instrument above the
ground at each location is also not used in this procedure.




Level Method ? 0@

Manual Entry Mode Leveling Method:

() Three wire
() single Wire
() Electronic

@ (Triconometric]

i

7208
< Level Level A Level >

Sequence: @ BSL...BSn>F51..FSn
O

[BS1 FS1=FS2 BS2]n

nurmber of Sets (h):

Stadia Constant: 100

W, Distance Taolerance;
H. Distance Tolerance:

Tolerance for Errar Checking:

[ ]

Kl

Choosing Leveling Mode

1.

2.

If your active instrument is an electronic automatic level, then Survey Pro
will automatically use Electronic leveling method.

If your active instrument is an optical total station, then Survey Pro will
automatically use the Trigonometric leveling method. Creating and
activating either an electronic level instrument profile or an optical total
station profile is the same procedure used to create an instrument profile
in optical surveying mode (see Optical Mode - Connecting Survey Pro to an
Optical Instrument on page 25).

. If your active instrument is the “Manual Mode” profile, then you must

choose your leveling method:
e Tap the Instrument icon and select Switch to Leveling.

e Tap the Instrument icon again and select Manage Instruments. This opens
the Settings screen.

e Select Manual Mode and then tap Instrument Settings. This opens the Level
Method screen.

e Select the desired leveling method among the four possible,

e Tap @ tovalidate your choice. As a result, you can see that Manual Mode
in the list of instruments has now been activated automatically.

e Tap @ to close the Settings screen. Survey Pro is now ready to perform
manual leveling.

Level Settings

Now that you have selected the Leveling mode, go back to the main menu
and select Job > Settings. This opens the Settings screen

Select Level from the upper tab. This screen allows you to set the shooting
sequence (BS1...BSn>FS1...FSn or [BS1 FS1>FS2BS2]n), the number of sets (n)
and a few leveling tolerances (vertical distance, horizontal distance, etc.)
Survey Pro will be using in Leveling mode.

The Load FGCS Defaults button allows you to specify a particular order and
class for the level loop. This will automatically fill in all the tolerances on
the Settings screen with the default FGCS values.

Setting tolerances allows Survey Pro to issue warning messages when
tolerances are not met. It's up to you to determine if the level loop meets
the criteria for a particular standard.

Tap @ to enter all your settings and close the Settings screen.

Go to the main menu and select Survey to start your leveling work. Refer to
Section 7. Leveling on page 72 for more information.
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5. Optical Surveying
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Instrument Setup

What you have done already:
* You have set up the optical instrument on a tripod over a point of your
choice and measured the instrument height.

* You have selected Optical from the instrument icon located on the Home
screen or Main Menu.

e You have activated the instrument for use with Survey Pro. See Optical
Mode - Connecting Survey Pro to an Optical Instrument on page 25.
¢ You have configured the proper settings in the Job > Settings > Surveying tab.
This tab allows you to configure:
— Earth Curvature & Refraction correction: To adjust measured zenith angles
for the effects of earth curvature and refraction.

— PPM: To adjust the measured slope distances for the atmospheric effects
on the EDM.

— Survey with True Azimuths: Automatically sets the Circle on the
instrument to match the BS Azimuth that is set when pointed at the
backsight.

What you should do now: You have to position and orient the total station in
your local coordinate system before you start measuring points. This can be
done using one of the methods below, by choosing whichever is most
appropriate:

e Known Point: Station setup on a point with known coordinates.

¢ Unknown Point /Resection: Station setup on an unknown point using the
resection method to determine the position of the point.

e Multiple Backsights: Station setup on a known point using several backsight
points to determine the orientation.

e Use Last Setup: This method is made available only after a station has been
set up in the current job. Use it only if you are certain the tripod is still
exactly at the same location as when the last setup was performed, and the
same BS and Circle are being used.

The first three methods are described below. The point or points used should
have previously been stored in or imported into the job.

Station Setup on a Known Point

The name and coordinates of the known point where the station is set up can
be picked from within the open job. This method offers three different
scenarios:

e BS Azimuth [1]: Backsight azimuth. The station location will be set from the

coordinates of the known point. The backsight azimuth will be the value you
enter in the BS Azimuth field.



Typically, this is an “assumed” backsight and the value will be O or North.
The backsight circle orientation will be set to 0°00’00” automatically.

e BS Point [2]: Backsight point. The station location will be set from the
coordinates of the known point. The backsight circle orientation will also
be set to 0°00’00" in that case.

e New Point [3]: This is a variant of backsight azimuth in which the azimuth
is given to a new point you would like to measure and add to the job.

The diagram below illustrates the three possible scenarios.

[1] JK (2] (3]
Known Azimuth Direction Known Backsight Point New Backsight Point
El el
4[\ /N
Known Station Point Known Station Point Known Station Point

NOTE 1: A variant to this procedure exists (whatever the scenario used) if the Survey with
True Azimuths setting is enabled (see Job > Settings > Surveying tab). In this case, the
backsight circle will always be set automatically to the true azimuth, either the entered
one (BS Azimuth then renamed “True Azimuth” scenario and New Point scenario) or the
calculated one (BS Point scenario).

NOTE 2: Whatever the method used, you can refine the station setup by making more
measurements. This is done by activating the Perform Backsight Repetition Set check box
allowing you to perform.direct and reverse measurements. Before you tap on the Finish
button to end the station setup, you can use the Backsight Sets button to perform
additional measurements.

The three scenarios are detailed below with the Survey with True Azimuths option

disabled.
Start the station setup as follows:
¢ Go to the Main Menu, then tap Survey > Station Setup.
Setup Type: * Choose Setup Type= Known Point.

~+ Occupy Point: IZ‘ .

720 Survey lgnre Eevations) Enter the name of the station setup point in the Occupy Point field. The

Information: point name can be entered directly, picked from the map or point list.

. HI: -2,000m R

B gon These options can be selected from the & button attached to the Occupy
el — Point field. In MAX+ configuration (GNSS + Robotics), the point may have

been collected using a GNSS receiver just before setting the base.

e |f you wish to ignore elevations in your job, check the 2D Survey box. You
will otherwise enter the height of instrument in the HI field.

e Tap Next.

No current Setup!
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Station Setup
[ BS Azimuth:_ ] [0,0000 II=]

Please make sure you are pointed at the
backsight with instrument in direct face.

[] Perform Backsight Repetition Set

|
[(Bspont.__ ] [E =]

BS Azimuth: -

Roving Target w HR‘ @

Please make sure you are pointed at the backsight
with instrument in direct face.

[] Perform Backsight Repetition Set

Measure & Set>
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Then, of the three possible options, choose the one that is suitable for your job:
If you choose BS Azimuth:

1.

Aim the instrument in the direction of a known or assumed azimuth.
Enter the known or assumed value of azimuth in the BS Azimuth field.

Tap Set Backsight. The screen provides a summary of what you have just
done and prompts you to check the setup.

NOTE: If the equipment used is unable to set the backsight circle, the button is
labeled “Read Backsight” instead of “Set Backsight”.

Check the Setup:

a. If you choose the By Angle option, just make sure the instrument is
still aimed in the direction of known azimuth, then tap Check. You
should read the previously set backsight circle.

b. If you choose the By Point option, enter the name of the point used
for checking, specify the target used on that point, correct the target
height if necessary and tap Check. A measurement is then made. Check
the delta values reported on the screen, which should be as close as
possible to zero.

¢. You cannot use the By Distance option in this case.

If you are satisfied with the read values, tap Finish. You can now start
measuring new points.

. If you choose BS Point:

Enter the name of the backsight point. It can also be picked from the
map or the list of points. The resulting backsight azimuth is then
calculated and displayed just underneath the BS Point field.

Specify the type of target used at the backsight point (Fixed Target or
Roving Target).

A “roving target” is when you measure to the backsight with the same
rod and prism you will be using for your subsequent data collection.
A “fixed target” is when you have a tripod and prism that will remain at
the backsight and that will be different from the rod and prism you will
be using for subsequent data collection. See also Managing Smart
Targets on page 106 for more information on the Survey Pro target
database and the fixed backsight target.

Using [7], select the name of this target. As a result, the HR (height of
rod) field is updated to provide the height of this target.

Aim the instrument at the known backsight point.

Two actions are then possible:

1) Tap Set. The screen provides a summary of what you have just done
and prompts you to check the setup. Note that the backsight circle has
been set to 0°00'00".



Station Setup
|
[» Bs Azimuth: | [5,555556 = |

Roving Target wr| HR (200N |z|

Please make sure you are pointed at the new
backsight point with instrument in direct face.

Perform Backsight Repetition Set ‘

e

NOTE: If the equipment used is unable to set the backsight circle, the button is
labeled “Read Backsight” instead of “Set Backsight”.

As previously explained for BS Azimuth, you can in the same way check
the setup either By Angle or By Point (see Check the Setup above).

You can also use the By Distance option. Just make sure the instrument
is still aimed in the direction of the backsight point and tap Check. The
measured horizontal and vertical distance errors are reported on the
screen. They should be as close a possible to zero.

or 2) Tap Measure & Set: This option sets the backsight circle to
0°00’00” and also takes a measurement to the point, with the
measurement results displayed in the next screen.

Whether you used the first or second option, if you are satisfied with the
read values, tap Finish. You can now start measuring new points.

. If you choose New Point:

Place a target at the unknown (new) backsight point.

Aim the instrument at this point.

Enter the known or an assumed value of azimuth along this direction.
Specify the type of target used at the backsight point (Fixed Target or
Roving Target).

Using [7], select the name of this target. As a result, the HR field is
updated to provide the height of this target. Update the height value if
necessary.

Tap Measure & Set to measure the new point and set the backsight.

NOTE: If the equipment used is unable to set the backsight circle, the button is
labeled “Measure & Read” instead of “Measure & Set”.

Enter a name and description for the new backsight point.

Tap @ to store the point.

Review the summary of the station setup, as shown on the screen. If it's
not as expected, tap Back and resume the setup.

If the setup is fine, tap Finish. You can now start measuring new points.
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Station Setup P HE 0

" Store Pt: sTsEwe [

‘ » Description: | H v‘

HL: [12D Survey
Shots per Resect Point:

Sequence: Direct and Reverse v
No current Setup!

Point [H [V [Desc |  choose from map...

PT1 Yes Yes CONTR
PT2 Yes Yes CONTR
PT3 Yes Yes CONTR  QccupyGNSS Point...

Create new point...

Current: RMS N:0.001 RMS

| < Back ‘ I Observe I | Next >

(%]
2 3h
Option: [Distance and Angl E
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Station Setup on Unknown Point, Resection Method
The resection method is illustrated below.

PT2

At least two known points should be observed to solve the station setup (e.g.

PT1, PT2). Other known points (PT3, PT4,..) may be added to refine the

computation.

e Go to the Main Menu, then tap Survey > Station Setup.

e Choose Setup Type= Unknown Point/Resection.

e Use the Store Pt and Description (or Feature) fields to enter respectively the
name and description of the point where the instrument is set up. (This is
a new point, with unknown coordinates.)

e |f you will ignore elevations in your job, check the 2D Survey box. You will
otherwise enter the height of instrument in the HI field.

e You can take one or more shots of each point. Enter the desired number of
shots in the Shots per Resect Point field.

e You may want the instrument to perform either Direct and Reverse
measurements (recommended for station setup) or a Direct Only
measurement. Use the Sequence field to make this choice.

e Tap Next. This opens the Station Setup screen on which you should define
the following parameters:

— Resect Point: Enter the name of the first point used (PT1 for example).
This name can be entered directly, or picked from the map or point list.
These options can be selected from the [=] button attached to the Resect
Point field.

In MAX+ configuration (GNSS + Robotics), you may use the Occupy
GNSS Point option to collect the point on which your GNSS receiver is
standing. Once the point has been logged and named, it can be used as
a resection point.

— Option: Define the type of measurement you will perform on the point
(Distance and Angle or Angle Only).

— Define the type of target used and its height (HR).



Station Setup ? B
Error Estimates: (1-sigma) A
Error N 0.001 m
Error E 0.000 m
Error Elev. 0.000 m ‘
Error Orientation ~ 0°00'01" deg

M

New Setup

Occupy: ST2 HI: 2.300

Backsight: PT1

Azimuth: 225°00'00" Circle: 315°00'00"

<Back | [ Backsight> | [ Finish

Tap Observe then Take Shot to start a measurement. You are then taken back

to the Station Setup screen where the measured point is listed as the first

point involved in the station setup.

Repeat the previous two steps for the next point (PT2 for example), and

then for additional points (PT3, PT4, etc.) for data redundancy.

As you get new points, Survey Pro tries to compute a solution for the station

location.

When a solution is available, the RMS values of the solution are shown in

the lower part of the screen.

You may reject the horizontal or vertical contribution of a point by tapping

on the corresponding “Yes” which will then be changed into a blank field.

Again, you will immediately see the impact of this change on the quality of

the solution.

At this stage (i.e. a solution is now available), you may take measurements

to as many other points as necessary to refine the station location (these

points must all be stored in the job). Survey Pro can guide you (or the

rodman) to each of these points if you don’t know where they are:

— In the Resect Point field, enter the name of the first of these points (or
select it from the map or list as you would usually do).

- Tap

— Use this new screen to find the point. Take several shots and each time,
follow the guidance instructions until the point is found.

— Then tap @ | to return to the previous screen, and tap Observe to add
a measurement to the solution.

— Add other points if necessary using the same procedure.

Also at this stage, if you are using a robotic instrument, you may add a
measurement to another known point of your choice by first asking Survey
Pro to turn the instrument to that point:

— Use the Resect Point field to select the name of the desired point.

- Tap to rotate the instrument in the direction of the point
— Take a measurement to the point
— Add other points if necessary using the same procedure.

When you are satisfied with the results, tap Next. The screen then shows
the properties of the station setup. If you scroll down the list of results, you
will see the components of the final error ellipse for the solved point.

On this screen, Survey Pro defines one of the control points you have just
used in the resection method as a backsight point.

At this stage, you can tap Finish to complete the station setup. The
instrument circle used for this setup will be the direct circle reading on the
first resection point used in the setup, unless you are surveying in true
azimuth mode.
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Station Setup PEOO
Setup Type: Multiple Backsights v

+  Occupy Point:

: N: 96,848
E: 43,972 Choose from map...
Elev: 23,000
Desc: TR Create new point...

! Sequence:

# of Sets: |1
Check Setup...

Show point details...

Zoom to point...

In true azimuth mode, the instrument circle will be adjusted so that your
circle will now read the true azimuth when pointed at the first resection
point used in the setup.

Alternatively, you can tap Backsight to proceed to the normal backsight
setup, with your newly calculated station point as the setup point, and your
last resection point as the backsight point. It is a good practice to do a
backsight check after a resection to ensure the instrument circle is oriented
as you expected.

When this is done, tap Finish. You can now start measuring new points.

Station Setup Using Multiple Backsights

The multiple backsights method is illustrated below.

PT2

\
X PT4

S, where the station is set up, is a known point. At least one known point

should be observed to determine the orientation of the instrument and correct

it accordingly. Other known points (PT3, PT4,..) may be added to refine the

computation of the correction angle.

e Go to the Main Menu, then tap Survey > Station Setup.

e Choose Setup Type= Multiple Backsights.

Use the Occupy Point field to enter the name of the point where the

instrument is set up. (This is a known point, i.e. with known coordinates.)

The point name can be entered directly, picked from the map or point list.

These options can be selected from the [=] button attached to the Occupy

Point field.

e |f you will ignore elevations in your job, check the 2D Survey box. You will
otherwise enter the height of instrument in the HI field.

e You may want the instrument to perform either Direct and Reverse
measurements (recommended for station setup) or a Direct Only
measurement. Use the Sequence field to make this choice.

e You can take one or more shots of each point. Enter the desired number of
shots in the # of Sets field.



+oseon Bl [[+][E]3

Option: [Distance and Angld*|| 2D Target: &El

Point [ Used [Desc [dHD [dHA [N

PT1  Yes Ref 0.000 0°00'38" 80.000
PT2 Yes Ref 0.000 0°00'00" 150.000
PT3  Yes Ref 0.000 0°03'47" 80.000

Ea i > |

F1 Correction: 0°01'29"

‘ < Back | |Observe I | Next > |

Tap Next. This opens the Station Setup screen on which you should define

the following parameters:

— BS Point: Enter the name of the first backsight point used (PT1 for
example).
In MAX+ configuration (GNSS + Robotics), you may use the Occupy
GNSS Point option to collect the point on which your GNSS receiver is
standing. Once the point has been logged and named, it can be used as
a backsight point.

— Option: Define the type of measurement you will perform on the point
(Distance and Angle or Angle Only).

— Define the type of target used, and possibly its height (HR).
Tap Observe then Take Shot to start a measurement. You are then taken back

to the Station Setup screen where the measured point is listed as the first
point involved in the station setup.

Survey Pro indicates the correction angle needed to the instrument

orientation so this instrument can accurately measure the azimuth angle to

this point. This angle is called F1 correction. It is positive for an

anticlockwise correction, negative for a clockwise correction.

You may repeat the previous two steps using additional points (PT2, PT3,

PT4, etc.) for data redundancy.

You may reject the contribution of a point by tapping on the corresponding

“Yes” which will then be changed into a blank field. You will immediately

see the impact of this change on the correction value.

When a solution is available, you may take measurements to as many other

points as necessary to refine the station location (these points must all be

stored in the job). Survey Pro can guide you (or the rodman) to each of these

points if you don’t know where they are:

— Inthe BS Point field, enter the name of the first of these points (or select
it from the map or list as you would usually do).

- Tap

— Use this new screen to find the point. Take several shots and each time,
follow the guidance instructions until the point is found.

— Then tap o , to return to the previous screen, and tap Observe to add
a measurement to the solution.

— Add other points if necessary using the same procedure.
Also at this stage, if you are using a robotic instrument, you may add a

measurement to another known point of your choice by first asking Survey
Pro to turn the instrument to that point:

— Use the BS Point field to select the name of the desired point.

- Tap to rotate the instrument in the direction of the point
— Take a measurement to the point
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— Add other points if necessary using the same procedure.

e To accept the computed correction value, tap Next>. Survey Pro suggests
you use the first point measured as the backsight. If you agree, just tap
Finish to complete the Station Setup.

Variant to the Basic Station Setup Procedures

There is a variant to the basic step-by-step procedures described above,

related to your current job settings (in Job > Settings > Surveying tab):

e PPM Correction: By default, the PPM will not show up in the station setup
routine. But, if you check the box for Prompt for PPM during Station Setup, the
PPM will become the first step in your station setup routine.

The PPM correction is applied to all measured slope distances. This may

be achieved in one of two different ways:

1. You enter the PPM in the instrument which in return will provide Survey
Pro with slope distances corrected for the PPM.

2. Or you enter the PPM in Survey Pro, in which case the instrument will
return uncorrected slope distances (make sure the PPM is set to “0” in
the instrument). Survey Pro will apply the PPM correction to any slope
distances that will be used in further calculations.

NOTE: With some instruments (e.g. FOCUS 30 and S6), the PPM correction can
only be set using the second method.

For any station setup, you can also set the elevation of the station point
independently using the Remote Elevation routine (see Remote Elevation on
page 47).



Remote Elevation 7 O
Elevation: 161.205589 ift E‘
Shoot

He [5.230 0 | HR {7349 it |ﬂ|z|

FS Elevation 161.206 ift -
Horz Dist. 128.000 ift H
Ground Horz Dist. 128,000 ift

Vert Dist. 0,000 ift =
Slope Dist. 128.000 ift

Zenith o0°00'00"  deg [+

Take Shot

s )
How do you wish to fix a station setup?
Rotate to Known Azimuth/Bearing
Rotate coordinates from an assumed backsight
direction 10 a known plan.

Rotate = |

Translate to Known Plan
Translate coordinates from an assumed origin to a
known plan,

‘ Translate > |

Remote Elevation

This routine will set the elevation coordinate of the station from a point with

known elevation. It is accessible from within the first station setup screen by

tapping the Remote Elevation button (provided the 2D Survey box is unchecked).

The known elevation is either that of:

e A point stored in the job. You will select this point from the map or from
the list of points.

e A point not stored in the job, but its elevation is known, perhaps through
past results, by calculation, or printed on a data sheet.

Step-by-step procedure:

e Have a target set up on the point.

e Aim the instrument at the point.

* Go to Station Setup and then tap the Remote Elevation button.
e Enter the elevation according to the suitable method.

e Check the HI value.

e Select the target and check the HR value.

e Tap Take Shot. The results of the shot then appears in the lower part of the
screen.

e Tap @ to return to the Station Setup screen and complete the setup
according to the method you chose.

Fixing Station Setup

You may need to apply corrections to all the measured points sharing the same
station setup. This can be done using the Fix Station Setup function in the Adjust
menu.

Two types of transformation can be done:

e Rotation, based on a known azimuth between two points sharing the same
station setup. You need to specify the value of known azimuth and the two
point names. When applying the change, all the concerned points will be
rotated the same way. The original backsight azimuth will be updated as
well to achieve the desired result (which Adjust > Rotate would not do).

e Translation, based on two points that you specify. The first one is an
observed point that you would like to translate to another location, and the
second one is a key-in point created with the coordinates that you would
like to assign to the first point. When applying the change, all the
concerned points will be translated the same way. The original occupy point
will be moved accordingly to achieve the desired results (which Adjust >
Translate would not do).
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Introduction to Traverse / Sideshot

Tap Survey > Traverse / Sideshot. This screen allows you to make traverse and
sideshot measurements. The current setup is summarized at the top of the
screen.

Enter the name (Foresight) and description (Desc.) or feature (Feat.) of the
point you will now be measuring, as well as the type and height (HR) of the
target used on that point.

The next step is choosing between sideshot or traverse (Sideshot is the
default option for the button; tap on the down-arrow if you want to select
Traverse).

Choosing “Sideshot” means you simply want to take a measurement of the
point. (See Sideshot on page 48.)

Choosing “Traverse” (see illustration below) means you are expected to
move the instrument to that point either immediately or after measuring
other points (sideshot).

m | [2] ]
A —A
b 4ol % P12 i PTI X P12
Instrument Target } Target Instrument
1

This implies a new station setup is required after moving the instrument.
(See Traverse on page 49.)

You may want just to perform a measurement, and not store it as a point.
In this case, use the Measure (or associated Angles Only Measure) button
rather than the Sideshot button.

Sideshot

Be sure the instrument is pointed at the target placed over the point.

Tap Sideshot. Survey Pro returns the results of the measurement in the
lower portion of the screen ([1]). The point name is automatically
incremented for the next measurement. Tapping on the Result tab will
provide more information on the measurement made ([2]).

[‘I] Traverse/Sideshot ?EQOQMQ [2] Traverse/Sideshot EEINEE)
OCC:PT1 HI:2,000 BS:5,0000
5 Point: 1 =
2 " =
oresig [~] é E: 41,920 m
[» Feat.: | [=]Hr[2000m [62[+] 5 Elev.: 23000 m
Angle Right: 45,0000  grad ~RE Angle Right: 45,0000 grad
Zenith: 100,0000 grad " Zenith: 100,0000 grad
Slope Dist: 31,000 m ‘3 Slope Dist: 31,000 m
Elevation: 23,000 m ol 12 Horz Dist: 31,000 m
Point; 1 Vert Dist: 0,000 m
Measure | w|[ Sideshot | ]




Measure new point and traverse to:
2 Foresight: PT3 IZI

| Measure and Traverse Now... |

Or traverse to an existing point:

Point ‘ Description |
1 SS

Point: Point name

N: Point coordinate Y

E: Point coordinate X

Elev.: Point coordinate Z
Description: Point description

Angle Right: Azimuth angle measured from the occupy point to the foresight
point (measured in a horizontal plane)

Zenith: Zenith angle measured from the occupy point to the foresight point

(Zenith is measured in the vertical plane, relative to gravity, where O is
pointing straight up, parallel to gravity, and 90 is pointing straight ahead,
orthogonal to gravity.)

Slope Dist: Slope distance measured from the occupy point to the target
Horz Dist: Horizontal distance calculated from the occupy point to the target
Vert Dist: Vertical distance measured from the occupy point to the target.

Repeat the above two steps until all your points have been measured.

Traverse

Be sure the instrument is pointed at the target placed over the point.

Tap on the down-arrow by the Sideshot button and select Traverse. The
screen prompts you to measure a new point, or to pick a point that was
previously measured from the current station setup (Survey Pro will display
a list of appropriate points), and then move the instrument to that point. If
you create a new point to traverse to, you will then be asked to enter the
description of the point before measuring it.

After the measurement is done or the point selected, Survey Pro provides a
summary of what the new station setup will be (see [1] below).

Move the instrument to the new station point and level it on its tripod.
Measure the new instrument height and enter the measured value (HI).

Aim the instrument in the direction of the point you came from (now the
backsight point).

Enter the type and height (HR) of the target used on the backsight point
(see [1]).
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171 EEEEEED 1 EETDEEEE
[ ] [ ] OCC:3 HI:2,000 BS:PT1, 261,0000, BS HR:2
'| ByDistance w Check
HL: {2,000 m I[ 2 ‘ | | |
New Occupy Point: 3
| New Backsight Point: PT1 | F?xed Target Prisme
New Backsight Circle: 0,0000 Fixed Target HR: 2,000
[ Fred Target | HR[2000m [E3[+] | loccupying Point 3
Backsight Point PT1
[ Perform Backsight Repetition Set Set > 4 9 Description
Measure & Set> [ <Back | [BacksightSets... | [ Finish

The New Backsight Circle will be preset to zero, unless you are surveying with
true azimuths.
In the true azimuth case, the circle will be the azimuth from the new
location occupied by the station back to its previous location, which is now
your backsight point.

e Two actions are then possible:

1) Tap Set and complete the station setup (see [2]). You have the capability
to perform several measurements after activating the Perform Backsight
Repetition Set check box, or by adding new measurements using the
Backsight Sets button just before tapping on the Finish button to end the
station setup.

or 2) Tap Measure & Set: This option sets the backsight circle to 0°00’00”
and also takes a measurement to the point, with the measurement results
displayed in the next screen. Tap Finish to complete the measurement.

NOTE: The Station Setup routine can be used at any point to occupy any existing
point in the job at any time. It is up to you to determine if and when this is
appropriate.

Measure

If you wish to perform just a measurement, and not necessarily store the
measurement results, use the Measure (or Angles Only Measure) button rather
than the Sideshot button. You can however save the results in a text file by
tapping and holding your finger within the results frame on the screen and
selecting Save Results.

After a measurement has been made, you can however change your mind and
store the measurement as a point using the Store button (which then replaces
the Sideshot button).
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Repetition Shots

The Repetition shots function allows you to perform sideshots or traverse shots
using any number (between 1 and 99) of repeated measurements (“Sets”).
e Go to the Survey menu and tap Repetition Shots.

e Tap @' in the command bar to access the job settings relating to repetition
shots (equivalent to navigating to the Job > Settings > Repetition tab).

e Tap the Repetition tab. The Rep Shoot Sequence field allows you to choose the
desired sequence of repetitions (7 available):
— “FS” stands for “Foresight”:
— “BS” stands for “Backsight”
— The ">" symbol is used to denote the next shot coming in the sequence

using the same face of the instrument (direct or reverse).

— The "A" symbol is used to denote when in the sequence you will flip the
instrument to take observations in the opposite face.

The other parameters on this screen are self-explanatory. Set them to meet
your application. The Radial Sideshot Seq field allows you to specify the
sequence of observations to be taken in the Radial Side Shot routine. This
setting is NOT used for either regular repetition shots or multiple side
shots.

e Tap @ to return to the Repetition Shots window.

e Use the Foresight field to enter a name for the point you will measure
through repetition shots.

e Enter the number of Sets you want the sequence to be repeated.

e Select the type and enter the height (HR) of the target used on the foresight
point.

e Start the sequence by tapping either HA, ZA, SD or All, whichever is
appropriate in your case. Depending on the instrument used, run the series
of measurements manually or let the instrument do this automatically.
Results are displayed at the end of the sequence (see illustrated).

— Average of: Shows the average angle or distance to the point from all the
shots taken. The number in parenthesis is the total number of
repetitions performed.

— Worst Residual: Displays the worst residual calculated from all the sets
of the selected measurement type.

You may use one or more of the Toss buttons to remove from the solution
the set of measurements that provided the worst residual. A Toss button can
only be used if three or more sets have been collected.

When you tap HA, ZA, SD or All, Survey Pro will collect an additional
observation of that type (or all of them) and add it to the sets already
collected.
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EXAMPLE: If you had three complete sets, then selected to toss the worst HA, you
would now have two HA sets, three ZA sets and three SD sets. If you tapped HA, you
would collect an additional set of horizontal angles only, and on return to this screen,
you would now have three HA, three ZA, and three SD sets. If you hit HA again, on
return to this screen you would have four HA, three ZA and three SD sets.

Additionally from this screen, you can either traverse to the point (tap
Traverse and then follow the usual traverse procedure) or tap Sideshot to
store a measurement of the point, based on all the data gathered during the
repetition shots, to store the point with the measurements taken.

NOTE: The Sideshot or Traverse buttons will not become active unless at least one
observation for each type of measurement (HA, ZA, SD) has been performed.

If you tapped Sideshot, the observation is used to store a new point, and you
view the results (see example). If you tapped Traverse, the traverse prompt
will open and you will be guided through moving and setting the instrument
on the new occupy station point. The traverse procedure is described above
(see Traverse on page 49).

Tap Sideshot if you plan to occupy the measured point at a later time. You
can use the Traverse button later to initiate moving the instrument to any
point measured from the current station.

Tap € to quit the Repetition Shots function.



6. GNSS Surveying

Starting an RTK Base

Start Survey Prompt Projection JEdiX]

Select a projection mode:

Use Ground Calibrati

Choose this mode if you are doing a ground level
survey with no projection and no datum for GNSS

Ground Calibration >

Use Mapping Plane:
Choose this mode if you will select a map
projection from the coordinate system database.

| Mapping Plane > |

["1Don't ask me again.

NOTE: You don’t need to set up a base if you are working in a network. Just make sure
your rover is configured to receive network corrections, and actually receives them
before you start taking measurements in your job. See Starting an RTK Rover on

page 55.

What you have done already:
e You have set up the base GNSS receiver on a tripod over a point of your
choice and measured the antenna height.

® You have selected GNSS from the instrument icon located on the Home
screen or Main Menu.

e You have created a receiver profile that matches the use of your receiver as
a base (or network base) and the receiver has been reported as being
“base” capable. See GNSS Mode - Connecting Survey Pro to a GNSS
Receiver on page 27.

® You have made sure the GNSS status is correct at the location where the
base is to be operated. See Checking the GNSS Status on page 34.

What you should do now:

e (o to the Survey menu and tap Start Survey. You may also find the Start
Survey function on your Home screen.

e Unless already done, highlight the name of the receiver profile you intend
to use for operating your base.
For a “network base”, select the network to which the base will deliver its
corrections by selecting the relevant network profile name. For a “base”,
there may be additional settings required using the Configure Modem button
(the radio settings provided by the selected receiver profile may not match
your case of use).

e Tap Connect.

When creating a job, if you decided not to choose a coordinate system, you

will be asked to reconsider this choice when starting the base. The Start

Survey Prompt Projection screen will appear at this time with two possible

options:

1. Ground Calibration: Choose this option if there is no known projection or
datum to relate your local grid coordinates to geodetic coordinates
(through this choice, you confirm your decision to use local control to
set up a coordinate system). The selection of a geoid is possible after
making that choice.
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2. Mapping Plane: Tap on this button if you now wish to use a coordinate
system (i.e. known origin and type of projection + known datum or
broadcast RTCM datum) that can either be keyed in or picked from
Survey Pro’s coordinate system database. For more information on the
projection mode, refer to Introduction to Calibration on page 65.

NOTE: If you always start your GNSS surveys with the same type of projection
mode, then you can tap Don't ask me again at this prompt, and Survey Pro will
start the GNSS survey with the settings you used to create the job.

Survey Pro will poll for the base position. While Survey Pro does this, enter
the antenna height you measured previously (Measured field) and how you
measured it (To field).

You may ask the base to log raw data (for post-processing) by just specifying
arecording interval in the Post Processing Recording Interval field. When you
start a rover, by default it will automatically use the same recording interval
as the base you set. Set the recording interval to “Off” if you do not want
to record raw data.

Tap Next. Survey Pro searches the point database for a location that
matches the current base position (the one that was checked on the
previous screen). If a matching point is found in the job, or else in the
reference station database (see Managing Reference Stations on page 70),
then Survey Pro offers this as the default base point. Tap Change to choose
a different point or to create a new point for the base setup.

Tap Next. The base is now started. Survey Pro prompts you to start the rover
(tap Set Rover) (as if you had tapped Start Survey on the Home screen).
Underneath the GNSS receiver profiles list, the name of the modem for the
selected profile is displayed).

NOTE: if you only want to set the base at this time, tap Finish Base Setup. Survey Pro
will then exit the Start Survey wizard and open the GNSS status page connected to
the base.




Starting an RTK Rover

Start Survey Prompt Projection [Jdix]

Select a projection mode:

Use Ground Calil i

Choose this mode if you are doing a ground level
survey with no projection and no datum for GNSS

Ground Calibration >

Use Mapping Plane:
Choose this mode if you will select a map
projection from the coordinate system database.

| Mapping Plane > |

[1Don't ask me again.

This section describes how to configure and start an RTK rover.
What you have done already:

You have set up the GNSS receiver on a pole and measured the antenna
height.

You have selected GNSS from the instrument icon located on the Home
screen or Main Menu.

You have created a receiver profile that matches the use of your receiver as
a rover (or network rover) and the receiver has been reported as being
“rover” capable. See GNSS Mode - Connecting Survey Pro to a GNSS
Receiver on page 27.

You have made sure the GNSS status is correct where you start your survey.
See Checking the GNSS Status on page 34.

What you should do now:

Go to the Survey menu and tap Start Survey. You may also find the Start
Survey function on your Home screen.

Unless already done, highlight the name of the receiver profile you intend
to use for operating your rover.

For a “network rover”, select the network from which the rover will receive
corrections by selecting the relevant network profile name. For a “rover”,
there may be additional settings required using the Configure Modem button
(the radio settings provided by the selected receiver profile may not match
your case of use).

For an "RTX" rover, no additional settings are required.

Tap Connect. If your receiver operates in RTX, refer to RTX Correction
Service on page 109 to read about the additional steps that take place at
this point.

When creating a job, if you decided not to choose a coordinate system, you
will be asked to reconsider this choice when starting the survey (unless you
started your own base and you were already prompted to make a choice at
that time). The Start Survey Prompt Projection screen will appear at this time
with two possible options:

1. Ground Calibration: Choose this option if there is no known projection or
datum to relate your local grid coordinates to geodetic coordinates
(through this choice, you confirm that you will be using a local
coordinate system defined by existing control points). The selection of
a geoid is possible after making that choice.

2. Mapping Plane: Tap on this button if you wish to use a coordinate system
(i.e. known origin and type of projection + known datum or broadcast
RTCM datum) that can either be keyed in or picked from Survey Pro’s
coordinate system database. For more information on the projection
mode, refer to Introduction to Calibration on page 65.

55



Start GNSS Survey
~Float @ 18s  [40,695 »17
Rover i D

Check the antenna height and measure to mark.

Rover T

Type: SPP91564_1
Measured: 2,000 m | To: [Bottom of mount (7]

Post Processing
Recording Interval: Off U

56

NOTE: If you always start your GNSS surveys with the same type of projection
mode, then you can tap Don't ask me again at this prompt, and Survey Pro will
start the GNSS survey with the settings you used to create the job.

While the rover receives data (corrections and position) from the base, enter
the rover antenna height you measured previously (Measured field) and how
you measured it (To field).

You may ask the rover to log raw data (for post-processing) by just
specifying a recording interval in the Post Processing Recording Interval field.
If you earlier set up a base doing the same, then make sure you are using
the same recording interval for both receivers. Select “Off” if data logging
is not required.

Tap Next.

Confirm or change the point where the base is located.

For most receivers, the height of the base antenna is broadcast over the
data link, so you do not need to change the base antenna height displayed
on this page.

NOTE: The broadcast height will be reduced to the antenna phase center, and will
show as an “Unknown” antenna brand.

If your rover receiver does not get the base antenna height from the data
link (Measured= "0.000", Base Brand= “Unknown” and Antenna Type=
“Unknown Broadcast”), you need to specify the antenna brand and type
used at the base, enter the measured height and specify the mark used to
measure the height (tap on the Change button to access the base’s Antenna
Height definition screen).

NOTE: Next time you run your rover, Survey Pro will automatically query the Base
Info list (see Managing Reference Stations on page 70) for the suitable base to use
with the rover, thus skipping the base location selection step described here.

If both the base location and antenna type match, Survey Pro will automatically use
the antenna parameters stored in the Base Info list for that base, and not the
antenna parameters broadcast by the base.

The message Rover is ready to set with reference station “x”. will indicate that the base
was picked from the reference station data base, whereas the message Rover is ready
to start a survey with base point ‘x’. will indicate it was found in the survey file.

Any time a VRS (Virtual Reference Station) survey is started, excluding a PRS
(Physical Reference Station) in a VRS survey, automatic base selection will be done
as well. The message Rover is ready to start a survey with virtual base ‘x’ will be displayed
in this case.

If the Finish button is displayed, this means the coordinate system is fully
solved, and you are ready to collect data.



Start GNSS Survey
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If the Next button is displayed instead, this means you are working in
Default Ground mode, where a calibration is always required, or you are
working in mapping plane mode but you started your base on a new point
with a new autonomous position. Tap this button. You will see a new screen
asking for occupation of control points (see screen example).

For the sake of clarity, calibration is discussed in a separate section (see
Solving Calibration on page 65).

NOTE: Solving the calibration is optional when your coordinate system is a known
map projection and datum, and your base was setup on a known point.

At this stage, you may tap Start Now to begin surveying with a temporary
calibration solution, which will solve your translation, but the scale and
orientation parameters will remain unknown. You can collect data points;
their local coordinates will be calculated with this temporary calibration.

At any time during the survey, you can collect the required number of GNSS
control points and solve the proper calibration for your site. After you solve
the calibration, any data collected points will automatically be recalculated
using the latest solution of coordinate system.

Some routines, such as point stakeout or offset points, cannot be run until
the calibration is properly solved.

Before starting data collection, tap Q in the command bar. This directly
opens the Meas. Mode tab (part of the Job Settings screen) where you can set
the acceptance criteria for different types of point collection:

— On the Data tab, define the criteria for all the points you will collect
using Point from the Data Collection screen or from the active survey map.

— On the Topo tab, define the criteria for all the points you will collect
using Topo SS from any measurement screen or from the active survey
map. Topo criteria are also used for feature collection.

— On the Check tab, define the criteria for all the points you will collect
after tapping successively Control (on the Data Collection screen), then
Check.

— On the Control tab, define the criteria for all the points you will collect
after tapping successively Control (on the Data Collection screen), then
Control.

— On the Stakeout tab, define the criteria for all the points you will collect
through any stakeout routine.

— On the RTX tab, define the criteria for all the points you will collect if
you have selected “RTX" as the survey function for your receiver (if the
receiver allows it). See also Setup Type field in Modifying a Receiver
Profile on page 31 or Managing Your Receiver Profiles on page 29.

If you collect a topo point in RTX, the Occupy for and Automatically accept
when criteria is met fields on the RTX tab are simply ignored.
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The value you choose in the HRMS field is used to test RTX convergence
for the computed position. If no HRMS value is specified (the check
button is cleared), a default value of 5 centimeters will be used to test
the convergence.

Independently for each type, you can set the following criteria:

Solution quality: “Fixed RTK only” or “Code, Float or Fix”
Max. tolerated HRMS and VRMS values

Max. tolerated PDOP value

Minimum number of satellites required (Min SV).

eLevel Bubble: Some models of GNSS receiver models are fitted with a
built-in electronic tiltmeter providing level information directly on the
screen. Check this option if you want to use it. This option will not
appear if the connected GNSS receiver does not incorporate a tiltmeter.
Minimum position averaging time, in seconds (Occupy for)
Automatically accept data collection or not when criteria are met.

NOTE: The last two criteria make sense when the receiver is set to static to give
the best averaged position. Since in Topo SS point collection Survey Pro is
allowed to store a point using the single latest epoch of data, these two criteria
are irrelevant in that case (compare the two screen examples on the left).

If you enabled raw data logging for post processing, the Post Process tab is
also accessible through which you will set the RTK autonomous points field
as follows:

Allow in PPK Survey: Choose this option to allow Survey Pro to store an

autonomous solution for a data point. This will happen during an RTK
survey in case of intermittent or prolonged data link failure. By doing

this, you will be able, after the survey and through post-processing, to
calculate a precise solution for the point using the data from the GNSS
raw data file (PPK logging file).

Do Not Store: No autonomous point will be stored.

On the Post Process tab, you can also set an alarm to warn you if the number
of satellites, or the remaining free memory size drops below a preset
threshold, or if the HDOP exceeds a preset limit.

Tap @ to save your settings. Survey Pro displays the Data Collection screen.



Collecting Data

Data Collection
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Standard data collection routines are presented below. Keep in mind that you
may have to solve the calibration before your measured GNSS coordinates are
properly transformed into your local grid (see Solving Calibration on page 65).
Remember also that you can access the data collection functions from the
active map after you have tapped and held on the map and selected Survey
Mode from the popup menu.

From the Data Collection screen, you can perform several types of point

collection:

e Point: Tap this button to collect the averaged position of a point after a
timed, static occupation on that point. The acceptance criteria defined on
the Data tab will apply. (The corresponding markers will be inserted into the
GNSS raw data file if raw data logging for post-processing is activated.)

e Topo SS: Tap this button to collect the “instant” position solution of a point.
The acceptance criteria defined on the Topo tab will apply.

In its upper part, this screen provides detailed, real-time GNSS status

information:

e Type of computed position (Fixed, Float, RTX,..) preceded by a green icon
if it complies with the current accuracy requirements (else red)

e Age of corrections (in seconds)

e Number of satellites used

e Coordinates of the last computed position, expressed in the chosen
coordinate system

 PDOP

e VRMS (estimated vertical accuracy) and HRMS (estimated horizontal
accuracy), represented respectively by small vertical and horizontal rulers.

Collecting Points

Place the pole in vertical position over the point to be surveyed and tap Point.

to start collecting data on this point.

The workflow of this routine will depend on the choice you made for the

following acceptance criteria:

e Occupy for checked and a minimum averaging time (in seconds) requested:
After tapping Point, you will see screen type [1] on which the lower-left
button label will show Survey Pro counting down from the requested
averaging time (Wait xx). After that time, Accept is restored as the button
label so you can decide on what to do: Accept the point collection now or
wait more time for an even better averaged position.

NOTE: You can tap the Wait xx button to accept the point before the minimum
duration has expired. You will in return be informed that the minimum duration is
not yet met, at which point you can discard the warning by tapping Accept anyway.
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e Occupy for cleared: Screen type [2] will be displayed for an unlimited period
of time, until you tap Accept. Point collection is then complete, unless some
other acceptance criteria are not met in which case you will see screen type
[3] after you tap Accept. You can also choose to accept the point before the
wait time expires. Still with this option cleared, you can spend some time
checking GNSS reception: This is done by pressing the GNSS Status button
on screen type [2]. Closing the GNSS status screen will take you back
directly to screen type [2].

e Automatically accept when criteria is met checked: The use of this parameter
makes sense when it is combined with Occupy for checked. Survey Pro will
automatically store the point at the end of the averaging time, unless some
other acceptance criteria are not met. In that case, at the end of the count
down, the Accept button will be restored on the screen and when you tap
on it, you will see screen type [3].
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Session Time: Session Time:
|— ’— 1:26 Measuring‘ | Accept | !

MeasuringJ | Wait 2 |

GNSS Measurement Criteifiig (%)
[3] GNSS Observation exceeds measurement criteria:

HRMS: 0,069 s too high.
VRMS: 0,073 s too high.

Keep Accept
Measuring Anyway

When screen type [31 is displayed, you can either ignore the warning message
(tap Accept Anyway), or ask for more data collection on the point (tap Keep
Measuring) until you are satisfied with the collected data (you will then tap
Accept to end the point collection).

NOTES: On-screen elLevel information is available only for those receivers
fitted with an embedded electronic tiltmeter, and provided you enabled its use
(see page 58). The View Map/View Data button allows you to choose the view
that is the most convenient to you when logging points.

Collecting Topo SS Points

This is the simplest way of collecting a point. Just tap on the Topo SS button
when you are physically on the point and you have previously named and



Collecting Offset
Points

Dist. 1

Dist. 2

described the point (see Name and Description fields). Survey Pro will save the
point position right away (no position averaging), assigning the last computed
position to the point. A new position being computed every second, the best
possible accuracy for the point is achieved if you wait about 1 second, once
physically on the point, before tapping on the Topo SS button. The Point field
is then automatically incremented, ready for storing a new point.

When GNSS reception is poor on a point of interest, you may resort to the
Offset Point method to collect it.

To select this function, go to the Survey menu and tap on Collect Offset. This
function is also available from the Data Collection screen. Offset points may be
collected in one of three ways:

1. By azimuth and distance (Az.IDist.): You choose a nearby reference point
(Md) where you know GNSS reception is good and from this point, you
measure the azimuth and distance to the offset point (¥) using any means
other that GNSS. You stand on the reference point and collect it, then you
enter the measured azimuth and distance (&7) to the offset point. Then you
store the offset point under a new point name (the point is therefore
defined by the coordinates of the reference point and the measured
azimuth and distance).

2. By 2-point azimuth and distance (2-Point Az.): You choose two nearby points
(reference point: Md, azimuth point: ®) where you know GNSS reception
is good. You measure the distance from the offset point (X) to the
reference point using any means other than GNSS. This distance is
measured in one of four possible directions compared to the reference
point, thus determining the location of the offset point compared to the
other two points:

Direction ‘ Offset Point Location
Forward | Aligned with, and beyond Az-to-Ref vector

To the left of the Az-to-Ref vector, on a line perpendicular to this vector passing

Left through the reference point.

To the right of the Az-to-Ref vector, on a line perpendicular to this vector passing

Right through the reference point.

Reverse | Somewhere on the Az-Ref segment.

One after the other and in any order, you stand on each of these points and
collect them, then you enter the measured distance and tell Survey Pro
where the offset point is located compared to the direction from the
azimuth to the reference point (“Forward”, “Left”, “Right” or “Reverse”).
Then you store the offset point under a new point name.

3. Bydistance/distance intersection (Dist./Dist.): You choose two nearby points
(reference point 1: fd and reference point 2: Bd) where you know GNSS
reception is good and from each of these points you measure the distance
to the offset point (¥). You stand on each of these points and collect them.
Then you enter the distance from each of these points to the offset point.
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Survey Pro will in return view the possible solutions for the offset point.
Choose the one that suits with what you see in the field and then store the
offset point under a new point name.

NOTE: In all three methods presented below, the reference and azimuth points
are assumed to be new points that you have to collect. But be aware these
points may also be existing points selected from either the list of points or from
the map view.

Collecting an Offset Point by Azimuth & Distance

e Choose Offset Type= Az./Dist.

e Stand on the reference point then tap on the Md Ref. button to collect this
point. This delivers an instant or averaged position solution for the point,
depending on the choice made from the down arrow attached to this
button.

e Using appropriate tools, measure the distance and azimuth from this point
to the offset point, then tap . Az./Dist. and type in the measured values.
You may need to type in the heights of the instruments used if appropriate.

e Tap @ to validate these measurements, then tap @& Store to name and log
the offset point.

Collecting an Offset Point by 2-Point Azimuth & Distance

e Choose Offset Type= 2-Point Az.

¢ Stand on the reference point then tap on the d Ref. button to collect this
point. This provides an instant or averaged position solution for the point,
depending on the choice made from the down arrow attached to this
button.

e Go toand occupy the azimuth point then tap on the ® Az. button to collect
this point. This provides an instant or averaged position solution for the
point, depending on the choice made from the down arrow attached to this
button.

e Using an appropriate tool, measure the distance from the offset point to the
reference point. Then tap & Dist. and type in the measured value.
e Tap @ to validate this measurement.

e Take alook at the map on the screen to deduce where the offset point would
be on the screen compared to the two collected points, based on what
you've done in the field. Choose between “Forward”, “Left”, “Right” or
“Reverse” to qualify this location (see explanations further above).

NOTE: The two collected points may be swapped using the scroll-down
menu attached to either the Ref. or Az. button.

e Tap & Store to name and log the offset point.
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Collecting Features
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Collecting an Offset Point by Distance/distance Intersection

Choose Offset Type= Dist./Dist.

Stand on the first reference point then tap on the d Ref. 1 button to collect
this point. This provides an instant or averaged position solution for the
point, depending on the choice made from the down arrow attached to this
button.

Using an appropriate tool, measure the distance from the collected point
to the offset point. Then tap & Dist. 1 and type in the measured value. Tap
@ to validate this measurement

Go to and occupy the second reference point then tap on the Fd Ref. 2
button to collect this point. This provides an instant or averaged position
solution for the point, depending on the choice made from the down arrow
attached to this button.

Again, measure the distance from the collected point to the offset point.
Then tap & Dist. 2 and type in the measured value. Tap @ to validate this
measurement

Take a look at the map on the screen and see which solutions Survey Pro
suggests for the offset point. Choose the one corresponding to what you see
in the field (Solution 1 or Solution 2).

If no solution is available, that means the two circles do not intersect.
Please double-check the distances measured and/or the distance values
you typed in.

NOTE: The two collected points may be swapped using the scroll-down
menu attached to either the Ref. 1 or Ref. 2 button.

Tap @ Store to name and log the offset point.

Go to the Survey menu and tap on Collect Feature. Features can be collected
using one of the methods below. In all methods, each new point name is
incremented automatically to the next available name.

Time Interval: After accepting the first point, additional points will
automatically be stored after the specified time interval (in seconds) has
elapsed.

Dist Interval - 2D or 3D: After accepting the first point, additional points will
automatically be stored after traveling the specified 2D or 3D distance.

Dist. Interval - Vertical: After accepting the first point, additional points will
automatically be stored after traveling the specified vertical distance.

Hold Still For: After accepting the first point, additional points are
automatically stored when the pole is held in the same spot for the
specified interval of time (in seconds).

Level and hold still for: Same as the previous option but you are required to
set the range pole vertical, by watching the e-level reading, before Survey
Pro starts down-counting the specified interval of time (in seconds) and log
the point automatically when time is up.

63



Collecting Data Out of
a Survey
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coordinates without a survey.

Autonomous Rover
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e Manual: Prompt Once: Will store points in the same way as Topo SS from the
Data collection screen, incrementing the point name automatically after
each stored point.

e Manual: Prompt Every Point: Same as Manual: Prompt Once except that you are
prompted for a new description, layer and attribute with each point stored.

When shown, Interval is the field where you should enter the time or distance
interval used for continuous data collection.

Use the Update Rate field to set the speed at which the rover receiver should
deliver position solutions. When Five Hz is selected, the receiver will compute
positions five times a second minimizing the measurement latency.

If you tap Data Collection on the Survey menu to work with the selected GNSS
receiver but without having first started a survey, Survey Pro will invite you to
choose between two options:

e Start the survey first, then collect data (this is the recommended way of
using Survey Pro).

e Start collecting data right away (and possibly running any stakeout
routines) using your receiver in Autonomous Rover mode, that is, with the
receiver only capable of delivering autonomous position solutions. You will
need to confirm this choice.

Working in this mode means you will collect LLH coordinates in the open
job regardless of the chosen acceptance criteria in the Data Collection
function.

NOTE: Most receiver models will provide autonomous position solutions in that
mode. However some may keep the ability to deliver more accurate solutions (i.e.
DGPS, Float or Fixed).

If you are using such a receiver, to remind you at all times that you are working with
no survey started, position solutions will be reported with a tilde character (~) placed
before the position status if better than Autonomous (e.g. “~Float” instead of
“Float”, “~Fixed” instead of “Fixed”, “~RTX" instead of “RTX").




Solving Calibration

Introduction to Calibration

A GNSS calibration is a 2D similarity transformation. The GNSS LLH

coordinates are transformed using a map projection into XY mapping plane

coordinates. The XY mapping plane coordinates are then translated, scaled
and rotated into your local grid using the calibration.

Your choice of projection mode will determine the mapping plane used for this

procedure:

1. If you started your job with no coordinate system, then there is no
projection and no datum available to relate the LLH coordinates to the local
grid coordinates. In this case, Survey Pro will initialize a default map
projection when you collect your first GNSS control point. This default
projection will be created to give ground distances at the height of the first
control point.

Because the orientation of your local grid relative to geodetic North is
unknown, you must collect at least two GNSS control points to solve the
scale, rotation, and translation between the default map projection and
your local grid coordinates.

2. If you started your job with a map projection and datum, then the measured
LLH coordinates can be transformed into local coordinates using this
selected map projection. In this case, because the scale and orientation is
defined by the map projection, you need only to solve for the translation
parameter.

If you set your base on a known point, then no calibration will be required.
If you set your base on a new autonomous point, then you must collect at
least one GNSS control point to solve the translation parameter.

A calibration with multiple points can still be performed to give extra
redundancy to the calibration solution.

A calibration is solved by collecting GNSS control points. A GNSS control point
is a point with an accurate local grid coordinate that you occupy with the GNSS
rover. The LLH from the GNSS measurement is combined with the accurate
grid point to form a calibration point pair. The calibration is then solved from
these control points to give you the best fit between your GNSS measurements
and the local ENE grid coordinate system.
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Calibration Procedure, lllustrated

The calibration procedure can be split into three distinct steps. These are
described below as flowcharts:

Base on a New Point,GN

SS Resection Case

? (%]

@ Fixed i# 105 4 0.019 815 @ Fixed i 1.0s = 0.019 E AL

el GNSS Resection Calibration
Oceupy 2 known points to
create GNSS control for the

GNSS Backsight Calibration
Occupy a known point to create
GMSS contol to orient the
setup.

Base Point:  B1_GNSS

@ ¢

Step 1: When you start a survey, Survey Pro will report the need for

calibration on the Calibration Status page, which will guide you through the
process of collecting the minimum amount of control points required for a
unique solution of the calibration.
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Step 2: The Calibration check page will guide you through the process of

collecting an additional GNSS control point to check the solution, and to
provide redundancy for the best fit least squares solution.
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Step 3: The calibration results page will solve the calibration and display
the results.

From Step 2

Control points
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You can change the contribution of your control points to the calibration
solution by tapping on the columns next to each point name in the list:

— Tap in the H column to deselect or select a point to be used in the
horizontal calibration.

Tap in the V column to deselect or select a point to be used in the
vertical calibration.

Any time you change the contribution of a control point, the Finish button

will change to a Re-Solve button. Tap this button to re-solve the calibration
using the new contribution of that control point.
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After you have solved the calibration as part of the Start Survey wizard, you can
use the Survey > Control > Control routine, or the Survey > Projection > Solve
Calibration > Add Point routine to add additional GNSS control points, re-solve
the calibration, and have all the collected points updated with the latest
calculation.

Special Case of One-Point Calibration

When you are using the Default Ground Calibration projection mode, and you
have started a new job with no points, or only one point in it, you have the
option of doing a one-point calibration to create the coordinate system for your
job. If these conditions are met, the screen will look as illustrated.

You can tap One Point to set up the calibration for a ground level survey at the
reference height displayed on this screen. Since there is only one point in the
job to start, the orientation is not fixed by the local grid coordinates, so only
the translation needs to be solved, which is possible from a single point.

How Survey Pro Deals With Base Location
With no known coordinate system used:

e |fyou set up the base on a known point, a geodetic point will be created for
the base location, using the autonomous LLH coordinates from the GNSS
receiver as the geodetic position for the base.

EXAMPLE: Base location “B1” will have for geodetic counterpart a point named
“B1_GNSS” with description “B1".

This point will automatically become a GNSS control point, with the known
grid location of the base paired with its new geodetic coordinates.

e |fyou set up the base on an unknown point, Survey Pro will create a default
point named “BASE_1" using the autonomous LLH coordinates from the
GNSS receiver as the geodetic position for the base. This point is not
eligible as a GNSS control point, because the grid coordinates are not
known until they can be calculated with a calibration solution. Until the
calibration is available, the grid coordinates of this point will be “-- -- --".

NOTE: You can set only one new autonomous base position in each job.
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With a known coordinate system used:

e |fyou set up the base on a known point, the selection of a known coordinate
system will allow Survey Pro to compute and attach the equivalent geodetic
(LLH) coordinates to that point.

e |f you set up the base on an unknown point: Same as with no coordinate
system used.

If the rover receives the coordinates of a new base station (through the
broadcast corrections message), a warning message will then be displayed.
This may occur when the receiver switches to a new network cell, or when
using a radio link and another operator is also broadcasting on the same radio
channel.

In this case, tap OK to acknowledge the warning message. This will take you
to the Start GNSS Survey screen. From that screen, you can verify and validate
the new base.

Survey Pro keeps up to date a list of reference stations that the software uses
to enhance the search for base points when starting a survey. To view this list:

e Go to the Main Menu.
e Tap Survey, then Base Info.

The Current Base tab shows the properties of the base point currently used in
the survey.

The Ref Stn List tab lists all the base points Survey Pro has been using so far.
The list includes:

e Base point names followed by the term “(database)”: These are read from
the reference station database. By default, any NTRIP station set up in a
survey —whether a single base, or a PRS in a VRS survey- is automatically
saved to that database (in addition to being part of the survey). This is done
because it is assumed that these stations are likely to be re-used in other
survey jobs to provide the required base points.

e Base point names followed by the term “(survey)”: These are read from the
current survey and so belong to the survey file. These are considered to be
temporary base points (reference stations using radios) not likely to be re-
used. That's why they are not by default saved to the reference station
database. You may however do so if you wish (see below).

From the Ref Stn List tab, you can:
e Tap to view all the properties of any reference station: base point name,

geodetic location, antenna used, and if applicable, additional information
about the NTRIP mount point used.



e For a “re-usable” reference station (<base point name> (database)), you
can use the context menu (tap and hold the base point name) to either
rename or delete the reference station, or edit the properties of its antenna.

e For a “temporary” reference point (<base point name> (survey)), you can
use the context menu to save the reference point to the reference station
database.

Endlng da Survey Go to the Home screen and tap End Survey. Confirm the end of survey by
tapping End.
A survey in progress implies that either a base or a rover or both are running.
You will need to end the currently running survey if you wish to reset the base
or rover.
Opening an existing job or creating a new one while a survey is in progress will
automatically end the current survey.
When an RTK rover or/and an RTK base is used in a survey, then ending this
survey will cause the rover to stop listening for corrections, and/or the base to
stop sending out corrections. (ProMark will however continue to operate as
rovers.)
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1. Leveling

712

Introduction

What Leveling Is

Leveling is a surveying method that allows the most accurate measurement of
vertical distances between points. Using a starting point with known elevation,
the leveling survey method allows you to transfer the elevation to new points
by measuring vertical distance differences between the known elevation and
the position of the level instrument.

Leveling data collection is organized into level loops. A level loop is a sequence
of measurements that starts and ends on a point of known elevation. Many
level loops start and end on the same point, hence the name “loop”. However,
you can start and end a level loop on different points, provided the elevation
is known for both points.

NOTE: Collecting and storing points in a level loop is different than optical or GNSS
surveying in that for leveling, you often need to take many measurements before you
reach the point of interest in the survey where you want to store a new elevation.

The procedure for leveling with Survey Pro is almost the same no matter which
leveling method you are using. The main difference for each method is the type
of information that is collected with each shot taken.

You should have now selected a leveling method and possibly connected an
instrument to Survey Pro (if you are using an electronic level or an electronic
total station for trig leveling). See Leveling Mode - Getting Ready for Leveling
on page 36 for more information.

It's a good idea, in the current job, to create the point from which your first
level loop will start. This point, which must have an accurate elevation, can
also be created when creating the level loop.

Other Definitions

e A level loop is a series of level measurements that start with a backsight
measurement on a known point with a valid elevation. This point is referred
to as the opening Control Benchmark (or opening CBM). The elevation of
the opening CBM will NOT be modified by the elevation measurements you
will collect in the loop.

A level loop is closed by taking a measurement to a point with a valid
elevation. This point is referred to as the closing Control Benchmark (or
closing CBM). Often, the closing CBM is the same point as the one where
you started the level loop, but it can also be any known point with an
accurate elevation.



A level loop can have two states: open or closed. Once a new loop is
created, it is automatically opened. It will remain open until you decide to
close the loop. A level loop is closed after shots are taken to the closing
CBM.

Level loops are stored within the current Survey file, which can contain any
number of level loops.

Any level loop can be selected from the current job as the active loop for
data collection. Once a loop is closed, it cannot be re-opened for data
collection. It can only be viewed or adjusted. Only closed loops can be
adjusted.

A level turn represents the set of backsight-foresight observations collected
from a given location where your instrument is set up. Each level turn
calculates the elevation of the point in the loop for which the foresight
observation is made. A level loop typically consists of many level turns
between each level benchmark point stored.

A benchmark is a point in your level loop for which you will store the
elevation as a point record in Survey Pro. A benchmark is usually a
permanent mark, such as a brass survey disk or a stable iron rod in the
ground, that can be reoccupied at a later date.

A turning point is an intermediate point used to connect two benchmarks.
Because a level turn is usually short (typically less than 50 meters), many
turning points are often needed to make the connection between two
consecutive benchmarks.

As opposed to benchmarks, turning points are not permanent marks on the
ground and are not stored in the job. They only exist while the rod occupies
them during the foresight/backsight measurements.

A sideshot point is a point of interest for which you will store the elevation
as a point record in Survey Pro. Unlike benchmarks, you do not turn
through sideshot points in the level loop, they are spur observations to the
loop.

A stakeout point is like a sideshot point in that you do not turn through
these points. They are spurs to your loop. A stakeout point is used to display
the cut/fill information from the level observation and some design
elevation.
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Creating or Selecting
a Level Loop
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From the main menu, tap Survey > Select/Create Loop.

NOTE: Survey Pro will list all the level loops that haven’t been closed yet. You may
select one of them and tap Activate Selected Loop to choose to work in this level loop.

To create a new level loop, tap on the New Loop button. This opens the New
Level Loop screen.

Enter a name for the new level loop (e.g. MyLoop).

Tap on [~] to define the opening CBM. The point may be selected from
either the map or the list of points. You may also create the opening CBM
at this stage.

NOTE: The opening CBM must be a point in the job with a user-entered, keyed-in
elevation. You cannot select points derived from measurements for your opening
CBM.

Tap Next.

Use the Desc field to enter a description for the level loop (e.g.
“Boundaries”). Below this field, the current definition of the level loop you
want to create is displayed. You may tap Back if you wish to modify this
definition.

When the definition of the level loop is complete, tap the Create Loop
button. A message is then displayed prompting you to proceed with level
measurements in the loop.

Tap OK to close the message. This automatically opens the screen from
which you can start collecting elevations in the level loop. (This screen can
also be accessed from the main menu by tapping Survey then Level.)



Collecting Elevations Description of a Simple Level Loop

in an Open Level Loop

A simple level loop is illustrated below.

Opening &
closing CBM

Collecting elevations in a simple level loop consists of the following:

1.

In every level loop, you will start with a backsight observation to the opening
CBM.

You will observe some number of turning points next. Turning points are not
stored in the survey file. They are used as intermediate points to transfer
the elevation between benchmarks.

After some number of turning points, you will reach a point you wish to
store an elevation for. You will observe this point as a benchmark. You can
observe a brand new point as a benchmark, in which case a new point with
only an elevation coordinate will be created. You can observe an existing
point as a benchmark, in which case you will have the option of updating
only the elevation of the existing point, and its horizontal coordinate will
remain unchanged.

After some number of turning points and benchmarks stored, you will reach
the end of your level loop. You will close the loop by collecting a foresight
observation to the closing CBM. This can be either your starting point, or it
can be another point of known elevation.

In practice, the sequence of observations will be as follows:
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1. The instrument is set up somewhere close to the maximum allowable sight
distance (typically 30 meters) away from the opening CBM. A backsight
observation is taken to the opening CBM.

2. Aforesight observation is made to the first turning point. This turning point
should be chosen in such a way that the instrument is located midway
between the opening CBM and that turning point.

Steps 1 and 2 are called the first turn, and are indicated as BS and FS in
the above diagram.

NOTE: A usually observed tolerance is that the foresight and backsight distances for
each turn should not be different from each other by more than + 5 meters, or some
similar value. Refer to Level Settings on page 37 to set this tolerance.

3. The instrument is set up midway between the first turning point (TP1) and
the second turning point (TP2). A backsight observation is made to TP1
and a foresight observation is made to TP2. These observations constitute
the second turn.

4. The instrument is set up midway between the second turning point (TP2)
and the first point of interest (BM1). A backsight observation is made to
TP2 and a foresight observation is made to BM1. These observations
constitute the third level turn.

5. Make the same types of observations for the next level turns (TP3-BM1,
TP4-TP3, BM2-TP4, TP5-BM2, TP6-TP5, BM3-TP6, TP7-BM3).

6. In the last level turn, a backsight observation is made to TP7 and a
foresight observation is made to the closing CBM, which here is the same
point as the opening CBM (it could be a different one as long as it has
accurate elevation).

There may be variants to this simple level loop. You can for example shoot
sideshot points or stakeout points as you go along the level loop. This is
explained in Collecting Elevations for Sideshot and Stakeout Points on
page 79.
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Collecting Elevations in a Simple Level Loop

After creating/selecting a loop, Survey Pro prompts you to start collecting
elevations in the loop. A new screen is displayed providing the list of possible
actions. The name of the open level loop is indicated in the upper bar.

NOTE: The ™ button provides access to the level settings (see Level Settings on
page 37).

Follow the procedure below to complete a typical level loop:

1. Set up your instrument midway between the opening CBM and the first
turning point and have your rods ready for backsight and foresight
observations.

2. Unless already done, select Survey from the main menu, then Level.

3. Tap Turn to Turning Point. Based on the shooting sequence you have chosen,
Survey Pro will prompt you successively to take all the necessary direct and
reverse shots to the backsight point (the opening CBM) and the foresight
point (the first turning point in the level loop).

If in manual leveling, you will be requested to enter the following
parameters measured with your standalone instrument:

Measurements:

2 o ]
s | £ a
g |8 2
. s 2 o
Leveling Method: S| S 7
Three Wire . . .
Single Wire .
Electronic . .
Trigonometric . .

4. After completing the shooting sequence, Survey Pro will show the results.
Tap Store Observation if you are satisfied with the results. If these are of poor
quality you can remove some of them (use the Toss button) or add new
backsight (BS) and/or foresight (FS) observations.

5. After you have tapped Store Observation, thus accepting the results, Survey
Pro will prompt you to start a second level turn.

NOTE: As you move along the loop, at the end of each level turn, Survey Pro provides
an up-to-date summary of the measurements made so far (total number of level
turns made, etc.)

If you tap on the Notes vertical tab, you will see a summary of all the measurements
made so far.
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6.

8.

9.

Move the instrument for the next level turn and then start a new shooting
sequence.

If the foresight point is a turning point, tap Turn to Turning Point again. If the
foresight point is a point of interest (i.e. a benchmark), tap Turn to
Benchmark. In both cases, proceed as explained above.

Again, Survey Pro will provide results at the end of the second level turn

that you will need to accept by tapping Store Observation. Additionally for a
benchmark, you will need to enter a name and description for that point.
This may be an existing point in the job (select it from the list or the map),
in which case Survey Pro will prompt you to update its elevation, or a new
point, in which case Survey Pro will create this point with just its elevation.
Tap @ to continue.

. For the last level turn, tap Turn to Benchmark when you are ready for the

shooting sequence. Proceed in the same way as for any benchmark.

The difference is when you name the point once the observation is
accepted, you will have to select the closing CBM from the list of existing
points. In our example, this point is also the opening CBM, a point named
“CBM". Survey Pro will then alert you that this point cannot be modified
but will give you the option to close the level loop (see screen example).
Tap Close Loop on Existing Point. Survey Pro will then provide a report on the
level loop you are about to close.

Tap Close Level Loop. A message informs you that the loop has been closed
successfully.

10.Tap OK. Survey Pro goes back to the loop summary screen from which you

will notice that no more action can be taken for the loop.

11.Tap & to return to the home screen.



Collecting Elevations for Sideshot and Stakeout Points

For some level turn, you have made your backsight measurement to the
previous turning point or benchmark. At this stage, the elevation of the
instrument is known.

Before completing the turn with a foresight measurement to the next

Sideshot or benchmark or turning point, you can shoot any number of sideshot or stakeout
Stakeout Points points. These points are spurs to the loop, as they are never used in any
Joy e backsight measurements. They are stored in the job file.
Typically with stakeout points, you will want to compare the measured
/?\ elevations to design points so you can compute cut/fill values.

Follow the instructions below to collect elevations of sideshot or stakeout
points in an open loop:

/ BS
’ FS
E/' ?53 e For the next level turn, instead of tapping Turn to Turning Point or Turn to

Benchmark, tap Sideshot or Stakeout.
e Have your instrument and rods set up accordingly.

e Start the shooting sequence: First make a backsight measurement to the
last measured benchmark or turning point, then shoot the sideshot or
stakeout point. For a stakeout point, you will need to specify which point
you want to measure. This may be an already existing point or a point you
create on the spot.

e |f your measurements are all good, tap Store Observation.

¢ Name the point and tap @.
For a sideshot point, you just need to name the point (Point field).

For a stakeout point, Survey Pro will ask you to name the as-staked point
(Point field) and will suggest to add a default description for this point in
the form “pt<stakeout_point_name>" (Description field).

NOTE: If you wish to collect a series of sideshot or stakeout points from the same
instrument setup, Survey Pro will ask you to perform foresight measurements
directly to the second and next points (no backsight measurements need to be
repeated in this case as Survey Pro has already collected these measurements for
the first of these points).

e When you are finished with the collection of your sideshot or stakeout
points, tap Turn to Turning Point or Turn to Benchmark to complete the level
turn. Once again, you will just have to perform foresight measurements to
this point, the backsight measurements having been already made.

e Start a new level turn.
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Adjusting a Closed Loop
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Adjustment may be used to remove the error computed from any existing
closed loop. This is a simple arithmetic adjustment where the computed error
can be either distributed equally among each instrument setup in the loop, or
a weighted adjustment can be applied where the error is distributed based on
the length of the backsight and foresight distance of each turn.

1. From the main menu, tap Survey > Adjustment

2. Choose how you want Survey Pro to distribute errors. Weigh by # of Setups
divides the computed error equally among each instrument setup selected
in the loop. Weigh by length of Setups distributes the error where each
instrument setup is adjusted by an error proportional to the length between
them, so that instrument setups that are farther apart will carry a larger
portion of the error adjustment than those closer together.

3. Choose the portion of the loop you want to adjust. Adjust Loop from Begin to
End will include every instrument setup of the selected level loop in the
error adjustment. Adjust Loop From a Specific Point to End will only adjust the
turning points and benchmarks starting from an alternative benchmark
(that you need to specify in the Begin CBM Pt field) to the end of the loop.

4. Use the Closed Loop Name drop-down list to select the name of the loop you
want to adjust. Only closed loops are listed here.

5. Tap Next to access the Adjustment Preview screen.

6. Tap Adjust to start the adjustment. At the end of this process, a message
will inform you that the job file has been backed up and this backup file
includes the archive of the adjustment.

7. Tap OK to close the message and read the results of the adjustment.

8. Tap &3 to close the results screen.



Running the 2 Peg Test
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Shooting the shot 'a2' on point 4.
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Press the 'Take Shot' button when you are ready.

Take Shot

The 2 Peg test is used to check the collimation error of an automatic level
instrument. This test can be used for electronic automatic levels and manual
automatic levels. The test will compute the error, which can then be used to
adjust the horizontal cross-hair of the instrument.

1. Position two rods 50 to 90 meters apart (165 to 300 feet).

2. Pace off the distance between the rods and set up the level midway
between them. (The placement of the rod over Point B can be adjusted after
shooting Point A.)

3. Carefully level the instrument. You should be able to rotate the instrument
180° around its vertical axis without the bubble moving away from the
center.

4. From the main menu, tap Survey > 2 Peg Test.

5. Tap Take Shot. You are now prompted to take each set of shots to the rod
over Point A. Once each shot is completed for the number of sets entered
in the Level Settings screen, you will return to the Peg Test screen.

6. Turn the instrument to the rod over Point B.

7. You can optionally tap Check H Dist to verify the instrument is centered
between the two rods.

The distance to Point B will be measured and compared to the horizontal
distances previously measured to Point A and a come/go distance will be
provided so the rod at Point B can be moved to equal the horizontal
distance to Point A prior to taking the shots that will be used to compute
the error.

8. Tap Take Shot. You are now prompted to take the required shots to the rod
over Point B. Once completed, the Peg Test screen will open with a new
graphic showing the next instrument setup.

9. Move the instrument as close as possible to the rod over Point A where a
shot can still be taken to it. This is typically about 3 meters (10 feet) from
the rod.

10.Tap Take Shot. You can now take the required shots to Point A from the new
instrument setup.

11.0nce complete, turn to Point B and take the required shots to that point.

12.After the final shot is taken, the Peg Test Results screen will open showing
the details of the shots taken and the computed error.

13.Tap & to close the results screen.
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8. Stakeout Routines

Selecting Points to Be
Staked, “Next Point”
Scenario
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This section introduces the basic stakeout routines with optical and GNSS
instruments. When you become familiar with these routines, you will be able
to extend your knowledge on more specific stakeout routines, such as stake to
line, slope staking, etc.

What you should have done already:

* You should have now completed the station setup with your optical
instrument.

¢ You should have now solved the calibration with your GNSS receiver.

e |f the points to stake are not in your job, you can use the File > Import
function to import your points to the job (see Importing Data on page 16).

The built-in electronic compass (if there is one in your data collector) may be
a valuable tool during the guidance phase as its activation will translate into
accurate N/S indications on the stakeout screen (see Electronic Compass on
page 107 for more information).

Whether you are working in GNSS or optical, Survey Pro offers two different
ways of selecting points for stakeout work:
By Points method (see screen [1] below): This is the simplest method. You
just select the point, from the open job, from either the list of points or the
map view, and then you stake it out. Icons assigned to points remain the
same (+) at every step of the stakeout procedure.

e By Managed Points method (see screen [2] below): This method gives better
control over the whole stakeout process. You need to create a list of design
points. lcons assigned to these points are distinct from other points and
later will change after the points have been staked. See “By Managed
Points” Method on page 83 for more information on this method.

To choose one of the two methods, go to Stakeout > Stake Points and use the
button located in the upper-left corner (see diagram below).

Wlstake points  IEEGECI-IWPA|stake Points IEREEN<]
By Paints - By Managed Paints W r EEE:’D
4 Managed Paints g ST1000
2 ghesign 2 PStaked Design Po
sT1007
+ oesgneont: [ Rrcont ][] & Point: [RHCODL R
Desc.: RMNC Desc.: RHC ‘ Manage Design. |
IMPD\ntB Iﬂcremem;'ul H Nesxt Paint ‘ { Next Point By Clogest Pt iw Next Closest
OCC:PT100 HI:2,000 BS:0°00'00" OCC:PTIO00 HI2,000 BS:0°00'00"
2240 m |@E [ Backsight... ][ Solve > | HR{z.240 m ‘EE [(Backsight... | soke > |

“Next Point” Scenario. After you have staked out a point, Survey Pro may help
you select the next point to be staked. This may be:



The point whose name matches the increment you specify (see screen [1]
above).

e.g. “ST101" first staked and Increment= 2, then next point will be “ST103".

Or the point the closest to the one you have just staked (see screen [2]
above). If the By Managed Points method is used, Survey Pro will search for
and prompt the closest design point, ignoring all the other types of points.
With the By Points method, Survey Pro will search for the closest point,
regardless of its type (design, staked or undifferentiated).

“By Managed Points” Method

Tap Stakeout > Manage Design Points (or tap Stakeout > Stake Points and then
tap on the Manage Design button).
All design points are necessarily picked from the open job. When added to

the list, points are allotted the design point icon (). For more details, see
screen and instructions below.

Manage Design Points Pl <)
2] — s ars Desigrpaints: \ [3]
%H To/Fram... ” Fram Layer... Hv! [4]

|5 Managed Points |
(5] 15 ®oesi;n 0 F‘StakedJ h gl=ho

et et S ill [l g

Foint Mame | Description -
18 rHco0L RMC @
|| ®sT0001 Design Pts
7] & ST0002 Desighn Pts L
*

— (8]

& STO003 Design Pts =

T 7
[9] [10]

— [1]: Used to select points from the map.

— [21: Used to select points by specifying a point name (e.g. “ST100") or
a range of point names (e.g. “ST200-ST300".

— [3]: Used to select all the points from the layer you specify.

— [4]: Used to select points using another selection criterion (non-control
points, distance, description, feature code or layer).

— [51: Indicates the current number of managed points:
Managed Points= Design Points + Staked Points

When you start a new list, that list can only contain design points. As
you progress in your stakeout work, design points will change into
staked points.

— [6]1: Used to choose which type of points to view in the list (all, design
points only, or staked points only)

— [71: Current content of the managed points list according to viewing
option [6].
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— [81: Set of three buttons allowing you to manually change the selected
point in the list ([7]) into a design point, a staked point or a deleted
point (respectively from top to bottom). Deleting a point means it
disappears from the list and, seen from the list of points (in Job >
Points), it becomes an “undifferentiated” point (+).

— [91: Used to change all the staked points in the list back into design
points.

— [10]: Used to erase the current list of managed points. (No point is
deleted from the job through this action.)

When the list is complete, tap €. You can then start staking out the first
design point.

NOTE: The icon of the design point will change from & to * only if you store the
measured position as a new point in the job (which will be assigned a (+) icon).

Go to the Stakeout menu and tap Stake Points.

Select the point to be staked using one of the two possible methods, as well
as the criterion allowing Survey Pro to prompt the next point to be staked
(see Selecting Points to Be Staked, “Next Point” Scenario on page 82).
Choose the type of target used and set the height of the rod (HR field). The
information underneath describes the current station setup.

(You may use the Backsight button to check the station setup or start a new
setup.)

Tap Solve. The Stake Points screen now indicates the angle and distances
the instrument should measure with the target placed exactly over the
design point.

It may be convenient at this point to change the circle setting so that it
reads zero when the total station is facing toward the design point. This can
be done by tapping the Circle Zero button. The first time you tap this button
during a stakeout session, a message will warn that the original backsight
reference will be lost.
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The following appears when zeroing the circle:

— A new backsight circle value is computed, sent to the instrument and
stored in the raw data.

— The Angle Right value is changed to zero to reflect the change (see
example). The instrument now needs to be turned horizontally to zero to
face the design point.

— To prevent errors, the backsight setup is invalidated when exiting the
Stakeout function. You will need to reset your backsight circle to the
proper reference after exiting stakeout before collecting any new data.

Whatever your choice about the circle setting, orient the instrument as

requested so the instrument is facing the target.

Tap Stake then Shot to take a measurement. The screen returns the results

of the measurement, providing information to adjust the position of the

target (see screen example):

— FORWARD / BACK: Indicates if the rod must move forward (toward the
instrument) or backward (away from the instrument).

— GoRIGHT / Go LEFT: Indicates if the rod must move to the right or left
from the instrument’s point of view.

NOTE: You can also get the reverse indication (i.e. displaying directions from the
rod’s viewpoint) by clearing the View From Instrument to Rod (non-remote) option in
Job > Settings > Stakeout tab.

— CUT/FILL: Displays the required amount of cut or fill to bring the stake
point to the design point’s elevation.

— RodElev: Displays the elevation at the rod’s location computed from the
last shot.

When you are satisfied with the location of the target, stake the point and
then do one of the following:

1. Before moving on to the next point, you may want to store the location
of the as-staked point: While still standing on the target, tap Store, name
and describe the point (the default description prompted by Survey Pro
is in the form “ST<name_of_point_you have_just staked>), then tap @
to collect the point. This point will be marked with a + icon.

2. Or If you wish to stake the next point without storing the results of this
staked point, tap Stake Next.
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Go to the Stakeout menu and tap Stake Points.
Select the point to be staked using one of the two possible methods, as well
as the criterion allowing Survey Pro to prompt the next point to be staked
(see Selecting Points to Be Staked, “Next Point” Scenario on page 82).
Choose the type of target used and set the height of the rod (HR field). The
information underneath describes the current station setup.
(You may use the Backsight button to check the station setup or start a new
setup.)
Tap Stake. This opens the Remote Staking screen.
If the status on that screen indicates that robotic tracking is not locked on,
you can tap the Remote button to open up the Remote Control screen, where
you can initiate a search for the target. Then tap & to close this screen.
The Remote Staking screen (illustrated) will guide you to the design point.
Survey Pro offers two different navigation modes to help you walk to the
design point:

(1] [2]
Status: Locked @
B WA
o / gﬁg
W STK202 "Stake" ( / W STK202 "Stake"

BH current Rod Location P B3 current Rod Location
- o \S/ " :
Direction to Instrumer Som 8 Direction to Instrumer

Remote Staking
Status: Locked
BACK: 0,670 m
Go RIGHT: 24,371 m
CUT:

| Remote... || Topo SS... || Done | | Remote... || Topo SS... H Done |

Tap on the button in the upper-right corner to change the navigation mode:

+1l: When this button is displayed, the top of the screen shows the
direction to the total station ([11).

- : When this button is displayed, you see a copy of the map view on
this screen ([2]), including background maps, if any made visible. You
may tap within this area to switch to the complete map view.

In both navigation modes, the screen provides information on how far you

are from the design point:

— FORWARD / BACK: Indicates if the rod must move forward (toward the
instrument) or backward (away from the instrument).

— GoRIGHT / Go LEFT: Indicates if the rod must move to the right or left
from the rod’s point of view. This requires that you have cleared the View
From Instrument to Rod (remote) option in Job > Settings > Stakeout tab,
otherwise you will get the reverse indication, i.e. directions from the
instrument’s viewpoint.

— CUT/FILL: Displays the required amount of cut or fill to bring the stake
point to the design point’s elevation.



Rod Elev: Displays the elevation at the rod’s location computed from the
last shot.

e Walk toward the design point following the instructions on the screen:

Symbol Meaning
E Design point location.
8 Your current location.
@ Instrument location.
e im Scale used on the graphic. Represents the circle radius.
FORWARD/BACK: xxx
Go LEFT/Go RIGHT: xxx |Horizontal and vertical components of the distance still to go.
FILL/CUT: xxx

When you get closer to the design point, the graphic will change to assist
you in more precisely locating the design point. The point to stake becomes
the fixed center of the display and the rod becomes the object that is

moving. This aids in precisely positioning the rod over the point. A red arrow

indicates the direction in which to go.

1. Distance to go is between 3.0 and 0.3 m (10 and 1 ft): Four dark-green
spots appear around the graphic.
2. Distance to go is less than 0.3 m (1 ft): The spots around the graphic

turn light green.
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When you are satisfied with the location of the target, tap Done to access
the Stake Points screen. The screen indicates how close you are to the
design point.

Stake the point and then do one of the following:

1. Before moving on to the next point, you may want to store the location
of the as-staked point: While still standing on the target, tap Store, name
and describe the point (the default description prompted by Survey Pro
is in the form “ST<name_of_point_you have_just staked>), then tap @
to collect the point. This point will be marked with a + icon.

2. Or If you wish to stake the next point without storing the results of this
staked point, tap Stake Next.

Whatever your choice, you will then be taken back to the Stake Points screen
with the next point to stake automatically selected, (based on the Increment
value you entered previously).

NOTE: At this stage, you may:

- Change the elevation of the design point after tapping Change.

- Tap the Turn button to automatically turn the instrument toward the design point.
- Tap the Shot button to re-measure the point.

- Collect a Topo SS point using the Topo SS button.

WARNING: Be sure you are using the Store button to store stakeout data. The Topo
S8 button only stores sideshot data.
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Go to the Stakeout menu and tap Stake Points

Select the point to be staked using one of the two possible methods, as well
as the criterion allowing Survey Pro to prompt the next point to be staked
(see Selecting Points to Be Staked, “Next Point” Scenario on page 82)
Set the rover antenna height.

Tap Stake. This opens the screen that will guide you to the point. Survey Pro
offers three different navigation modes to help you walk to the design point
(the screenshot examples shown below are those of an SP80 for which an
e-level is displayed. Note that not all GNSS receivers have this tool. When
no e-level is available, the corresponding area on the screen is left empty).

GNSS Staking GNSS Staking | GNss staking
@ Fixed 1) 14s 0031 £13 | [ Fixed @) 14s 90031 13 @ Fixed 145 0031 & 13|
| Go SOUTH 8,919 m + | Go SOUT- 8,606 m + . Go SOUTF 9,137 m
| Go WEST: 22,574 m —yy | Go WEST: 22,291 m Go WEST: 22,718 m
w FILL:  1,468m / \ } FILL:  1,678m FILL:  1,556m |
In‘! STK202 "Stake" ( | E STK202 " Stake & # STK202 "Stake” A
Pt + [Rer: 0°00°00" G032
‘. \ I | & o] P
( Ak
S / | Q
Topo SS... 20m | Topo SS... 20m Topo SS... |
; [ Accert_]| |[»rovine ‘Accept » ROVING

NOTE: In the example above, the direction to follow is provided as Go South / Go West
instructions. Survey Pro can instead provide Azimuth / Distance to the point if it's
more convenient for you. Go to Job > Settings > Stakeout tab to change the setting of
the Display Directions As field. Point tolerance (different from acceptance criteria)
can also be set on this tab.

Tap on the buttons shown in the upper-right corner (] 7 [F / [E] ) to
change the navigation mode:

- : When this button is displayed, the top of the screen shows the
direction in which you are walking ([11). A large red arrow will appear as
you walk. The North (N) and South (S) directions will be shown as well.
You can also define a reference point or azimuth using the Ref... button.
The resulting direction will appear as a blue line starting from your
current position.

When this button is displayed, the top of the screen shows the
selected reference point or azimuth you select through the Ref... button
([21).

- : When this button is displayed, you see a copy of the map view on
this screen ([31), including background maps, if any made visible. You
may tap within this area to switch to the complete map view.

Walk toward the design point following the instructions on the screen (see
table below).
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Remember the rover receiver is always in dynamic mode (>ROVING button
displayed) as you navigate to the design point:

Symbol | Meaning
E Design point location.

I‘_ﬁ'_"l Your current location.

+ Reference point or azimuth.

== 11w |Scale used on the graphic. Represents the circle radius.

Go N/S: xxx
Go E/W: xxx | Horizontal and vertical components of the distance still to go.

FILL/CUT: xxx

NOTE: You can use the Topo SS button any time along the way to store any point of
interest. Survey Pro will ask you to name and describe that point before storing it.

When you get closer to the design point, the graphic will change to assist
you in more precisely locating the design point. The point to stake becomes
the fixed center of the display and the rod becomes the object that is
moving. This aids in precisely positioning the rod over the point. A red arrow
indicates the direction in which to go.

@ @

I. | e— ] 2.

1. Distance to go is between 3.0 and 0.3 m (10 and 1 ft): Dark-green spots
appear around the graphic.

2. Distance to go is less than 0.3 m (1 ft): The spots around the graphic
turn light green.

3. Your current position is within the acceptance criteria defined on the
Stakeout tab: The rover and the design point are practically
superimposed at the center of the graphic.
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When you have located the design point and you wish to collect a static RTK
occupation at this point in order to get a more precise position averaged
from multiple epochs, you should toggle to occupying mode by tapping the
>ROVING button (which is then changed into an >OCCUPYING button). This
will turn the receiver into static mode for the occupation.

When you are satisfied with the occupation results, you can tap Accept to
finish the stakeout measurement. Depending on the acceptance criteria
you set on the Stakeout tab, the button label may show Wait xx before it
becomes an Accept button. The screen then shows the results of the
position computation for the staked point.

NOTE 1: At this stage, you may tap Shot to re-measure the point. You may also
change the elevation of the design point by tapping Change.

NOTE 2: If you are simultaneously collecting raw data for post-processing, the as-
staked point is automatically stored when you tap Accept on the previous screen,
provided you did a static occupation on the point.

WARNING: Be sure you are using the Store button to store stakeout data. The Topo
S8 button only stores sideshot data.

Stake the point and then do one of the following:

1. Before moving on to the next point, you may want to store the location
of the as-staked point: While still standing on the target, tap Store, name
and describe the point (the default description prompted by Survey Pro
is in the form “ST<name_of_point_you have_just staked>), then tap @
to collect the point. This point will be marked with a + icon.

2. Or If you wish to stake the next point without storing the results of this
staked point, tap Stake Next.

Whatever your choice, you will then be taken back to the Stake Points screen
with the next point to stake automatically selected, (based on the Increment
value you entered previously).
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You can use Survey Pro for other stakeout routines:

Stake to Line: Allows you to locate any position in relation to a predefined
line. The line can be defined by two points, a point and direction, a polyline
or the centerline of an alignment. Distance, direction and cut/fill
information is provided so the rod/the rover can locate the line by traveling
the shortest possible distance (a perpendicular offset to the line).

Compared to point stakeout, the guidance screen (illustrated) will be
automatically restored after you have stored a point, ready for storing the
next point. This routine is often used to keep the rod on-line while clearing
line along a property boundary.

Offset Staking: Is used to stake the center of a road, the road edge, the curb/
ditch edge, or any offset at fixed intervals. An existing polyline, alignment,
or a specified point range can define the centerline of the road.

Slope Staking: Is used to locate the catch points for a roadway in any terrain.
The first screen is used to define or select the line that describes the
centerline of the road to be slope staked. An existing polyline or alignment
can be selected, or a series of existing points can be entered to define the
centerline.

Point Slope Staking: Is a simplified version of the Slope Staking routine.
Stake Skew Line: is used to stake a usually short straight line (a skew line)
intersecting the current polyline at a given point and with a given skew
angle (for example this function is useful for staking a culvert going under
a road).

Line and Offset, Curve and Offset and Spiral and Offset: Are used to stake
stations at fixed intervals on respectively a line, curve or spiral, or at an
offset to it.

Show Station: Allows you to see where the rodman/rover standing anywhere
near a polyline, a range of points that define a line, or an alignment is
located in relation to the line.

Store Offset Points: Is used to store points in the current job at a specified
offset from an existing polyline or alignment at a specified interval.

Stake DTM: Allows you to stake an area and get cut/fill information between
the point being staked and a reference DTM surface at the same horizontal
coordinates.

Define a Location: Is used to manually enter the distance and direction to a
new point from any existing reference point and then stake out the new
point.

Where is Next Pt?: Provides instructions to locate the next point in the job
taking into account the current location of the operator (or rodman) and a
reference point.



Navigation: Allows you to navigate to existing points using autonomous
positions from a GPS receiver that outputs a NMEA signal. The routine also
allows you to store coarse-precision GPS points.

93



9. Survey Pro’s On-Board Version
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Survey Pro is used on board a Nikon Nivo or Spectra Precision FOCUS total
station. After you have powered on the instrument, wait until the screen
displays the desktop. Then do the following:

e Double-tap the Survey Pro icon: B#. Survey Pro starts initializing the
instrument. The Level Bubble screen is then shown (see screen example).

e Level the instrument and enable or disable the compensator, as required.

e Tap & when done. This opens the Quick Shot screen.

You may take measurements with Survey Pro without opening a job. You may
also create or open a job where you can collect all your measurements and/or
use as reference other measurements you collected earlier in that job.

NOTE: The onboard version of Survey Pro will always start with no job open regardless
of whether you ended your last Survey Pro session with a job open or not.

The Quick Shot screen you get at startup can be split into different parts:
Command bar ([1] to [9])

e Function buttons ([10] to [13]1)

e Result pane ([14])

¢ Target management and EDM measurement mode ([15])

e QOther control buttons ([16] to [18]).

Robotic Instrument:
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Mechanical Instrument:
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Command bar:

[1]: Provides access to Online Help.
[2]: (Robotic instrument only) Denotes keyboard used in numeric mode.
[3]: Provides status of visible laser pointer:

- ¥ off. Tapping this icon will toggle it On.

NOTE: Standard safety precautions should be taken to ensure that persons do
not look directly into the beam.

- ¥.o0n. Tapping this icon will toggle it Off.

For safety reasons, this button is always accessible so that at all times you
can easily disable the laser pointer whatever the screen you are on.

[4]: Battery status. This icon provides access to the power off setting
through which you can set an idle time at the end of which the instrument
will be turned off automatically.

[5]: Provides access to the instrument settings (specific to each
instrument).

[6]: This icon allows you to switch to another data collection mode (using
a data collector through a serial cable, Bluetooth or in Robotic mode).
[7]1: Quick Pick function: Provides quick access to common Survey Pro
functions. About and Level Bubble are the only two selections available
unless a job is open. After a job is opened, the list will populate with
available functions.
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e [8]: Provides access to Survey Pro settings:

— Units tab: Used to set distance and angle units, directions, azimuth type
and the order in which to display/deliver coordinates.

— Format tab: Used to set the number of decimal places displayed by the
instrument for each type of measurement.

— Quick Shot tab: Used to choose which results to display (HA, ZA, SD or
HA, HD, VD) and which function to assign to the Measurement key
(Measure Only or Measure and Store). Measure and Store requires an open
job. See Working With a Job Open on page 98.)

e [9]: Used to exit.

Function buttons:

(More functions are available from these buttons with a job open. See Working
With a Job Open on page 98.)

The left-arrow button located before each function button opens a related
menu. Tapping directly on the function button is equivalent to selecting the
first option on the menu.

e [10]: Sets the circle to O or to any value you specify.

e [11]: (Robotic instrument only) Turns to angles you specify, or to flip the
instrument.

e [12]: (Robotic instrument only) Starts the search target or LockNGo
function or stops the one you last activated.

e [13]: Opens or creates a job where measurements will be stored.

Result pane:
(Item [14]) on the screen example.)

Depending on how you set the Display field on the Quick Shot tab (see [8]

above), this pane will either provide the measured values of:

e Horizontal angle (HA), zenith angle (ZA) and slope distance (SD)

e Or horizontal angle (HA), horizontal distance (HD) and vertical distance
(VD).

Tapping on the display over these labels will also toggle between the display
modes.



Target management:
(Item [15]) on the screen example.)

HR field: Enter the height of rod for the selected target

KX / = button: Specify the type of target used. Also provides access to the
management of smart targets.

Choose the EDM measurement mode. This is an instrument-dependent
setting but these are the usual available options:

— Standard: (Focus 30) Precise measurement mode, activated only when
you trigger a measurement

— Tracking: (Focus 30) EDM continuously measuring distances
— Normal: (Nivo) Normal measurement mode
— Precise: (Nivo) Precise measurement mode

Other control buttons:

[16]: A button equivalent to and bigger than button [3].

[17]: Turns on or off the instrument’s track light. The track light is for
helping the rodman stay online when staking. It will flash more quickly
when the instrument is locked to the target.

The track light is instrument dependent. For example, the Focus 30 has
two different colors (green and red) located on either side of the
instrument. Nivo has two red colors, one that flashes and the other that
doesn't.

[18]: Instrument dependent. Shows LockNGo status (IDLE, MEASURING
or Locked). Also shows if the current measuring mode uses a prism or
reflectorless target.
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Working With
a Job Open

If you open or create a job using button [13], the Quick Shot screen will then
show different options.

Robotic Instrument:

Quick ShIEEEE R RN <]
Ha: 79.1397 < Bt Do
104.6761 3 e | 1y

4

=

— [12]

403

[19]—— *** BACKSIGHT IS MOT SET *** |

1.500 m -%-El Standardﬂ
Foresight: Il El :
[20]— bDesc.:ISS El % I‘_\I

HR.:

e

4

_*_

Mechanical Instrument:

Quick Shot IETE TR N

Ha: 0.0006 <« BE 0o
2k 102.0725],
- 281.830 m

[19] — *** BACKSIGHT IS NOT SET *** \

HR:|1.DDD m @E | Frecise W |
Faoresight: 4 Izl |
[20] » Desc. |55 Iz‘ i -

—[13]

UEhy
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The differences are listed below:

[101: With a job open, the Quick Stake screen can be accessed through this
button. The Stakeout, Station Setup and Check Setup functions can be
accessed by clicking on the arrow to the left of this button.

[11] and [12]: Same as with no job open.

[13]: With a job open, a sideshot can be taken and stored by pressing this
button. The Sideshot and Traverse functions can be accessed by clicking on
the arrow to the left of this button.

[19]: The current station setup status is reported in this area.

[201]: Use this area to name and describe each point you will be measuring
and storing in the job. Make sure MSR Key= Measure and Store on the Quick



Shot tab if you plan to store measurement data (see [8] described earlier in
this section).

With a job open, you can perform a lot of the most commonly used functions
from the Quick Shot screen. To access the full set of Survey Pro functions, you
can close the Quick Shot screen and access the Survey Pro main menu. Survey
Pro can be used either in optical or leveling mode.

NOTE: To access the Quick Shot screen at any time, simply press the “star”/F1 hard key
on the instrument.
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Appendix

Advanced Information Layers

on Point Properties Layers help you manage the data in a job. Any number of layers can exist in a
job and any new objects (points, polyline alignments) can be assigned to any
particular layer.

The visibility of any layer can be toggled on and off, which gives full control
over the data that is displayed in a map view. This is useful to reduce clutter
in a job that contains several objects.

Layers can be added, deleted and renamed with the exception of Layer O and
the Control Layer. Layer O is a special layer that must exist in every job for
compatibility with AutoCAD and for storing objects not assigned to any other
layer. The Control layer is a special layer used by Survey Pro to denote control
points in the job. Control points are protected and cannot be modified.

Use the Power button located near the Layer field to manage your layers. Use
the Set Active button on the Manage Layers screen to set the default layer used
in your measurements.

Descriptions

A description may be defined for each point you store in a job (e.g. tree,

pavement). You can create a description list to automate the task of entering

descriptions for points when they are stored. This is particularly useful when

the same description is used frequently.

A description list is stored in Survey Pro as a description file (a TXT file you

store in /Survey Pro Jobs/ for example), which may be in two different formats.
[1] [2] Choosing one rather than the other determines how descriptions are entered:

ITEEER ENEEs ¢ Description list without codes [1]: Only contains the list of descriptions you
File Edit Format iew Fie Edit Format Wiew Wa[’]t to use.

Help Help

i) o Sy e Description list with codes [2]: Similar to the previous one except a short
e '.iﬁ;@gﬁ?ﬁi"g code precedes each description (with a space or tab in between). Tapping
oak ree 03 Oak Tree . . . N

cherry e < Chary Tree the code rather than the full description will speed up entering

ponderosa pine po Ponderasa Pine

descriptions.

You can use simultaneously two lists, one of each type. Use the Power button
located near the Description field to manage your lists.
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Features & Attributes

Features can be used to quickly describe objects (points, lines), and in more
detail than a standard text description, particularly when data is collected for
several points that fit into the same object (e.g. a line).

A feature describes what an object is while attributes describe the details of
that object.

Features and attributes can be entered as you collect data, or later by editing
the points in your job. Lists of features are usually pre-defined and saved in

XML format (file with FXL extension) for direct use in Survey Pro.

Choosing a Feature Database:

¢ Go to Job >Settings and open the Auto Linework tab. By default, Survey Pro
prompts you to use the GlobalFeatures.fxl file as the feature definition file.
You can choose any other FXL file prepared specifically for your work, and
stored on the data collector.
The GlobalFeatures.FXL file lists more than 10 categories of features
(Buildings, Earth Drainage, Landscaping, etc.). Each of these categories
contains 5 to 10 different features. Some additional 10 features also exist
in the file that are not part of any of these categories.
Each feature has an icon, a name and a feature code, which is an
abbreviation of the feature name (e.g. "cp" for "concrete pad").

e After you have chosen your FXL file, tap @ .

Enabling Feature Entry While Collecting Data:
e Go to Job > Settings and open the Surveying tab.

¢ Enable the Prompt for Feature and Attributes option, then tap @ .

Entering Features While Collecting Data: When collecting points, features and
attributes can be assigned to each point individually. When collecting lines,
you just need to assign features to the first point when starting collecting the
line. Then all the points collected along the line will be assigned the same
features as the first point.

Before you store a point, Survey Pro will show a list of feature codes already
used in the job (see screen example). Just tap on a feature code button to enter
the corresponding feature.

* - | can also be used to pick a new feature code from the selected FXL file.

Within the frame, you can then define each of the attributes for the point. This
may be an image file, or a description of the point in relation to its location
along the line.
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Adding/Modifying Features By Editing Points:
¢ Go to Job > Points.

e Select the point for which extra features are required, or attributes need to
be corrected.

e Tap then open the Feature tab.

e Tap to add a new feature (and define its attributes), or directly edit
the attributes of the existing features if necessary.

Handling the Feature Database:

e Assuming you have tapped to access the feature database,

e Tap to set a filter on the list of available features so you can focus on
the features you are interested in:

— Selecting All will list all the features (no filter)
— Selecting Codes In Use will only list the features already in use in the job

— Selecting a category of features (e.g. “Manmade Boundary”) will list
only the features pertaining to this category (see screen example).

Toggling Between Descriptions and Features

You can easily change the type of identification information attached to a point
you are about to collect. The field accompanying the point name just before

the point is collected may be either a description (Desc.) or a feature (Feat.).

To toggle between the two types, just tap on the field label [1] (a scroll button).
The power button ([2]) adjacent to the field may then be used to set a value
for the field (see below).

OCCIST1 HL2,000 BS:STS, 328°45'54" OCCiST1 HL:2.000 BS:STS, 328°46'54"
e N L T
v |refp2an m |EE[ ] ) Feat.: w |Hr{z240m QE
Description Settings... pp
Edit Description List... qup
Show Description List [ 1 ] [ 2] wm

It is worth mentioning that the Description/Feature toggle button only controls
what you have as an edit field when you start data collection. You can still use
the Prompt for Description and Prompt for Feature and Attributes on the Surveying
tab in Job > Settings to control what you will be prompted for before you store
the point. See the different possible scenarios in the table below.



is: Description| Feature Comments

‘ Edit field | Prompt for | Promptfor

You are prompted for Description and Feature:

+ The default value prompted for Description is the one you
defined before collecting the point.

+ When prompted, the Feature field is shown empty.

You are prompted for Description only:

+ The default value prompted for Description is the one you
defined before collecting the point.

+ No Feature stored for the point.

No Prompt:

+ The Description stored for the point is the one assigned to
the Description field before collecting the point.

+ No Feature stored for the point.

You are prompted for Description and Feature:

+ The default value prompted for the Feature field is the one
you defined before collecting the point.

+ When prompted, the Description field is shown empty.

You are prompted for Feature only:

+ The default value prompted for the Feature field is the one
you defined before collecting the point.

+ No Description stored for the point.

No Prompt:

+ The Feature stored for the point is the one assigned to the
Field field before collecting the point.

+ No Description stored for the point.

[N

Description ON ON

N

Description ON OFF

w

Description OFF OFF

~

Feature ON ON

(S}

Feature OFF ON

(2]

Feature OFF OFF

Quick Codes Function

The Quick Codes function is available in both Optical and GNSS Surveying. It
is particularly useful when you have to collect a series of points for which you
anticipate that a different description or feature will have to be defined for
each new point you collect.

e To access the function, go to the main menu and tap Survey > Quick Codes.

Quick Codes The Quick Codes function allows you to quickly choose a description or
L) izt Do B LE feature from one of the existing tables (max. 10 user-preset descriptions or
| (CH 2 features per table).

Set HR | |2,000 H f . . . .
. 1o+ Bottom of antenna mo By default, Survey Pro only contains a single table of preset descriptions or
e | Rl features but, using the big scroll-down button next to the table, you may

FIR 7 OAK B MAPLE |- . . . .

——.T o . T one create new tables with more of your own descriptions or features. Using the

s W0 M o same scroll-down button, you may also rename or delete an existing table.
FENCE | When several tables exist in Survey Pro, use the scroll-down list to select

the table from which to pick a description or feature.

e To toggle between Description and Feature, tap on the Description/Feature
button and select the desired option. The table underneath is updated
accordingly to show respectively the 10 preset descriptions or features.
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Raw Data Note ?2E T Q
[Enter a note..
‘

Code [Fistory EETEN

BEG 2 et [ Rz |

END c3 cP2

BC cP3

EC

e To define or change the description or feature attached to a cell, tap and
hold the cell until Survey Pro shows a new screen allowing you to define or
change the Description or Feature. An empty cell means the cell has no
Description or Feature attached to it.

e To store a point with a Description or Feature, enter the point name and
then tap on the cell holding the Description or Feature you wish to assign
to the point. Alternately you can press on the corresponding numeric key (O
to 9) on the keyboard (there is a number shown to the right of each cell
indicating which numeric key to press to select the Description or Feature
held by that cell). The point is then stored right away.

Notes

Survey Pro lets you attach one or more notes to each of your points so you can
freely add any comment you will find useful to better describe them. Once
created, a note CANNOT be deleted.

While creating or modifying a point, do the following to add a note:

e Tap on the Notes tab.

e Tap on the Add Note button.

e Tap your note in the upper edit field.

e When finished, tap Write Now! to validate the note.

e Tap @ to return to the Notes tab. The new note appears at the bottom of
the list. The note header shows the date and time when the note was
created.

Survey Pro allows you to customize the note editor so you can enter your notes

more quickly. Up tol6 buttons are made available for this purpose. Through

each of them, you can preset up to 127 characters of text and/or numerals,

The label of each button (5 characters max., also editable). should reflect the

character string held by the button.

While creating or modifying a point, do the following to customize a button:

e Tap on the Notes tab.

e Tap on the Add Note button.

e Tap Customize.

e Tap on the button you want to customize (for example “C2"). This opens
the Code Edit screen on which you can define a new character string for the
button. You can also change the label if appropriate.

e Tap @ to validate the new button definition and return to the previous
screen.
e Tap Customize again to end the button definition sequence.

e |f you now tap the button you have just defined, this will preset the edit
field with the new text held by the button. You may complete or modify this
text if necessary before tapping Write Now! to validate your entry.



Raw Data Viewer
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e As previously, tap @ to return to the Notes tab.

Note the presence of the History tab, which you can use to list all the notes you
have entered previously. These can be listed either in alphabetical order, from

the most recent to the oldest, or from the most to the least frequently used.

The Raw Data Viewer lists every action performed in the current job since it
was created. The reported actions are always listed from the oldest (top of the
list) to the most recent one (bottom of the list).

By default, each action is represented in one line but you can extend the line
by tapping on the “+” sign to read more details on this action. Conversely, you
can collapse the line by tapping the “-” sign

When you open the Raw Data Viewer from Job > View/Edit Raw Data, the last
action will be highlighted. If you access the Raw Data Viewer while you are
editing a point (i.e. by tapping View Raw on the Derivation tab), the viewer will
spot the action the point originates from (manual entry, measured point,
imported point, etc.).

Raw Data Viewer Toolhox

The Raw Data Viewer is fitted with a toolbox that you can use as explained
below.

Takes you to the first action logged in the job.

€| |

Takes you to the last action logged in the job.

Takes you back to the previous action you highlighted in the list of actions.

Valid only after you have used the left-arrow button just above. Allows you to scroll back
through the different actions you went through previously with the left-arrow button.

2| [¥] [+

Opens the “Find Point” function where you can define a search criterion (point name).

Valid only after the Find Point function has been set. Takes you to the next occurrence
of the point name in the list.

Mate. . Allows you to add a note as a new entry at the bottom of the list of actions. Adding a
note in this case is done in the same way as when adding one for a point.

= Instantly adds the current date & time in a new line at the bottom of the list of actions.
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Editing Manual Shots

All manual shots performed in traverse/sideshot, repetition shots or leveling

(single- or three-wire) may be edited from within the Raw Data Viewer:

¢ |n the Raw/Data Viewer, tap and hold the stylus on the desired observation
and select Edit Manual Shot Data. This opens the Enter Shot Data window
showing the measurements currently stored for this observation.

e Correct the measurements as desired and then tap @ .
Following this action, the observation is automatically updated with the
measurements you have just modified and all the points affected by this
change are re-calculated as well.

In earlier versions of Survey Pro, there was a separate list for backsight and
foresight targets. With Survey Pro 5.2 and 5.3, there is now a single list of
optical targets, so you can choose to take an observation to any target from any
measurement routine.

This enhancement makes certain routines, such as repetition, multiple
sideshots and shoot from two ends, much easier to use.

With all optical targets now managed from a single list of targets, you will
notice some changes to the way “height of target” edit fields are handled in
the case where you have a fixed backsight target defined in the station setup:
When you choose your fixed backsight target as the target for the current
observation, the edit field disappears and the height of the fixed backsight
target is shown in static text next to the smart target selector. This prevents
you from changing the height of the fixed backsight target.

When you upgrade to Survey Pro 5.2 or higher, you will notice that all of your
optical targets are now merged into a single target selection list. There is no
longer a separate list of backsight and foresight targets.



Electronic Compass

settings _______ I IRX]
[ <General _|[Compass J[Receiver ... > |

Enable data collector compass|

Magnetic Declination: [0.0040

|
Calibrate Compass

Survey Pro can integrate the use of an electronic compass if the model of data
collector you are using if fitted with one.

Setting the Electronic Compass

Go to Job > Settings. If your data collector is fitted with a built-in electronic
compass, a Compass tab can be selected from the Settings screen. Open this
tab. Different functions can be performed from this tab:

e Check or clear the Enable data collector compass box to respectively enable
or disable the use of the electronic compass in Survey Pro.

e Enter the magnetic declination (in degrees and fractions of a degree)
e |f the compass is active, view the compass reading:
View Compass
_—

54°

e Calibrate the compass. The calibration procedure is specific to the model
of data collector used. Usually however, you are requested to rotate the data
collector in the vertical and/or horizontal plane. The data collector will
provide the necessary instructions on the screen as you progress, until the

procedure is complete.

Using the Electronic Compass

Once running and if properly calibrated, the electronic compass will assist you

in the following ways while using Survey Pro:

e The current value of heading will continuously be displayed in the upper-
left corner of the active map (e.g. Compass Heading: 111°)

* In optical stakeout, North and south indicators will be placed on the
compass screen.

* In GNSS stakeout, for which these indications already exist without an
electronic compass running, the heading value given by the compass being
more accurate than the one provided by the GNSS —especially when the
rover is stationary or moving slowly— the N/S indicators shown on the
stakeout screen are those derived from the electronic compass, and not
from the GNSS.

While staking out a point with the electronic compass active, the @ button on the
stakeout screen gives access to the compass settings as well.
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Quick Pick

This tool provides a shortcut to preset Survey Pro functions/routines. When you
tap on the yellow star, you have direct access to a list of Survey Pro functions
(the Quick Pick list). Just tap on one of the items in that list to run the
corresponding function.

A list of functions is defined by default, picked from the different Survey Pro
menus. You can customize the list by selecting Edit Quick Pick at the bottom of
the Quick Pick list. This opens the quick pick editor (Quick Pick Editor).

Instrument Settil
Point to Point

Level Bubble

Instrument [Sea

n?:nlar?f?) Layers [Stop] Instrumel :

Past Results
Manage Pictures Defaults PIntS i

View Report View / Edit Raw
Take Picture Where Is Next P8
View Compass

G | |[Move Down <d™ B

Calculator

Move Up

In the right-hand pane, you can read the currently active shortcuts (i.e. the

Survey Pro functions listed when tapping on the yellow star). In the left-hand

pane, you can read the list of available functions per menu. Use the Menu ltems

field to select the menu you want to pick functions from. In this list, the

functions already defined as shortcuts in the Quick Pick list are shown in bold

characters.

For example, you want to add View Report in the Quick Pick list:

e Select Job from the Menu ltems field.

e Scroll down the list of functions available from that menu until you can
select View Report in the list.

e Tap on the Add --> button. The View Report function is added at the bottom
of the Quick Pick list. It can now be run directly from this list.

e Tap @ to save your changes and close the quick pick editor.

Other buttons are available in the quick pick editor:

e <-Remove: Use this button to remove the function selected in the right-
hand pane from the Quick Pick list.

e Defaults: Use this button to revert to the default Quick Pick list.
Confirmation is required before the default Quick Pick is restored.

e Move Up / Move Down: Use this button to rearrange your Quick Pick list. The
selected function is respectively moved by one position, up or down
respectively.
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RTX™ (for Real Time eXtended) is a Trimble worldwide service delivering
corrections to RTX-enabled GNSS receivers allowing them to compute
centimeter-accurate positions without the need to work from a particular base.
With Survey Pro, RTX corrections are delivered via the Internet. With the
offered service (CenterPoint™ RTX), accuracy is 3.8 cm after 30 minutes of
convergence timel (accuracy is 30 cm after 10 minutes, 20 cm after 15
minutes).

RTX supports GPS, GLONASS, QZSS and BeiDou constellations.

NOTE: RTX corrections will be received only if your data collector is connected to the
Internet.

Using an RTX-enabled GNSS receiver with Survey Pro:
e In Survey Pro, select Manage Instruments from the GNSS icon in the
command bar, and then tap on Add Receiver Profile.

e Scan for an RTX-enabled GNSS receiver through Bluetooth. Wait until the
scan is complete.

e Select the receiver from the list of Bluetooth-detected receivers, tap Next>,
choose a “network type” profile for this receiver and then tap Finish.

e In the Receiver Profiles list, select the newly added receiver and tap [&.

e Select “RTX” from the Setup Type scroll-down list and tap @

® Go back to the Survey menu and tap Start Survey.

e Select the receiver from the list of receiver profiles and tap Connect directly

(you don’t need to specify the network from which RTX corrections are
delivered).
Survey Pro then tests the RTX service subscription validity. If you have 10
or less days left, a warning message will pop up prompting you to take the
necessary steps to renew the subscription. If the subscription has expired,
another message will show up reporting this situation and the receiver will
not be allowed to proceed.

If the subscription is still valid, the message “Waiting for RTX engine to
initialize...”is displayed. This initialization step may take a while. In the
meantime, you can set the antenna (model, height value, height type) and
possibly start raw data recording for further post-processing (see in the
lower part of the screen).

NOTE: A message will be reported if initialization fails, prompting you to try again.

After the RTX engine has initialized, the message “Waiting for position to
converge” is displayed (this step usually takes more time than RTX engine

1. The convergence time is the time required before the expected, nominal accuracy is achieved for the delivered RTX positions.
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initialization). When the position has converged, the message “Rover
receiver is ready to set. Press [Finish] to continue”.

Tap Finish. You can now start collecting data.

NOTE: Convergence is achieved when the computed HRMS has been less than the
requested value for five epochs in a row. The requested value of HRMS is the one

specified on the RTX tab in Job >Settings>Meas. Mode.

If the HRMS box is left unchecked, Survey Pro will use a default value of 5 cm for the
HRMS to decide on whether the position has converged or not.

Using the Quick Start Button to Reduce Convergence Time

While waiting for the position to converge, you may — with some GNSS
receivers only — speed up the process by using the Quick Start procedure:

Make sure the antenna height is set at the right value.

Tap on the Quick Start button.

Pick a point from the job where to start initialization (the location of this

point in the field must be visible). Its coordinates must be geodetic ones

(in ITRF2008 epoch 2005.0).

Move your receiver in the field to the selected point and keep it motionless
right over this point.

Tap on the Start button. This button is changed into a Stop button. Wait until
the process is complete, which is effective when the Stop button is changed
into a Done button.

Tap Done. You can now start collecting data.



Memo for GNSS Users

Assuming the following:

A receiver profile has been created previously so you can use your RTK rover
in a network.

If you are using a “network rover”, a network has also been defined
previously for the purpose of receiving corrections from an IP server. (No
network profile needs to be created if you are using a “rover” receiving
corrections from a base via radio.)

A new job file needs to be created in which a known coordinate system and
a geoid are used.

Then proceed as indicated below:

Turn on your receiver.

Start Survey Pro on the data collector.

Create a job in which you select the coordinate system and geoid used.
Tap the instrument icon and select Switch to GNSS.

Go to Survey >Start Survey.

Select the receiver profile prepared earlier for your rover.

Select the network used (skip this step if you are using a “rover”, and not
a “network rover”).

Tap Connect.

Wait until the rover receives data from the base.
Confirm/change the point where the base is located.
Set acceptance criteria for all your measurements.

Make sure the receiver continuously delivers a “Fixed” position solution.
(You may also go to Survey > GNSS Status to check the GNSS reception
status and then come back to Survey > Data Collection.)

Start collecting your data (points, offset points, lines). Data may be
collected using one epoch of data (always the case when collecting data
along a line), or by averaging the position through a static occupation on
each point.

When finished, select End Survey on the Home screen.
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Index

Symbols

$PASH commands 108
Numerics

2D Survey 39, 42, 44, 47
3D position solution 35

A

Accept Anyway 60
Acceptance criteria (GNSS) 57
Activate 25

Active map 8

Add Receiver 28

Add to Home 6

Adjusting a close level loop 80
Alarm 58

Alignments 20

All 51

Allow in PPK Survey 58
Angle only 42, 45

Angle Right 49

Angle right 85

Antenna type 56

Attributes 101

Automatic-All 22 o
Automatically accept when criteria is

met 60
Automatic-WiFi 22
Autonomous rover mode 64
Average for 58, 59
Average of 51
Azimuth (entering) 2
Azimuth/Distance 89
B

Backsight 44, 48
Base (change) 70
Base (Start Base) 53
Base brand 56

Base capability 31
Base location 69
Basemap files 8
Battery level 5

Battery status 95
Bearing (entering) 2
Benchmark 73
Bluetooth 28
Broadcast RTCM 15, 54, 55
BS 2

BS Azimuth 38, 40
BS Point 39

By Angle 40

By Distance 40

By managed points 82
By Point 40

By points 82

C

CAD 8

Calibration (Introduction to) 65
Calibration (one-point) 69
Calibration (procedure) 66
Calibration (solve) 69
Calibration requirements 57
CenterPoint RTX 109

Central (cloud service) 4, 22
Check 40

Check box 7

Circle 96

Circle Zero 84

Close loop on existing point 78

Collecting data out of a survey 64

Collimation 25, 95

Color code (for constellations) 35

Command bar 4
Compensator 94

Control benchmark (CBM) 72
Control file 14

Convergence time 109
Coordinate system (select) 15
Corrections 31

CR5 (file format) 16, 20
Create New Instrument 25
CSV 16, 20

CSV format 20

Curve and Offset 92
Customize (home screen) 5
CUT/FILL 85, 86

D

Data collection 56, 59

Data collection capability 31
Data Link 34

Datum 15

Define a Location 92
Deleted point icon 17

Demo mode 24

Description vs. feature (Toggling

between) 102
Descriptions 19, 100
Design point icon 17
Direct and Reverse 42, 44
Direct only 42, 44
Display Directions as 89
Dist Interval.. 63

Dist. Interval - Vertical 63
Distance and Angle 42, 45
Do Not Store 58

DXF (file format) 8, 20

E

Earth Curvature & Refraction 38
Earth curvature & refraction 14
Edit (manual shots) 106

Edit points 17

EDM 2, 25, 95, 97
Electronic compass 82, 107
Electronic leveling 36
Elevation Mask 31

elLevel 58

End survey 71

Error ellipse 43

Export data 20

F

FBK format 20

Feature (data collection) 63
Feature vs. description (Toggling
between) 102

Features 19, 101

First point 16

Fixed Target 41

Fixing station setup 47

FLD format 20

Follow-me function 12
Foresight 48, 51

Format 96

FORWARD/BACK 85, 86

G

GDM 16

Geolock 26

Global geodetic 19

GNSS 23, 53, 55, 108
GNSS reception status 34

Go North/Go East 89

Go RIGHT/Go LEFT 85, 86
Google Earth 20

Grid 15, 18

Ground calibration 15, 53, 55
H

HA 51, 96

HD 96

HI 39, 42, 44, 47, 49

Hold Still For 63

Home screen 3

Horizontal distance 49

HR 41, 42, 45, 47, 49, 84, 86, 97
HRMS 58

HTML format 20

|

Icons (for points) 17

Import data 16

Insert Page Before (or After) 6
Instrument icon 4



Instrument Settings 25
Instrument settings 25
IXL 16

J

JOB (file format) 16, 20
Job settings 14

Jobs 13

JobXML 16, 20

JPG 8

JXL (file format) 16

K

Keep Measuring 60
Key-in points 17

KML format 20

Known Point 38

KOF 16

KOF format 20

L

L band 31

LandXML 16

Layer 16

Layers 19, 100

Letter code (for constellations) 35
Level bubble 25, 94
Level loop 1, 72, 75
Level loop report 20
Level settings 37

Level turn 73

Leveling 1, 23, 36, 72
Leveling mode (choice of) 37
Lights 25, 95

Line and Offset 92
LisCAD 20

LLH 2

Local geodetic 19
LockNGo 96, 97
LockNgo 26

M

Main menu 3
Manage design points 18
Manage Instruments 23, 28, 29, 30,
31, 33
Manual 22

Prompt Every Point 64
Manual Configuration 27
Manual mode 24
Manual Prompt Once 64
Map projection 15
Map view 4, 8
Mapping plane 54, 55
Meas. Mode 57
Measure and Store 96, 98
Measure Backsight 41

Measure Only 96

Min SV 58

Move Item 6

MSR key 98

Multiple Backsights 44
Multiple backsights 44

N

Navigation 93

NEE 2

Network base 33

Network profile 27, 53, 55
Network profile (Manage) 33
Network rover 33

New Backsight Circle 50
New Point 39, 41

Normal 97

Notes 104

(0]

Observe 43, 45

Observed points 17

Occupy Point 39
OCCUPYING 91

Offset Staking 92

On-line help 5

Optical 23

Origin (of a point) 17

P

PDOP 58

POB 20

Point (data collection) 59
Point Details screen 17
Point icon (general case) 17
Point Slope Staking 92
Points (management) 17
Polylines 20

Position (GNSS) 35

Post Process 58

Post Processing 23, 34
Post Processing Recording Interval 54,
56

Power button 7

PPM 2, 38

PPM Correction 46

Precise 97

Precision tab (optical equipment) 25
Profile 20

Prompt for PPM during Station Setup
46

Proprietary commands 108
Q

Quick codes 103

Quick Pick 5, 95, 108
Quick Shot 94, 96, 98, 99

Quick Start (RTX) 110

R

Radial Sideshot Seq 51

Radio 25

Raw Data Viewer 105

RAW format 20

Receiver profile I, 53, 55
Receiver profile (Add) 28
Receiver profile (Export) 30
Receiver profile (Import) 30
Receiver profile (introduction to) 27
Receiver profile (Manage) 29
Receiver profile (Modify) 31
Ref... button 89

Reference station database 54, 70
Refraction 14

Remote Control screen 26, 86
Remote Elevation 47

Remote Staking 86

Remove Item 6

Remove Page 6

Rep Shoot Sequence 51
Repetition shots 51

Resect Point 42, 45
Resection 38, 42

Reset Ambiguities 34

Roads 20

Rod Elev. 85, 87

Rotate 47

Rover (Start Survey) 54, 55
Rover capability 31

ROVING 90

Roving Target 41

RTK 34

RTK autonomous points 58
RTX 27, 30, 31, 32, 55, 57, 109
S

Sat Info 35

Scale factor 15

Scroll button 7

SD 51, 96

Search 26, 95, 96

Sequence 42, 44

Serial connection 29

Set circle 96

Set to Off mode 32

Setup Type 39, 42, 44

SFN 16

Sharing files over the Internet 21
Shots per Resect Point 42, 44
Show Station 92

Sideshot 48, 52, 98
Sideshot point 73



Signal strength 35
Single-wire leveling 36

Sky View 35

Slope distance 49

Slope Staking 92

Smart targets 40, 106
Snap-To toolbar 11

Solution quality 58

Solve 84

Spectra Auto-Configure 27
Spiral and Offset 92

SS 2

Stake DTM 92

Stake Next 85, 88, 91
Stake Points 84, 86, 88, 89
Stake Skew Line 92

Stake to Line 92

staked point icon 17
Stakeout 98

Stakeout point 73

Stakeout points, managing the list of
82

Stakeout, GNSS 89
Stakeout, mechanical 84
Stakeout, robotic 86
Standard 97

Start Manual Setup 28
Start Now 57

Start Survey Prompt Projection 55
Station Setup 39, 42, 44, 98
Stop 26

Store Offset Points 92

Store Pt 42, 44

Submenus 3

Surpac 16

Survey (file format) 16, 20
Survey Mode 59

Survey reports (generate) 20
T

Tab 7

Take Shot 43, 45

Tap and hold on menu items to manage

the Home screen 5

Three-wire leveling 23, 36

TIFF 8

Time Interval 63

Topo SS (acceptance criteria) 57
Topo SS (data collection) 59
Toss 51

Track light 97

Tracking 97

Transform computed point to key-in
point 19

Translate 47

Traverse 48, 49, 52, 98
Traverse/Sideshot 48
Trigonometric leveling 36

True Azimuths 38

Turn To 26

Turn to 96

Turn to benchmark 78

Turn to turning point 77, 78
Turning point 73

Two-peg test 81

TXT 16, 20

U

Units 14, 96

Unknown Point/Resection 38, 42
Update Rate 64

Use Last Setup 38

Use Station Index 32

\";

VD 96

Vertical distance 49

View From Instrument to Rod (non-
remote) 85

View From Instrument to Rod (remote)
86

Visible laser pointer 26

Visible laser pointer status 95, 97
VRMS 58

w

Wait xx 91

Wait.. 59

Where is Next Pt? 92

Worst Residual 51

X

XML 16

XML (file format) 20

Z

ZA 51, 96

Zenith 49

Zoom extent button 10, 11

Zoom toolbar 10
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